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About This Manual

Use this manual to familiarize yourself with SignalExpress interactive 
measurements and the basic SignalExpress features that you use to acquire 
and analyze signals.

This manual contains exercises that help you begin working with 
SignalExpress. These exercises teach you how to run projects, configure 
steps, work with signals, configure sweep measurements, log data, and 
extend SignalExpress with LabVIEW graphical programming.

Conventions
The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence Options»Settings»General directs you to 
pull down the Options menu, select the Settings item, and select General 
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names, input and output names, views, dialog boxes, sections of dialog 
boxes, and menu names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 
to a key concept. Italic text also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard. This font is also used for the proper names of disk drives, paths, 
directories, programs, subprograms, subroutines, device names, functions, 
operations, variables, filenames, and extensions.

Related Documentation
Refer to the SignalExpress Help, available by selecting Help»
SignalExpress Help, for more information as you read this manual.
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1
Getting Started with 
SignalExpress

National Instruments provides innovative solutions for scientists 
and engineers to build automated measurement systems based on 
industry-standard computers and platforms. National Instruments develops 
robust, industry-leading programming environments for automating 
measurement systems, such as LabVIEW for graphical development, 
LabWindows™/CVI™ for ANSI C programming, and Measurement Studio 
for Microsoft Visual Studio programming. You can use these programming 
tools with National Instruments measurement hardware and interfaces to 
traditional instruments to build custom, advanced virtual instrumentation 
systems.

SignalExpress optimizes virtual instrumentation for design engineers by 
offering instant interactive measurements that require no programming. 
You can use SignalExpress interactively to acquire, generate, analyze, 
compare, import, and log signals. You can compare design data with 
measurement data in one step. SignalExpress extends the ease of use and 
performance of virtual instrumentation to those who must acquire or 
analyze signals without programming applications. You also can extend the 
functionality of SignalExpress by importing a custom virtual instrument 
(VI) created in the LabVIEW Development System or by converting a 
SignalExpress project to a LabVIEW block diagram so you can continue 
development in LabVIEW. Refer to Chapter 6, Extending SignalExpress 
Projects with LabVIEW, for more information about advanced 
functionality in SignalExpress.

This chapter provides information about SignalExpress version availability 
and available licensing options.
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SignalExpress Version Availability
SignalExpress is available in both a full and limited (LE) version. Refer to 
the following table for a list of features available in 
each version. 

Table 1-1.  Differences in SignalExpress Limited Edition (LE) and Full Edition

LE Full

Instrument Support

Over 300 common standalone instruments Acquire/Generate Signals steps 
installed by NI Device Drivers

IVI DMM Acquire

IVI FGEN Arbitrary Waveform

IVI FGEN Standard Function

IVI Power Supply

IVI Scope Acquire

Acquire/Generate Signals steps 
installed by NI Device Drivers

IVI DMM Acquire

IVI FGEN Arbitrary Waveform

IVI FGEN Standard Function

IVI Power Supply

IVI Scope Acquire

Visualization and Documentation

Customizable graphing Data View Data View

Interactive cursors Cursors Cursors

Drag and drop data into Microsoft Excel, 
Word, and WordPad

Drag and drop Drag and drop

Print and export graphs — Project Documentation tab

Operator mode with limited user-editing — Operator mode

Signal Creation

Analog signal creation Create Analog Signal Create Analog Signal

Digital signal creation Create Digital Signal Create Digital Signal

Signal Processing

Software filters — Filter

Scalar and waveform math — Arithmetic

Formula

Scaling and Conversion

Time Averaging

Window
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Signal Processing (Continued)

Analog and digital conversion — Convert Analog to Digital

Convert Digital to Analog

Interactive signal comparisons — Interactive Alignment

Load simulation data from PSPICE, 
Multisim, and other SPICE packages

— Load from SPICE

Time and Frequency Measurements

Amplitude and level — Amplitude and Levels

Timing and transition — Timing and Transition

Power spectrum — Power Spectrum

Frequency response — Frequency Response

Distortion measurements — Distortion

Tone extraction — Tone Extraction

Data Logging

Save signals to file Load/Save Signals steps 
installed by NI Device Drivers

Export to text and Microsoft 
Excel files

Load/Save Signals steps 
installed by NI Device Drivers

Export to text and Microsoft 
Excel files

Save to ASCII/LVM

Export TDMS log files to 
Microsoft Excel

Data logging (Creating TDMS Files) Record button*

Playback

Record button

Playback

Record While Running button

Recording Options tab

Unlimited logs per project

Logging alarms and events — Alarms

Events

Logging with start or stop conditions — Start conditions

Stop conditions

Table 1-1.  Differences in SignalExpress Limited Edition (LE) and Full Edition (Continued)

LE Full
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Measurement Automation

Parameter sweeping — Sweep

Limit testing — Limit Test

Software triggering — Trigger

Sequencing — Sequence

Remote Data Access

Read/Write shared variables — Read Shared Variables

Write to shared variables

LabVIEW Interaction

LabVIEW code generation Generate a LabVIEW VI from 
a project

Generate a LabVIEW VI from 
a project

LabVIEW Express VIs Acquire/Generate Signals 
Express VIs installed by 
NI Device Drivers

Create Signals Express VIs

IVI DMM Acquire

IVI FGEN Arbitrary Waveform

IVI FGEN Standard Waveform

IVI Power Supply

IVI Scope Acquire

Acquire/Generate Signals 
Express VIs installed by 
NI Device Drivers

Create Signals Express VIs

IVI DMM Acquire

IVI FGEN Arbitrary Waveform

IVI FGEN Standard Waveform

IVI Power Supply

IVI Scope Acquire

Load/Save Signals Express VIs

Processing Express VIs

Analysis Express VIs

Run LabVIEW VIs in SignalExpress — Run LabVIEW VI steps

* Recording is limited to one log per project

Table 1-1.  Differences in SignalExpress Limited Edition (LE) and Full Edition (Continued)

LE Full
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SignalExpress Licensing Options
This section assists you in understanding the licensing policies for 
SignalExpress. This document does not replace the National Instruments 
Software License Agreement. Use this document only as a reference.

Evaluation Mode
The evaluation mode of SignalExpress gives you access to the 
SignalExpress Full Edition and the features in Table 1-1 for 7 days. After 
that period, you must either register the free, unlicensed LE version or 
activate the SignalExpress Full Edition. If you do not register or activate 
SignalExpress, you cannot launch the product after the 7 day evaluation 
period expires.

Note If you install SignalExpress on a machine that has LabVIEW 8.0 or later installed, 
the trial of the SignalExpress Full Edition begins the first time you launch either LabVIEW 
or SignalExpress.

SignalExpress Full Edition
The full edition of SignalExpress provides you with the full functionality 
shown in Table 1-1. You can activate the full edition of SignalExpress 
using the National Instruments License Manager, the SignalExpress 
installer, or the National Instruments website at ni.com/activate.

Refer to the National Instruments website at ni.com/signalexpress to 
purchase SignalExpress Full Edition.

SignalExpress LE
You can register the free limited edition, SignalExpress LE, at any time 
during or after the 7 day evaluation period. After the 7 day evaluation 
period expires, registered versions of SignalExpress LE allow you to 
evaluate licensed features with the following restrictions:

• Each time you drop a step that is licensed, a dialog box prompts you to 
activate the software. 

• You cannot save a project.

• Projects close after 10 minutes.

http://www.ni.com/signalexpress
http://www.ni.com/activate


Chapter 1 Getting Started with SignalExpress

© National Instruments 1-6 Getting Started with SignalExpress

Activating SignalExpress LE
Complete the following steps to activate SignalExpress LE from the 
application.

1. Launch SignalExpress. 

2. In the National Instruments License Dialog window that appears, 
click the Register Limited Edition button. 

3. Follow the prompts to activate SignalExpress LE. 

Note You also can activate SignalExpress LE from the NI License Manager using the 
serial number listed in the SignalExpress Readme.
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2
Working with Projects

You can use SignalExpress to define measurement procedures by adding 
and configuring steps in an interactive measurement environment. A step is 
a configurable function that acquires, generates, analyzes, loads, or stores 
signals. The Add Step menu and the Add Step palette show the steps 
available in SignalExpress. 

Most steps process input signals and produce output signals. You can 
configure the operation of a step by specifying values on the Step Setup tab 
for the step. A saved sequence of configured steps is a SignalExpress 
project.

This chapter teaches you how to load and run existing projects and how to 
configure steps in these projects.

Opening a Project
Complete the following steps to load a sample project in SignalExpress.

1. Launch SignalExpress. Select Empty SignalExpress Project from the 
Getting Started window.

Notice that SignalExpress is split into views that display various types 
of information. The primary view appears in the middle of the 
application window and contains tabs. If SignalExpress opens in the 
default configuration, the Data View tab, the Recording Options tab, 
and the Project Documentation tab appear in the primary view. 

The primary view is surrounded by supplementary views. In the 
default configuration, the Project View appears on the left, and the 
context help appears on the right.

Note If SignalExpress detects a supported hardware device, the Channel View appears 
across the bottom of the SignalExpress application window.
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2. If SignalExpress does not open in the default configuration, select 
View»Layout»Reset Project to NI Default Layout to reset the 
application to the default configuration. You can use the View menu to 
display tabs and views or reset the layout at any time.

3. Select Help»Open Example to open the SignalExpress\
Examples directory. Navigate to the Tutorial directory and 
double-click First Project.seproj to open the example project. 

4. Examine the window that appears, as shown in Figure 2-1, to learn 
about different components of SignalExpress. 

Figure 2-1.  First Project.seproj

1 Run button
2 Record button
3 Primary view with Data View tab visible
4 Work Area pull-down menu
5 Project View

6 Step
7 Input
8 Output
9 Logged Data window
10 Context Help

8

6

7

4

2 31

55

5

10

9
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Running a Project and Displaying Signals
SignalExpress has multiple execution or run modes. You can run projects 
once, continuously, for a number of iterations you specify, or for an amount 
of time you specify. When you run a project once, SignalExpress executes 
all the steps that appear in the Project View one time. When you run a 
project continuously, SignalExpress executes all the steps in the project 
continuously. Click the down arrow on the Run button, shown at left, and 
select Configure Run from the pull-down menu to configure the run mode 
for a project.

Displays on the Data View tab update continuously while a project runs. 
When a project is running, you can change measurement configuration settings 
by changing settings on the Step Setup tab and view the results immediately. 
Projects you run continuously run until you click the Stop button, shown at left. 
The Stop button appears in place of the Run button as a project runs. 

Complete the following steps to run the sample project and display signals.

1. Click the Run button. If the Run Information dialog box appears, 
click the Run button in the dialog box to execute all the steps in the 
project continuously.

The project loads a signal from a text file and performs two operations 
on the signal—an amplitude and levels measurement and a distortion 
measurement. The Amplitude and Levels step and the Distortion step 
perform these measurements, respectively. When you run a project, 
steps analyze input signals and generate new output signals as a result 
of the analysis. In this project, the Load from ASCII step loads a 
distorted sine wave, the Amplitude and Levels step and the Distortion 
step analyze the sine wave, and both steps return new outputs. In the 
Project View, SignalExpress indicates inputs with red arrows and 
outputs with blue arrows.

The graph display on the Data View tab still contains the loaded 
signal, which is a time-domain signal. Graphs display time-domain, 
frequency-domain, or XY signals. 

2. Drag the exported spectrum output signal of the Distortion step, 
shown at left, from the Project View to the Data View tab to display 
the signal. 

SignalExpress creates a new graph display on the Data View tab. 
SignalExpress does not display the exported spectrum signal on the 
same display as the time-domain signal because the exported 
spectrum signal is a frequency-domain signal. SignalExpress 
automatically recognizes different types of signals and renders them in 
the appropriate displays.
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Tip Refer to the SignalExpress Help for more information about signal types by selecting 
Help»SignalExpress Help, clicking the Index tab, and entering signal types. The help 
provides information about using SignalExpress functionality such as projects, steps, and 
signals.

3. Drag the dc output of the Amplitude and Levels step to the Data 
View tab. 

SignalExpress creates a Chart display with both a graph and a Legend 
table to display the scalar measurement from the dc output. The 
Legend table displays the value of each output and the color 
SignalExpress uses to plot the output on the adjoining graph.

4. Drag the rms output of the Amplitude and Levels step to the Chart 
display to display the scalar RMS measurement.

SignalExpress creates a new row in the table to display the second 
measurement. The project appears as shown in Figure 2-2.

Figure 2-2.  Outputs of First Project.seproj



Chapter 2 Working with Projects

Getting Started with SignalExpress 2-5 ni.com

Configuring a Step
A step is a configurable function that acquires, generates, analyzes, loads, 
or stores signals. Steps process input signals and produce output signals. 
You can configure the operation of a step in SignalExpress by specifying 
values on the Step Setup tab for the step. While a project runs, you can 
modify the configuration of steps and see immediate feedback on the Data 
View tab, and you can adjust measurements until you achieve the results 
you need.

Complete the following steps to configure the Distortion step and the 
Amplitude and Levels step.

1. Double-click the Distortion step in the Project View. SignalExpress 
displays the Step Setup tab for the Distortion step, as shown in 
Figure 2-3.

Figure 2-3.  Distortion Step Setup Tab
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On the Configuration page of the Step Setup tab, the Export signals 
(THD) field indicates that the Distortion step exports the input signal, 
and the Exported Signal graph displays a preview of the signal. The 
Exported Power Spectrum graph indicates that the step performs a 
power spectrum on the input signal to convert it to the frequency 
domain, and the Measurement Results field displays the fundamental 
frequency and total harmonic distortion (THD) of the signal. The step 
generates the exported signal and three measurements as outputs—the 
spectrum, the THD, and the fundamental frequency of the original 
time-domain waveform input.

2. If the context help does not appear on the right side of the screen, select 
Help»Context Help to display complete reference information about 
the step. 

The upper section of the context help displays information about the 
step, and the lower section of the context help displays information 
about specific parameters of the step when you move the cursor over a 
parameter. Move the cursor over the THD (%) parameter to display 
information about the parameter.

3. On the Configuration page, select Fundamental Tone from the 
Export signals (THD) pull-down menu.

The Exported Power Spectrum graph changes from displaying the 
frequency-domain spectrum of the entire input signal to displaying 
only the frequency spectrum of the fundamental tone of the input 
signal. Both the output signal of the Distortion step and the graph 
display of the exported spectrum output on the Data View tab update 
to reflect the change you made.

4. Select Harmonics only from the Export signals (THD) pull-down 
menu.

The Exported Power Spectrum graph on the Step Setup tab and the 
graph of the output on the Data View tab both change to display only 
the spectrum of the harmonic signals from the input signal.

5. Click the Amplitude and Levels step in the Project View. 

The Step Setup tab changes from displaying the configuration of the 
Distortion step to displaying the configuration of the Amplitude and 
Levels step.
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6. Select the Input/Output page to display the list of possible inputs and 
outputs for this step, as shown in Figure 2-4.

Figure 2-4.  Amplitude and Levels Step Setup Tab

7. Place checkmarks in the Export +peak value, Export -peak value, 
and Export peak-peak value checkboxes to configure the Amplitude 
and Levels step to return three additional measurements.

Three additional outputs appear in the Project View.

8. Switch to the Data View tab.

9. Drag the three new outputs from the Project View to the Chart display 
of scalar measurements. The new outputs appear on the graph and in 
the Legend table.

Note If you have been running the project for a while, you might need to stop and restart 
the project to see all the scalar signals on the graph. SignalExpress accumulates points of 
data for signals that you add to a graph, and new signals you add do not have as many data 
points to display on the graph. 
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10. Click the Stop button to stop the project.

When you click the Stop button, the project stops running after 
completing the current cycle of operations, or the current iteration. 
Click the down arrow on the Stop button and select Abort from the 
pull-down menu to completely stop the project without finishing the 
current iteration.

11. Select File»Save Project As and save the project as My First 
Project.seproj in the C:\Program Files\National 
Instruments\SignalExpress\Examples\Tutorial directory.

12. Select File»Close Project to close the project.

Ordering, Moving, and Deleting Steps
Most steps in SignalExpress projects require input data. Steps can operate 
only on signals exported from previous steps in the Project View, so the 
order in which steps appear in the Project View can effect project 
functionality. 

For steps that have an Input or Input/Output page on the Step Setup tab, 
the Input signal pull-down menu on that page displays only compatible 
signals exported from a previous step. When the output of a step becomes 
the input of another step, the steps become dependent on each other, and the 
two steps execute sequentially at the same rate. The first step generates an 
output signal that the second step must receive as an input before the second 
step can execute.

You can move a step within a project by dragging it up or down in the 
Project View. You can delete a step by right-clicking it in the Project View 
and selecting Delete from the context menu. When you move or delete a 
step, the status of signals in the project changes. For example, if you delete 
a step that generates output signals, the operation of the project breaks if 
any of the deleted output signals are inputs for other steps, and an error 
indicator appears in the Project View. You also can cut, copy, and paste 
steps within a project by pressing the <Ctrl-X>, <Ctrl-C>, and <Ctrl-V> 
keys, respectively, or by right-clicking a step in the Project View and 
selecting Cut, Copy, Paste Before Selected Step, or Paste After Selected 
Step from the context menu.
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Handling Errors and Warnings
If an error occurs while a project runs, an error indicator, shown at left, 
appears in the Project View on the step that encountered the error. 
Double-click the step with the error to display an error description across 
the bottom of the Step Setup tab. Click the Details button to the right of 
the error description to display the full error description.

SignalExpress logs all errors and warnings on the Event Log tab while a 
project runs. To display the Event Log tab, select View»Event Log. Refer 
to the SignalExpress Help for more information about errors and warnings 
by selecting Help»SignalExpress Help, clicking the Index tab, and 
entering errors.
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3
Working with Signals

You can use SignalExpress to generate and analyze signals without 
programming. This chapter teaches you how to work with signals in 
SignalExpress, including how to plot signals on graphs, import signals 
from a file, interactively align and compare two signals, and save signals to 
a file.

Graphing Signals
Complete the following steps to plot signals in a sample project and 
examine the signals visually using cursors.

1. Select Help»Open Example, to open the SignalExpress\
Examples directory. Navigate to the Tutorial directory and 
double-click Signals.seproj. This project configures the Create 
Analog Signal step to create a square wave signal and the Filter step to 
perform a lowpass Butterworth filter.

2. Drag the step signal output of the Create Analog Signal step to the 
Data View tab.

3. Drag the filtered step output of the Filter step to the Data View tab.

Both the step signal and the filtered step signals are time-domain 
signals, so they appear on the same graph display. If you try to plot 
signals of different types by dragging the signals to the same display, 
SignalExpress creates a new display.

4. Click the Add Display button, shown at left, to create a new display.

Note You can remove individual displays by clicking the X at the top right corner of the 
display.

5. Drag the filtered step output of the Filter step to the new display.
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6. Right-click the new display and select Visible Items»Cursors from 
the context menu to display two interactive cursors, as shown in 
Figure 3-1.

Figure 3-1.  Signals.seproj

As you drag the cursors, SignalExpress displays the x- and y-values of 
the cursors in the cursor table at the bottom of the Data View tab.

7. Select File»Save Project As and save the project as 
My Signals.seproj in the C:\Program Files\National 
Instruments\SignalExpress\Examples\Tutorial directory.
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Importing a Signal from a File
You can import signals from standard file formats such as ASCII comma- 
or tab-delimited files and LabVIEW measurement data files (.lvm). You 
also can import signals from simulated results of electronic design 
automation tools such as SPICE simulators.

Complete the following steps to import a signal from a file.

1. Right-click in the Project View and select Load/Save Signals»
Analog Signals»Load from ASCII from the context menu to add the 
Load from ASCII step to the Project View. The Step Setup tab for the 
Load from ASCII step appears. This step parses an ASCII file and 
displays the signals in the file.

Note You can add steps to a project from the Add Step menu, the Add Step palette, or the 
context menu that appears when you right-click in the Project View.

2. Confirm that . (dot) is selected in the Decimal separator pull-down 
menu to read the values in the example file correctly. 

3. On the Step Setup tab, click the browse button, shown at left, 
navigate to the C:\Program Files\National Instruments\
SignalExpress\Examples\Tutorial directory, and double-click 
Step Response.txt.

In the File preview section, column 1 shows the time stamp data, and 
column 2 shows the actual voltage values of the signal.

4. Switch to the Import Signals page of the Step Setup tab to display the 
available signals in the file.

5. Confirm that a checkmark appears in the Column 2 checkbox to 
import that signal.

The Step Setup tab displays a preview of the signal on the Imported 
Signal graph.

6. Confirm that Column 1 (Column 1) appears in the Input X values 
pull-down menu to set the x-axis data of the waveform to the 
appropriate values.

7. Switch to the Data View tab.

8. In the Project View, expand the Step Response.txt output of the Load 
from ASCII step.

9. Right-click the Column 2 output and select Rename from the context 
menu.
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10. Enter step response and press the <Enter> key to rename the output.

11. Drag the new step response output of the Load from ASCII step to the 
lower display on the Data View tab.

The lower graph display appears to show almost no signals.  This is 
because the Create Analog Signal step produces signals with a current 
timestamp while the step response output has a zero timestamp.  
Right-click the lower graph display and select Time Stamp»Ignore to 
see both the filtered step signal and the step response output.

The filtered step signal resembles the rising edge of the step response 
output, as shown in Figure 3-2.

Figure 3-2.  Signals of Signals.seproj

12. Select File»Save Project to save the project.
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Aligning and Comparing Signals
Although the filtered step signal and the step response output both show 
an overshoot in the rising edge, assessing the similarity between the two 
is difficult because the signals come from different sources and vary in 
amplitude and timing. However, you can use the Interactive Alignment step 
to align and compare two signals, so you can choose which type of 
information you want to export from the operation to use in the project.

Complete the following steps to align two signals in the 
My Signals.seproj project.

1. Expand the Step Response.txt output, right-click the step response 
output and select Send To»Processing»Analog Signals»Interactive 
Alignment from the context menu to pass the step response signal 
from the Load from ASCII step to the Interactive Alignment step. 
Place a checkmark in the Ignore x0 checkbox on the Alignment tab to 
ignore timestamp mismatches.

The step selects the two most recent signals from the project to use as 
inputs and displays the signals on the graphs on the Step Setup tab, 
as shown in Figure 3-3.

Figure 3-3.  Interactive Alignment Step Setup Tab
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When you add a step to a project, SignalExpress selects input signals 
based on the signal types the step can accept. For example, the 
Interactive Alignment step can operate only on time-domain waveform 
signals. Therefore, the step selects as inputs the last two time-domain 
signals created in the project. 

Note To change the input signals for a step, select different signals from the pull-down 
menu of compatible signals on the Input or Input/Output page of the Step Setup tab, or 
click the down arrow that appears next to the step input name on the step in the Project 
View.

2. Click the red signal in the Input Signals graph and drag it to another 
point within the graph. The Comparison Result Signal graph updates 
to show the new calculated difference between the signals.

You can drag, expand, and contract signals on the graph.

3. Try to align the rising edges of the two signals by dragging a signal 
within the graph. Click a signal to set an anchor point and press and 
hold the <Alt> key while dragging the signal to stretch the signal 
around that anchor point along the x- and y-axes.

On the Alignment page of the Step Setup tab, the step computes and 
displays the x- and y-gain and offset values you need to achieve the 
alignment specifications as you drag the signals.

4. Select Auto - Step from the Mode pull-down menu to align the 
signals. SignalExpress computes the alignment using built-in 
algorithms.

The Comparison Result Signal graph on the Step Setup tab displays 
the difference between the two signals.

5. On the Input/Output page, place a checkmark in the Export aligned 
signals checkbox to add the signals to the outputs of the step.

6. Switch to the Data View tab.

7. Click the Add Display button to add a third display.

8. Drag the aligned reference and aligned test outputs of the Interactive 
Alignment step to the new graph to view the aligned signals.

9. Select File»Save Project to save the project.
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Signal Types in SignalExpress
Some steps, such as the Arithmetic step, can operate on multiple signal 
types. For example, you can use the Arithmetic step to operate on 
time-domain or frequency-domain waveforms. The Arithmetic step 
changes behavior based on the type of input signals you select for the 
step. For example, if you add two time-domain signals, SignalExpress adds 
only their amplitudes. However, if you add two frequency-domain phase 
signals, SignalExpress adds the appropriate phase shift.

Refer to the SignalExpress Help for more information about signal types by 
selecting Help»SignalExpress Help, clicking the Index tab, and entering 
signal types.

Exporting and Printing Signals
You can use SignalExpress to document signals or continue analysis in 
another software application. This section teaches you how to export 
signals, including sending signals to an ASCII file, sending data to 
Microsoft Excel, printing signals, and using the built-in project 
documentation feature to document the SignalExpress project.

Saving Signals to File
Complete the following steps to save a signal from My Signals.seproj 
to a file.

1. Click the Add Step button, shown at left, to display the Add Step 
palette.

2. Select Load/Save Signals»Analog Signals»Save to ASCII/LVM to 
add the Save to ASCII/LVM step to the Project View. The Step Setup 
tab for the Save to ASCII/LVM step appears.

3. Click the Signals page on the Step Setup tab and select filtered step 
from the Input Data pull-down menu.

4. On the File Settings page, specify where to save the text file you are 
creating by clicking the Browse button next to the Export file path 
field and navigating to the C:\Program Files\National 
Instruments\SignalExpress\Examples\Tutorial directory. 
Enter filtered signal.txt as the filename.

5. Select Overwrite from the If file already exists pull-down menu.

6. Select Generic ASCII (.txt) from the Export file type pull-down 
menu.
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You can use a Load/Save Signals step to save data to a file every time 
the project runs.

7. Click the down arrow on the Run button and select Run Once to run 
the project and save the resulting signal to the specified ASCII file.

8. Select File»Save Project to save the project.

9. Select File»Close Project to close the project.

10. Browse to the filtered signal.txt and open the file in a text 
editor to see the values of the signal. In SignalExpress, you can use the 
Load from ASCII step to import the signal back into a project.

Exporting Signals to Microsoft Excel
To export signal data to Microsoft Excel, launch Excel and drag the output 
signal of a step in SignalExpress to an Excel spreadsheet. You also can 
right-click a display on the Data View tab and select Export To»
Microsoft Excel to export all the data on the display.

Creating Reports in SignalExpress
Select View»Project Documentation to display the Project 
Documentation tab. You can use this tab to describe a project using text and 
images such as graphs. You can drag a step output from the Project View 
to the Project Documentation tab to display a graph of the output signal. 
If the project is running, the graph on the Project Documentation tab 
automatically updates to match the current value of the step output. 

To print the documentation, display the Project Documentation tab 
and select File»Print»Print Documentation or click the Print 
Documentation button. To export the documentation to HTML, display 
the Project Documentation tab and select File»Export»Export 
Documentation to HTML.
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4
Logging Data

You can use SignalExpress to record and analyze measurements. You can 
record any time-domain, double, 32-bit unsigned integer, Boolean, or 
digital step output. You also can analyze and process logged data by 
playing it through analysis steps. 

This chapter teaches you how to record data using the integrated data 
logging features in SignalExpress. You learn how to record a specified 
signal, play back that signal, and analyze the signal using analysis steps. 
You also learn how to use the Recording Options tab to log signals based 
on specified start or stop conditions. 

Recording a Signal
You can use the Record button to configure a data logging process. 

Complete the following steps to specify a signal to record and to record the 
signal.

1. Select Help»Open Example, navigate to the Tutorial directory, and 
double-click Logging.seproj.

This project uses the Create Analog Signal step to generate a signal 
based on a formula.

2. Click the Record button, shown at left, to display the Logging Signals 
Selection dialog box.

The Logging Signals Selection dialog box displays the signals in the 
project available for recording. You can select one signal or multiple 
signals to record. You also can specify a name and description for 
the log.

3. Place a checkmark in the signal checkbox to record the formula signal 
generated in the Create Analog Signal step.

4. Click the OK button to close the Logging Signals Selection dialog 
box and begin recording the signal. The logging operation continues 
until you click the Stop button.
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5. Click the Stop button, shown at left, to stop logging the signal. If you 
have not logged a signal before, the First Log Complete dialog box 
appears. Click the OK button to close the dialog box.

The logged data appears in the Logged Data window at the bottom of 
the Project View, as shown in Figure 4-1.

Figure 4-1.  Logged Data Window

By default, SignalExpress names the logged data according to the date 
and time you recorded the data. SignalExpress saves logged data in the 
.tdms file format in the directory you specify in the Options dialog 
box. 

6. Select Tools»Options and select the Logging option to specify the 
directory for SignalExpress to save the logged data and to customize 
various preferences for logged data.

7. Click the OK button to close the Options dialog box.

8. Select File»Save Project As and save the project as 
My Logging.seproj in the C:\Program Files\National 
Instruments\SignalExpress\Examples\Tutorial directory.

Viewing a Logged Signal
Complete the following steps to view the logged data.

1. If the Data View tab is not visible, select View»Data View to display 
the Data View tab. 

2. The Logged Data window displays a list of all logged data in the 
current project. Select the data log you just recorded from the Logged 
Data window and drag it to the Data View tab. The Data View tab 
displays the logged data and a Preview Graph, as shown in Figure 4-2 
with the context help closed. The signal displayed on the Data View 
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tab might differ from the signal displayed in Figure 4-2, depending on 
how long you recorded the signal.

Figure 4-2.  Logging.seproj

The Preview Graph provides a method for zooming and panning 
through data on the Data View tab. The Preview Graph appears by 
default when you view logged data. When viewing live or non-logged 
data, right-click a display on the Data View tab and select Visible 
Items»Preview from the context menu to display the Preview Graph.

Click the Zoom In button next to the Preview Graph to zoom in on the 
logged signal. The cursors on the Preview Graph show the subset of 
data currently displayed on the Data View tab. Use the scroll bar 
beneath the Preview Graph to scroll through the data. Click and drag 
the cursors on the Preview Graph to increase or decrease the subset of 
data you are viewing.

1 Logged Data 2 Preview Graph

1

2
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Logging Signals with Predefined Start and Stop 
Conditions

You can configure start and stop conditions that signals must meet before 
SignalExpress records or stops recording the signals. Complete the 
following steps to log data based on start and stop conditions.

1. If the Recording Options tab is not visible, select View»Recording 
Options to open the Recording Options tab.

2. Select Signal Selection from the Category list on the Recording 
Options tab.

3. Place a checkmark next to the signal in the Record column, as shown 
in Figure 4-3.

Figure 4-3.  Signal Selection

The Record button changes to the Record While Running button, 
shown at left. Ensure the Record While Running button is pressed. 
When the Record While Running button is pressed, SignalExpress 
records the selected signal when you click the Run button.

4. Select Start Conditions from the Category list on the Recording 
Options tab. 
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5. Click the Add button under the Start condition list to customize a 
start condition for the logging task.

a. In the Condition type pull-down menu, verify that Signal trigger 
is selected to specify that SignalExpress begins recording when 
the input signal meets the specified condition.

b. In the Signal pull-down menu, verify that signal is selected.

c. In the Trigger type pull-down menu, verify that Rising slope is 
selected to specify to begin recording the signal based on the value 
of the edge of the signal on a positive slope.

d. Enter 1 in the Trigger value field to begin recording when the 
signal crosses 1 on a rising slope.

6. Select Stop Conditions from the Category list on the Recording 
Options tab.

7. Click the Add button under the Stop condition list to customize a stop 
condition for the logging task.

a. In the Condition type pull-down menu, verify that Duration is 
selected to specify that SignalExpress stops recording after a 
specified amount of time passes.

b. In the Duration (s) control, verify that 5 appears to specify to stop 
recording 5 seconds after the signal begins.

8. Click the Run button, shown at left. SignalExpress begins recording 
the signal when the signal crosses level 1 on a rising slope and 
continues recording the signal for 5 seconds. 

The following indicators in the Recording status section of the 
Recording Options tab update while the project runs:

• Recording displays ON when the signal meets the start condition 
and logging is in progress. 

• Disk information displays the available hard disk space on the 
computer for the log. 

• Current estimated log size displays the size of the log file on 
disk.

• Recording time available displays the amount of time you can 
continue recording the log before running out of disk space.

• Current log started on displays the start time of the current log.

The Start Conditions, Stop Conditions, Alarms, and Events pages 
of the Recording Options tab also include indicators that display the 
status of start and stop conditions, alarms, and events that you 
configure.
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Analyzing Logged Signals
After you log a signal, you can play back the logged data or run the logged 
signal through analysis steps, just as you can with live data. Complete the 
following steps to analyze a logged signal.

1. Locate the Work Area pull-down menu above the Project View, 
as shown in Figure 4-4. Click the down arrow and select Playback 
to switch to the Playback work area.

Figure 4-4.  Work Area pull-down menu

Use work areas to perform multiple SignalExpress operations from 
within the same project. You can acquire data, process signals, record 
data, and perform measurements on logged data without opening a 
new project. When you save a project, SignalExpress saves every work 
area within the project in the same project file.

The default work area, Monitor/Record, allows you to take 
measurements, analyze live data, and log data. The Playback work area 
allows you to use logged data that you record in the Monitor/Record 
work area as an input for an analysis step.

2. Click the Add Step button, shown at left, and select the Filter step from 
Processing»Analog Signals»Filter. SignalExpress automatically 
selects the first signal you logged as the input to the Filter step.

3. Switch to the Data View tab, and drag the filtered data output of the 
Filter step to the Data View tab to view the resulting signal.

4. Click the Run button. The Data View tab displays the resulting 
filtered signal and SignalExpress plays back the entire log.
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Advanced Playback
You can use the Playback Options tab to configure advanced data 
playback options. The Playback Options tab displays a preview of the 
logged data and allows you to select a subset of that data to play back or run 
through analysis steps.

1. Select View»Playback Options to display the Playback Options tab, 
as shown in Figure 4-5. 

Figure 4-5.  Playback Options Tab

2. In the Logged signal listbox, select signal from the second log you 
created.

3. Enter 1 in the Start time (s) field to play back or analyze a subset of 
the logged signal beginning 1 second after the start of the log. 

4. Enter 4 in the Stop time (s) field to play back or analyze a subset of 
the logged signal ending four seconds after the start of the log. If the 
log is not at least 4 seconds long, enter an appropriate value in the Stop 
time (s) field. 

5. In the Logged signal listbox, right-click the signal from the second log 
and select Activate from the context menu to make that signal the 
active log.

Note You also can right-click a log in the Logged Data window and select Make Active 
Log from the context menu to make that log the active log.
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6. Switch to the Data View tab. The graph display on the Data View tab 
automatically updated to display the signal from the second log when 
you made that signal the active signal. 

7. Click the Run button, shown at left. SignalExpress filters the subset of 
the signal you specified on the Playback Options tab and displays the 
resulting filtered signal on the Data View tab.

8. Select File»Close Project to close the project. The Save Project 
Changes? dialog box appears. Select Discard project changes and 
delete new logs on disk option. You can also select Save project and 
logs option and Discard project changes and keep logs on disk 
option.

Refer to the SignalExpress Help, available by selecting Help»
SignalExpress Help, for more information about logging data, such as 
specifying alarm conditions, events, and playback options.
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5
Performing Sweep Measurements

You can use SignalExpress to automate measurements to characterize and 
validate designs by creating sweep operations. A design can be anything 
you create and want to characterize and validate with SignalExpress. You 
can use the sweep measurements to gather data from designs over a range 
of conditions to document the performance of the designs. For example, 
you can use sweep operations to vary the frequency of a stimulus signal or 
vary the level of a supply voltage while taking measurements to 
characterize designs.

This chapter teaches you how to set up sweep operations using the Sweep 
step in SignalExpress. You learn how to characterize the performance of a 
filter by sweeping through a range of frequency values and measuring the 
output of the filter. You also learn how to display sweep results and perform 
multidimensional sweeps for more complex measurements.

Defining Sweep Ranges and Outputs
You can use the Sweep step in SignalExpress to define automated 
measurements for complex, repeatable sweep operations.

Complete the following steps to define a frequency range in a sample 
project to sweep through a filter.

1. Select Help»Open Example, navigate to the Tutorial directory, and 
double-click Sweep.seproj.

2. Click the Run button, shown at left, to run the project continuously.

The project generates a sine wave stimulus signal using the Create 
Analog Signal step, passes it through a bandpass elliptic filter using the 
Filter step, measures the RMS level of the filter output using the 
Amplitude and Levels step, and converts the level to decibels (dB) 
using the Formula step. The Filter step acts as a simulated unit under 
test, so the project uses no hardware. However, you also can sweep 
physical signals generated from a National Instruments arbitrary 
waveform generator, function generator, dynamic signal analyzer, 
or multifunction I/O (MIO) device.

3. Click the Stop button to stop the project.
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4. Click the Add Step button, shown at left, and select Execution 
Control»Sweep to add the Sweep step to the Project View.

5. On the Step Setup tab, click the Add button to display the list of 
sweepable parameters from each step in the project, as shown in 
Figure 5-1.

Figure 5-1.  Sweep Parameter Selection Dialog Box

6. Select the Frequency (Hz) parameter under Create Analog Signal 
and click the OK button.

The Sweep step encloses the Create Analog Signal step, which 
provides the signal to sweep.

7. On the Sweep Configuration page of the Step Setup tab, select 
Exponential from the Type pull-down menu.

8. Enter 1k in the Start: Frequency (Hz) field, and enter 40k in the 
Stop: Frequency (Hz) field.
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9. Enter 150 in the Number of points field.

The Sweep Configuration page appears as shown in Figure 5-2.

Figure 5-2.  Sweep Step Setup Tab

You use the Sweep step to specify a range of values to iterate through 
the Frequency (Hz) parameter of the Create Analog Signal step. 
The Create Analog Signal step uses the defined frequency range to 
generate a sine wave at each of these frequencies. You can use the 
Sweep step to iterate through any sweepable parameter value of any 
sweepable step in a project.

10. Switch to the Sweep Output page.

11. Click the Add button to display the list of sweepable outputs from each 
step in the project.

12. Select the response amplitude in dB output under Formula and 
click the OK button to plot this measurement against the swept 
Frequency (Hz) parameter.

The Sweep step creates a loop around all the steps in the Project View 
to include all the steps in the sweep operation.
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Running Sweep Measurements
Complete the following steps to run the sweep measurement.

1. Switch to the Data View tab, click the down arrow on the Run button, 
and select Run Once to execute the sweep measurement.

The white stimulus signal output on the graph display iterates through 
the specified range of frequencies.

2. Drag the response amplitude in dB vs. Frequency signal from the 
bottom of the Sweep loop to the Data View tab to display the output 
of the sweep.

SignalExpress creates a new graph display. The data from 
a sweep operation is an XY array that requires a separate display, 
as shown in Figure 5-3.

Figure 5-3.  Sweep.seproj
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3. Select the Run Once option again to execute the sweep.

The frequency response of the Filter step plots on the new graph 
display while the project runs. The graph shows the transfer function 
of the filter, or the amplitude output expressed in decibels versus the 
frequency.

Note By default, SignalExpress does not clear displays on the Data View tab between 
iterations of a sweep. Because the frequency response of the Filter step is the same for each 
iteration, the graph that displays the signal does not appear to update when you run the 
project. You can use the Data page of the Options dialog box to specify whether 
SignalExpress clears displays between iterations of a sweep. Select Tools»Options to 
display the Options dialog box.

4. Double-click the Filter step to display the filter specifications on the 
Step Setup tab.

The frequency response of the filter in the Filter Magnitude 
Response (dB) graph matches the graph on the Data View tab.

5. Select File»Save Project As and save the project as 
My Sweep.seproj in the C:\Progam Files\National 
Instruments\SignalExpress\Examples\Tutorial directory.

You can use the Sweep step to sweep multiple parameters simultaneously 
by adding additional parameters on the Sweep Configuration page of the 
Sweep Step Setup tab. Sweeping two or more parameters simultaneously 
is called a parallel sweep. For example, if you want to vary the amplitude 
of a stimulus signal, you can run a parallel sweep to maximize the precision 
of the acquisition by varying the input range of a digitizer or MIO device 
as you vary the signal level. As the signal level increases, you can increase 
the input range of the measurement device to ensure you use the entire 
resolution for the measurement.

Running Multidimensional Sweeps
Use multidimensional, or nested, sweeps to iterate through one range while 
you vary another range. For example, if you want to sweep through 
frequencies of a stimulus signal at different amplitudes, run a nested sweep. 
You can set the amplitude to level 1 and sweep through frequencies, then 
set the amplitude to level 2 and sweep through frequencies, and so on. You 
can build a nested sweep by right-clicking a Sweep step in a project and 
selecting Add nested sweep from the context menu to add another sweep 
loop. 
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Complete the following steps to run a sample nested sweep project.

1. Select Help»Open Example, navigate to the Tutorial directory, and 
double-click Nested Sweep.seproj.

2. Click the Run button to run the project.

Each iteration of the inner sweep loop sweeps the frequency of the 
stimulus signal. The outer sweep loop varies the low and high cutoff 
frequencies of the Filter step. Each iteration appears in real time on the 
upper graph display, and then appears on the lower display to show all 
the sweeps at each cutoff frequency setting, as shown in Figure 5-4.

Figure 5-4.  Nested Sweep.seproj

3. Click the Stop button, shown at left, to stop the project.
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6
Extending SignalExpress Projects 
with LabVIEW

You can use SignalExpress to define automated measurements by using 
built-in steps for acquiring, generating, analyzing, or logging signals. You 
can extend the functionality of SignalExpress projects using LabVIEW in 
the following ways:

• Build a VI in LabVIEW and import the VI into SignalExpress to 
provide custom step functionality and expand the number of steps 
available in SignalExpress.

• Convert a SignalExpress project to a LabVIEW VI to continue 
development in LabVIEW.

Importing LabVIEW VIs into SignalExpress as Steps
Use the Run LabVIEW VI steps in SignalExpress to call custom 
LabVIEW VIs. 

Note You do not need to install the LabVIEW Development System to use a Run 
LabVIEW VI step. The Run LabVIEW VI steps do not support VIs developed in 64-bit 
versions of LabVIEW.

You can call a LabVIEW VI from SignalExpress to do the following:

• Control GPIB instruments

• Control National Instruments hardware that SignalExpress does not 
support

• Read or write data to more file formats

• Display operator instructions in a pop-up dialog box

• Define a measurement algorithm
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Complete the following steps to import a VI from LabVIEW with the Run 
LabVIEW VI step.

1. Select Help»Open Example, navigate to the Tutorial directory, and 
double-click User Step.seproj.

This project uses the Create Analog Signal step to generate a signal.

2. Click the Add Step button, shown at left, and select Run LabVIEW 
VI»Run LabVIEW 2011 VI. 

Note The VI you run in this exercise was saved in LabVIEW 2011. You must use the 
version of the Run LabVIEW VI step that matches the version of LabVIEW in which you 
saved the VI.

3. On the Step Setup tab, click the browse button in the Select VI section 
and select Limiter-LV2011.vi in the C:\Program Files\
National Instruments\SignalExpress\Examples\

Tutorial directory. The Limiter-LV2011 VI accepts a time-domain 
waveform as an input, clips the signal above and below values that you 
specify on the Step Setup tab, and returns the clipped waveform as an 
output signal.

When you import a LabVIEW VI, SignalExpress maps the inputs of 
the VI as parameters and the outputs of the VI as output signals in 
SignalExpress.

You can define whether the inputs for VIs become input signals or 
parameters. An input signal appears in the Project View as an input to 
a step, which means you can pass signals as inputs to a VI. A parameter 
is a value you can configure on the Step Setup tab of a step. You also 
can sweep parameters dynamically using the Sweep step. In this 
project, the VI has an input signal, Time waveform in, and scalar 
parameters, Upper limit and Lower limit.
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Verify that the Step Setup tab appears as shown in Figure 6-1.

Figure 6-1.  Limiter VI Step Setup Tab

4. Click the Run button, shown at left, to run the project. 

5. Switch to the Data View tab and drag the Clipped waveform out 
output signal from the Run LabVIEW 2011 VI step to the Data View 
tab.

6. Double-click the Run LabVIEW 2011 VI step to display the Step 
Setup tab.

7. Select the Configure VI page to display the VI. 

8. Enter new values in the Upper limit and Lower limit fields. For 
example, enter 100 in the Upper limit field.

9. Switch to the Data View tab. The Clipped waveform out signal 
changes to reflect the changes you made.

10. Click the Stop button, shown at left, to stop the project.

11. Select File»Save As and save the project as My User Step.seproj.

12. Select File»Close Project to close the project.
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Refer to the SignalExpress Help for more information about using 
LabVIEW VIs in SignalExpress and building VIs that work well in 
SignalExpress.

Converting SignalExpress Projects to LabVIEW VIs
SignalExpress can convert SignalExpress projects into LabVIEW VIs.

Note To convert a SignalExpress project to a LabVIEW VI, you must have the LabVIEW 
8.2 Full Development System or later installed.

Complete the following steps to convert a SignalExpress project to a 
LabVIEW VI.

1. Select Help»Open Example, navigate to the Tutorial\Solutions 
directory and double-click My First Project.seproj.

2. Select Tools»Generate Code»LabVIEW Diagram.

3. Specify a filename and location for the new LabVIEW VI and click the 
OK button. SignalExpress generates the new VI and opens the VI in 
the last version of LabVIEW you opened on the machine.

The resulting LabVIEW VI reflects the execution of the project in 
SignalExpress. The block diagram consists of LabVIEW Express VIs 
wired together. Each Express VI correlates to a step in the 
SignalExpress project. You can double-click an Express VI to display 
a configuration dialog box that is identical to the Step Setup tab in 
SignalExpress. You also can right-click an Express VI and select Open 
Front Panel from the context menu to convert the Express VI into a 
LabVIEW subVI. You can view the block diagram to see how the 
LabVIEW block diagram executes and modify the functionality of the 
VI. When you convert an Express VI into a subVI, you cannot convert 
the subVI back into an Express VI.

Note When you convert a SignalExpress project with logging, SignalExpress generates a 
LabVIEW block diagram with one Express VI. You cannot convert the generated Express 
VI into a subVI.
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7
Where to Go from Here

Refer to the following resources for more information about SignalExpress.

SignalExpress Sample Projects
SignalExpress provides a variety of sample projects that demonstrate 
more capabilities of SignalExpress. These projects are located in the 
C:\Program Files\National Instruments\

SignalExpress\Examples directory. Review these examples to learn 
more about the features of SignalExpress or to start with a project that 
closely resembles your needs.

Using Hardware with SignalExpress
SignalExpress supports a variety of National Instruments hardware for 
acquiring and generating signals. You can generate or acquire and log 
analog signals in SignalExpress using National Instruments MIO devices, 
dynamic signal acquisition devices, high-speed digitizers, or arbitrary 
waveform generator and function generator devices. You also can 
synchronize multiple devices in a system by sharing clocks and trigger 
signals between devices. Refer to the SignalExpress Help by selecting 
Help»SignalExpress Help for more information about using hardware 
with SignalExpress.

Web Resources
Refer to the National Instruments website at ni.com/signalexpress for 
resources such as example projects, technical documents, and LabVIEW 
VIs written for use in SignalExpress.

http://www.ni.com/signalexpress
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A
Technical Support and 
Professional Services

Log in to your National Instruments ni.com User Profile to get 
personalized access to your services. Visit the following sections of 
ni.com for technical support and professional services:

• Support—Technical support at ni.com/support includes the 
following resources:

– Self-Help Technical Resources—For answers and solutions, 
visit ni.com/support for software drivers and updates, a 
searchable KnowledgeBase, product manuals, step-by-step 
troubleshooting wizards, thousands of example programs, 
tutorials, application notes, instrument drivers, and so on. 
Registered users also receive access to the NI Discussion Forums 
at ni.com/forums. NI Applications Engineers make sure every 
question submitted online receives an answer.

– Standard Service Program Membership—This program 
entitles members to direct access to NI Applications Engineers 
via phone and email for one-to-one technical support as well as 
exclusive access to eLearning training modules at ni.com/
elearning. All customers automatically receive a one-year 
membership in the Standard Service Program (SSP) with the 
purchase of most software products and bundles including 
NI Developer Suite. NI also offers flexible extended contract 
options that guarantee your SSP benefits are available without 
interruption for as long as you need them. Visit ni.com/ssp for 
more information.

For information about other technical support options in your 
area, visit ni.com/services, or contact your local office at 
ni.com/contact. 

http://www.ni.com/cgi-bin/redirect.cgi?dest=infcoprod&src=lvhelp&openagent&code=rdbp04
http://www.ni.com/forums
http://www.ni.com/services
http://www.ni.com/contact
http://www.ni.com
http://www.ni.com/elearning
http://www.ni.com/elearning
http://www.ni.com/ssp
http://www.ni.com
http://www.ni.com/cgi-bin/redirect.cgi?dest=infcoprod&src=lvhelp&openagent&code=rdbp04
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• Training and Certification—Visit ni.com/training for training 
and certification program information. You can also register for 
instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, National Instruments 
Alliance Partner members can help. To learn more, call your local 
NI office or visit ni.com/alliance.

You also can visit the Worldwide Offices section of ni.com/niglobal 
to access the branch office websites, which provide up-to-date contact 
information, support phone numbers, email addresses, and current events.

http://www.ni.com/cgi-bin/redirect.cgi?dest=infcoprod&src=lvhelp&openagent&code=rdbp08
http://www.ni.com/alliance
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À propos de ce manuel

Utilisez ce manuel pour vous familiariser avec les mesures interactives dans 
SignalExpress et les fonctionnalités de base de SignalExpress que vous 
utilisez pour acquérir et analyser des signaux.

Ce manuel contient des exercices qui vous aident à prendre en main 
SignalExpress. Ces exercices vous apprennent à exécuter des projets, 
configurer des étapes, manipuler des signaux, configurer des mesures de 
balayage, enregistrer des données et étendre les possibilités de 
SignalExpress avec l’environnement de programmation graphique 
LabVIEW.

Conventions
Les conventions suivantes apparaissent dans ce manuel :

» Le symbole » vous guide à travers les éléments de menu imbriqués et les 
options de boîte de dialogue pour une action finale. Ainsi, la séquence 
Options»Paramètres»Général indique qu’il vous faut dérouler le menu 
Options, sélectionner l’élément Paramètres et sélectionner Général dans 
la dernière boîte de dialogue.

Cette icône représente une astuce qui vous donne des recommandations.

Cette icône représente une remarque qui vous donne des informations 
importantes.

gras Un texte en caractères gras représente un élément que vous devez 
sélectionner ou sur lequel vous devez cliquer dans le logiciel, comme les 
éléments de menu ou les options de boîte de dialogue. Du texte en gras 
indique également des noms de paramètres, d’entrées et de sorties, des 
affichages, des boîtes de dialogue, des sections de boîte de dialogue et des 
noms de menus.

Le texte en italique Signale les variables, la mise en valeur, une référence croisée ou une 
introduction à un concept-clé. Il indique également du texte que vous devez 
remplacer par un mot ou une valeur.
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monospace Du texte dans cette police indique du texte ou des caractères qui doivent 
être entrés avec le clavier. Cette police est également utilisée pour les noms 
des disques durs, des chemins, des répertoires, des programmes, des 
sous-programmes, des noms des périphériques, des fonctions, des 
opérations, des variables et des noms de fichiers et d’extensions.

Documentation associée
Reportez-vous à l’Aide Signal Express, disponible en sélectionnant 
Aide»Aide Signal Express, pour obtenir des informations 
complémentaires.
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1
Initiation à SignalExpress

National Instruments offre des solutions innovatrices aux scientifiques et 
aux ingénieurs pour construire des systèmes de mesure automatisés basés 
sur les plates-formes et les ordinateurs conformes aux normes de 
l’industrie. National Instruments développe des environnements de 
programmation robustes, à la pointe de la technologie, comme LabVIEW 
pour le développement graphique, LabWindows™/CVI™ pour la 
programmation en C ANSI et Measurement Studio pour la programmation 
avec Microsoft Visual Studio. Vous pouvez utiliser ces outils de 
programmation avec le matériel de mesure de National Instruments et des 
interfaces pour instruments traditionnels afin de construire des systèmes 
d’instrumentation virtuelle avancés.

SignalExpress optimise l’instrumentation virtuelle pour les ingénieurs 
concepteurs en offrant des mesures interactives instantanées qui ne 
requièrent aucune programmation. Vous pouvez utiliser SignalExpress de 
manière interactive pour acquérir, générer, analyser, comparer, importer et 
enregistrer des signaux. Vous pouvez comparer des données de conception 
avec des données de mesure en une étape. SignalExpress apporte la 
simplicité d’utilisation et les performances de l’instrumentation virtuelle 
aux personnes qui doivent acquérir ou analyser des signaux sans 
programmer des applications. Vous pouvez aussi étendre les fonctionnalités 
de SignalExpress en important un VI (instrument virtuel) personnalisé créé 
dans l’environnement de développement graphique LabVIEW ou en 
convertissant un projet SignalExpress en un diagramme LabVIEW ce qui 
vous permet de poursuivre le développement dans l’environnement 
LabVIEW. Reportez-vous au chapitre 6, Extension des projets 
SignalExpress avec LabVIEW, pour obtenir des informations 
complémentaires sur les fonctionnalités avancées de SignalExpress.

Ce chapitre fournit des informations sur les versions et les options de 
licences disponibles pour SignalExpress.
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Versions de SignalExpress disponibles
SignalExpress est disponible dans les versions complète et limitée (LE). 
Reportez-vous au tableau suivant pour consulter une liste des 
fonctionnalités disponibles dans chaque version. 

Tableau 1-1.  Différences entre les éditions Limited Edition (LE) et Full Edition de SignalExpress

LE Full

Support d’instruments

Plus de 300 instruments autonomes communs Étapes d’acquisition/génération de 
signaux installées par les drivers de 
périphériques NI

DMM IVI - Acquérir

FGEN IVI - Signal arbitraire

FGEN IVI - Fonction standard

Bloc d’alimentation IVI

Oscilloscope IVI - Acquérir

Étapes d’acquisition/génération de 
signaux installées par les drivers de 
périphériques NI

DMM IVI - Acquérir

FGEN IVI - Signal arbitraire

FGEN IVI - Fonction standard

Bloc d’alimentation IVI

Oscilloscope IVI - Acquérir

Visualisation et documentation

Traçage personnalisable Affichage des données Affichage des données

Curseurs interactifs Curseurs Curseurs

Glisser - Déposer des données dans Microsoft 
Excel, Word et WordPad

Glisser et déposer Glisser et déposer

Imprimer et exporter des graphes — onglet Documentation du projet

Mode opérateur avec édition par l’utilisateur 
limitée

— Mode opérateur

Création de signaux

Création de signaux analogiques Créer un signal analogique Créer un signal analogique

Création de signaux numériques Créer un signal numérique Créer un signal numérique

Traitement du signal

Filtres logiciels — Filtre

Mathématiques sur scalaires et waveforms — Arithmétique

Formule

Mise à l’échelle et conversion

Moyennage temporel

Fenêtre
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Traitement du signal (Suite)

Conversion analogique et numérique — Analogique en numérique

Numérique en analogique

Comparaison interactive de signaux — Alignement interactif

Chargement de données de simulation à partir 
de PSPICE, Multisim et d’autres logiciels 
SPICE

— Charger un fichier SPICE

Mesures de temps et fréquence

Amplitude et niveaux — Amplitude et niveaux

Cadencement et transition — Cadencement et transition

Spectre de puissance — Spectre de puissance

Réponse en fréquence — Réponse en fréquence

Mesures de distorsion — Distorsion

Extraction de ton — Extraction de ton

Enregistrement des données

Enregistrer des signaux dans un fichier Étapes de 
chargement/d’enregistrement des 
signaux installées par les drivers de 
périphériques NI

Exporter dans des fichiers texte et 
Microsoft Excel

Étapes de 
chargement/d’enregistrement des 
signaux installées par les drivers de 
périphériques NI

Exporter dans des fichiers texte et 
Microsoft Excel

Enregistrer au format ASCII/LVM

Exporter des fichier journaux 
TDMS dans Microsoft Excel

Enregistrement des données
(création de fichiers TDMS)

Bouton Enregistrer*

Relecture

Bouton Enregistrer

Relecture

Bouton Enregistrer pendant 
l’exécution

onglet Options d’enregistrement

Fichiers journaux illimités par 
projet

Alarmes et événements d’enregistrement — Alarmes

Événements

Tableau 1-1.  Différences entre les éditions Limited Edition (LE) et Full Edition de SignalExpress (suite)

LE Full
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Enregistrement avec conditions de démarrage 
et d’arrêt

— Conditions de démarrage

Conditions d’arrêt

Automatisation des mesures

Balayage de paramètres — Balayage

Test de limite — Test de limite

Déclenchement logiciel — Déclenchement

Mise en séquence — Séquence

Accès distant à des données

Lecture/Écriture de variables partagées — Lire des variables partagées

Écriture de variables partagées

Interaction avec LabVIEW

Génération de code LabVIEW Génère un VI LabVIEW à partir 
d’un projet

Génère un VI LabVIEW à partir 
d’un projet

VIs Express LabVIEW VIs Express 
d’acquisition/génération de 
signaux installés par les drivers de 
périphériques NI

VIs Express de création de signaux

DMM IVI - Acquérir

FGEN IVI - Signal arbitraire

FGEN IVI - Signal standard

Bloc d’alimentation IVI

Oscilloscope IVI - Acquérir

VIs Express 
d’acquisition/génération de 
signaux installés par les drivers de 
périphériques NI

VIs Express de création de signaux

DMM IVI - Acquérir

FGEN IVI - Signal arbitraire

FGEN IVI - Signal standard

Bloc d’alimentation IVI

Oscilloscope IVI - Acquérir

VIs Express de chargement et 
d’enregistrement de signaux

VIs Express de traitement

VIs Express d’analyse

Exécution de VIs LabVIEW dans 
SignalExpress

— étapes Exécuter un VI LabVIEW

* L’enregistrement est limité à un fichier journal par projet

Tableau 1-1.  Différences entre les éditions Limited Edition (LE) et Full Edition de SignalExpress (suite)

LE Full
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Options relatives aux licences de SignalExpress
Cette section a pour but d’expliquer les polices relatives aux licences de 
SignalExpress. Ce document ne remplace pas le Contrat de licence logiciel 
National Instruments. Utilisez ce document seulement comme référence.

Mode d’évaluation
Le mode d’évaluation de SignalExpress vous donne accès à l’édition 
complète de SignalExpress et aux fonctionnalités correspondantes listées 
dans le tableau 1-1 pendant 7 jours. Quand cette période expire, vous devez 
soit enregistrer la version LE gratuite et sans licence, soit activer l’édition 
complète de SignalExpress. Si vous n’enregistrez ou n’activez pas 
SignalExpress, vous ne pouvez plus lancer le produit une fois la période 
d’évaluation de 7 jours passée.

Remarque Si vous installez SignalExpress sur une machine sur laquelle est installée la 
version 8.0 de LabVIEW ou une version ultérieure, la période d’évaluation de 7 jours de 
l’édition complète de SignalExpress commence la première fois que vous lancez soit 
LabVIEW, soit SignalExpress.

SignalExpress Édition complète
L’édition complète de SignalExpress vous offre toutes les fonctionnalités 
qui figurent dans le tableau 1-1. Vous pouvez activer l’édition complète de 
SignalExpress en utilisant le Gestionnaire de licences National 
Instruments, l’installeur de SignalExpress ou le site Web de National 
Instruments en vous rendant sur ni.com/activate.

Reportez-vous au site Web de National Instruments sur ni.com/
signalexpress pour acheter l’édition complète de SignalExpress.

SignalExpress LE
Vous pouvez enregistrer l’édition limitée, SignalExpress LE, à tout 
moment pendant ou après la période d’évaluation de 7 jours. Une fois que 
la période d’évaluation de 7 jours expire, la version enregistrée de 
SignalExpress LE vous permet d’évaluer les fonctionnalités sous licence 
avec les restrictions suivantes :

• Chaque fois que vous ajoutez une étape sous licence, une boîte de 
dialogue vous demande d’activer le logiciel. 

• Vous ne pouvez pas enregistrer de projets.

• Les projets se ferment après 10 minutes.

http://www.ni.com/activate
http://www.ni.com/signalexpress
http://www.ni.com/signalexpress
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Activation de SignalExpress LE
Effectuez les étapes suivantes pour activer SignalExpress LE à partir de 
l’application.

1. Lancez SignalExpress. 

2. Dans la fenêtre National Instruments - Boîte de dialogue de licence, 
cliquez sur le bouton Enregistrer Limited Edition. 

3. Suivez les instructions pour activer SignalExpress LE. 

Remarque Vous pouvez aussi activer SignalExpress LE à partir du Gestionnaire de 
licences NI en utilisant le numéro de série listé dans le fichier Readme de SignalExpress.
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2
Utilisation des projets

Vous pouvez utiliser SignalExpress pour définir des procédures de mesure 
en ajoutant et en configurant des étapes dans un environnement de mesure 
interactif. Une étape est une fonction configurable qui acquiert, génère, 
analyse, charge ou enregistre des signaux. Le menu Ajouter une étape et 
la palette Ajouter une étape affichent les étapes disponibles dans 
SignalExpress. 

La plupart des étapes traitent des signaux en entrée et produisent des 
signaux en sortie. Vous pouvez configurer le fonctionnement d’une étape 
en spécifiant des valeurs dans l’onglet Configuration de l’étape propre à 
l’étape. Une séquence enregistrée d’étapes configurées constitue un projet 
SignalExpress.

Ce chapitre vous apprend à charger et à exécuter des projets existants et à 
configurer des étapes dans ces projets.

Ouverture d’un projet
Effectuez les étapes suivantes pour charger un exemple de projet dans 
SignalExpress.

1. Lancez SignalExpress. Sélectionnez Projet vide SignalExpress à 
partir de la fenêtre de démarrage.

Notez que SignalExpress est divisé en affichages qui présentent 
différents types d’informations. L’affichage principal apparaît au 
milieu de la fenêtre d’application et contient des onglets. Si 
SignalExpress s’ouvre avec la configuration par défaut, les onglets 
Affichage des données, Options d’enregistrement et 
Documentation du projet apparaissent dans l’affichage principal. 

L’affichage principal est entouré d’affichages supplémentaires. Dans 
la configuration par défaut, la Vue du projet apparaît à gauche et 
l’aide contextuelle à droite.

Remarque Si SignalExpress détecte un périphérique matériel supporté, l’Affichage des 
voies apparaît en bas de la fenêtre d’application de SignalExpress.
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2. Si SignalExpress ne s’ouvre pas dans la configuration par défaut, 
sélectionnez Affichage»Mise en page»Réinitialiser le projet à la 
mise en page NI par défaut pour réinitialiser la configuration par 
défaut de l’application. Vous pouvez utiliser le menu Affichage pour 
afficher des onglets et des affichages ou réinitialiser la mise en page à 
tout moment.

3. Sélectionnez Aide»Ouvrir un exemple pour ouvrir le répertoire 
SignalExpress\Examples. Naviguez vers le répertoire Tutorial 
et double-cliquez sur First Project.seproj pour ouvrir l’exemple 
de projet. 

4. Observez la fenêtre qui apparaît, comme l’indique la figure 2-1, pour 
vous familiariser avec les différents composants de SignalExpress. 

Figure 2-1.  First Project.seproj

1 Bouton Exécuter
2 Bouton Enregistrer
3 Affichage principal avec l’onglet Affichage des données visible
4 Menu déroulant Zone de travail
5 Vue du projet

6 Étape
7 Entrée
8 Sortie
9 Fenêtre Données enregistrées
10 Aide contextuelle

1 3

10

2

8

6

7

9

4

5
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Exécution d’un projet et affichage de signaux
SignalExpress a plusieurs modes d’exécution. Vous pouvez exécuter des 
projets une fois, en continu ou pendant un nombre d’itérations ou une durée 
que vous spécifiez. Quand vous exécutez un projet une fois, SignalExpress 
exécute toutes les étapes qui apparaissent dans la Vue du projet une fois. 
Quand vous exécutez un projet en continu, SignalExpress exécute toutes 
les étapes du projet en continu. Cliquez sur la flèche vers le bas du bouton 
Exécuter, montré à gauche, et sélectionnez Configurer l’exécution dans 
le menu déroulant pour configurer le mode d’exécution d’un projet.

Les affichages de l’onglet Affichage des données se mettent à jour 
continuellement pendant qu’un projet s’exécute. Quand un projet 
s’exécute, vous pouvez changer les paramètres de configuration de la 
mesure en changeant les paramètres sur l’onglet Configuration de l’étape 
et voir les résultats immédiatement. Les projets qui s’exécutent en continu 
s’exécutent jusqu’à ce que le bouton Arrêter, montré à gauche, soit 
actionné. Le bouton Arrêter apparaît à la place du bouton Exécuter 
lorsqu’un projet s’exécute. 

Effectuez les étapes suivantes pour exécuter l’exemple de projet et afficher 
des signaux.

1. Cliquez sur le bouton Exécuter. Si la boîte de dialogue Informations 
sur l’exécution apparaît, cliquez sur le bouton Exécuter dans cette 
boîte de dialogue pour exécuter toutes les étapes du projet en continu.

Le projet charge un signal à partir d’un fichier texte et effectue deux 
opérations sur le signal : une mesure de l’amplitude et des niveaux et 
une mesure de distorsion. L’étape Amplitude et niveaux et l’étape 
Distorsion effectuent ces mesures, respectivement. Lorsque vous 
exécutez un projet, les étapes analysent des signaux en entrée et 
génèrent de nouveaux signaux en sortie comme résultat de l’analyse. 
Dans ce projet, l’étape Charger un fichier ASCII charge un signal 
sinusoïdal déformé, l’étape Amplitude et niveaux et l’étape Distorsion 
analysent le signal sinusoïdal et les deux étapes renvoient de nouvelles 
sorties. Dans la Vue du projet, SignalExpress indique les entrées avec 
des flèches rouges et les sorties avec des flèches bleues.

L’affichage graphe dans l’onglet Affichage des données contient 
toujours le signal chargé, qui est un signal du domaine temporel. Les 
graphes affichent des signaux XY, du domaine fréquentiel ou du 
domaine temporel. 
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2. Faites glisser le signal en sortie spectre exporté de l’étape Distorsion, 
montrée à gauche, de la Vue du projet vers l’Affichage des données 
pour afficher le signal. 

SignalExpress crée un nouvel affichage graphe dans l’Affichage des 
données. SignalExpress n’affiche pas le signal spectre exporté sur le 
même graphe que le signal du domaine temporel car le signal spectre 
exporté est un signal du domaine fréquentiel. SignalExpress reconnaît 
automatiquement les différents types de signaux et les affiche en 
fonction de leur type.

Astuce Reportez-vous à l’Aide SignalExpress pour obtenir des informations 
complémentaires sur des types de signaux en sélectionnant Aide»Aide SignalExpress, 
en cliquant sur l’onglet Index et en entrant "types de signaux". L’aide offre des 
informations sur l’utilisation des fonctionnalités de SignalExpress telles que les projets, les 
étapes et les signaux.

3. Faites glisser la sortie cc de l’étape Amplitude et niveaux vers l’onglet 
Affichage des données. 

SignalExpress crée un affichage Graphe déroulant contenant à la fois 
un graphe et une table Légende pour afficher la mesure scalaire de la 
sortie cc. La table Légende affiche la valeur de chaque sortie et la 
couleur que SignalExpress utilise pour tracer la sortie sur le graphe 
attenant.

4. Faites glisser la sortie Veff de l’étape Amplitude et niveaux vers 
l’affichage Graphe déroulant pour afficher la mesure scalaire efficace.
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SignalExpress crée une nouvelle ligne dans la table pour afficher la 
deuxième mesure. Le projet apparaît tel que le montre la figure 2-2.

Figure 2-2.  Sorties de My First Project.seproj

Configuration d’une étape
Une étape est une fonction configurable qui acquiert, génère, analyse, 
charge ou enregistre des signaux. Les étapes traitent des signaux en entrée 
et produisent des signaux en sortie. Vous pouvez configurer le 
fonctionnement d’une étape dans SignalExpress en spécifiant des valeurs 
dans l’onglet Configuration de l’étape de l’étape. Pendant qu’un projet 
s’exécute, vous pouvez modifier la configuration des étapes et afficher 
immédiatement le retour d’informations sur l’onglet Affichage des 
données. Ainsi, vous pouvez ajuster les mesures jusqu’à ce que vous 
obteniez les résultats escomptés.
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Effectuez les étapes suivantes pour configurer l’étape Distorsion et l’étape 
Amplitude et niveaux.

1. Double-cliquez sur l’étape Distorsion dans la Vue du projet. 
SignalExpress affiche l’onglet Configuration de l’étape pour l’étape 
Distorsion, comme le montre la figure 2-3.

Figure 2-3.  Onglet Configuration de l’étape Distorsion

Sur la page Configuration de l’onglet Configuration de l’étape, le 
champ Signaux à exporter (DHT) indique que l’étape Distorsion 
exporte le signal en entrée, et le graphe Signal exporté affiche un 
aperçu du signal. Le graphe Spectre de puissance exporté indique 
que l’étape applique un spectre de puissance sur le signal en entrée 
pour le convertir en signal du domaine fréquentiel, et le champ 
Résultats de la mesure affiche la fréquence fondamentale et la 
distorsion harmonique totale (DHT) du signal. L’étape génère le signal 
exporté et trois mesures sous forme de sorties : le spectre, la DHT et la 
fréquence fondamentale de l’entrée du signal du domaine temporel 
d’origine.
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2. Si l’aide contextuelle n’apparaît pas à droite de l’écran, sélectionnez 
Aide»Aide contextuelle pour afficher des informations de référence 
complètes sur l’étape. 

La partie supérieure de l’aide contextuelle affiche des informations sur 
l’étape, et la partie inférieure de l’aide contextuelle affiche des 
informations sur des paramètres spécifiques lorsque le curseur passe 
dessus. Déplacez le curseur sur le paramètre DHT (%) pour afficher 
des informations sur le paramètre.

3. Sur la page Configuration, sélectionnez Ton fondamental dans le 
menu déroulant Signaux à exporter (DHT).

Le graphe Spectre de puissance exporté passe de l’affichage du 
spectre du domaine fréquentiel du signal en entrée complet à 
l’affichage du spectre de fréquence du ton fondamental du signal en 
entrée uniquement. Le signal en sortie de l’étape Distorsion et 
l’affichage graphe de la sortie spectre exporté sur l’onglet Affichage 
des données des données se mettent à jour pour refléter la 
modification que vous avez apportée.

4. Sélectionnez Harmoniques uniquement dans le menu déroulant 
Signaux à exporter (DHT).

Le graphe Spectre de puissance exporté de l’onglet Configuration 
de l’étape et le graphe de la sortie sur l’onglet Affichage des données 
changent tous les deux pour afficher uniquement le spectre des signaux 
harmoniques du signal en entrée.

5. Cliquez sur l’étape Amplitude et niveaux dans la Vue du projet. 

L’onglet Configuration de l’étape qui affichait la configuration de 
l’étape Distorsion, affiche désormais la configuration de l’étape 
Amplitude et niveaux.
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6. Sélectionnez la page Entrée/Sortie pour afficher la liste des entrées et 
des sorties possibles pour cette étape, comme le montre la figure 2-4.

Figure 2-4.  Onglet Configuration de l’étape Amplitude et niveaux

7. Cochez les cases Exporter la valeur max., Exporter la valeur min. 
et Exporter la valeur de pic à pic pour configurer l’étape Amplitude 
et niveaux pour renvoyer trois mesures supplémentaires.

Trois sorties supplémentaires apparaissent dans la Vue du projet.

8. Passez à l’onglet Affichage des données.

9. Faites glisser les trois nouvelles sorties de la Vue du projet vers 
l’affichage Graphe déroulant de mesures scalaires. Les nouvelles 
sorties apparaissent sur le graphe et dans la table Légende.

Remarque Si le projet s’exécute depuis quelques minutes, il se peut que vous deviez 
l’arrêter et le redémarrer pour voir tous les signaux scalaires sur le graphe. SignalExpress 
accumule des points de données pour les signaux que vous ajoutez à un graphe et les 
nouveaux signaux que vous ajoutez n’ont pas autant de points de données à afficher sur le 
graphe. 



Chapitre 2 Utilisation des projets

© National Instruments 2-9 Initiation à SignalExpress

10. Cliquez sur le bouton Arrêter pour arrêter le projet.

Lorsque vous cliquez sur le bouton Arrêter, le projet arrête de 
s’exécuter après avoir terminé le cycle de fonctionnement actuel ou 
l’itération actuelle. Cliquez sur la flèche vers le bas à droite du bouton 
Arrêter et sélectionnez Abandonner dans le menu déroulant pour 
arrêter complètement le projet sans terminer l’itération en cours.

11. Sélectionnez Fichier»Enregistrer le projet sous et enregistrez le 
projet sous le répertoire My First Project.seproj sous 
C:\Program Files\National Instruments\SignalExpress\

Examples\Tutorial.

12. Sélectionnez Fichier»Fermer le projet pour fermer le projet.

Organisation, déplacement et suppression d’étapes
La plupart des étapes dans des projets SignalExpress requièrent des 
données en entrée. Certaines étapes ne peuvent fonctionner que si elles 
reçoivent des signaux d’étapes les précédant dans la Vue du projet. 
L’ordre dans lequel les étapes apparaissent dans la Vue du projet peut 
donc affecter le fonctionnement d’un projet. 

Pour les étapes qui ont une page Entrée ou Entrée/Sortie sur l’onglet 
Configuration de l’étape, le menu déroulant Signal en entrée de cette 
page n’affiche que des signaux compatibles exportés par une étape 
précédente. Lorsque la sortie d’une étape devient l’entrée d’une autre étape, 
les deux étapes deviennent dépendantes l’une de l’autre et s’exécutent de 
manière séquentielle, à la même fréquence. La première étape génère un 
signal en sortie que la deuxième étape doit recevoir comme entrée avant de 
pouvoir s’exécuter.

Vous pouvez déplacer une étape dans un projet en la faisant glisser vers le 
haut ou vers le bas dans la Vue du projet. Vous pouvez supprimer une 
étape en faisant un clic droit dessus dans la Vue du projet et en 
sélectionnant Supprimer dans le menu contextuel. Lorsque vous déplacez 
ou supprimez une étape, l’état des signaux du projet change. Par exemple, 
si vous supprimez une étape qui génère des signaux en sortie, le 
fonctionnement du projet est brisé si l’un des signaux en sortie supprimés 
est l’entrée d’une autre étape et un indicateur d’erreur apparaît dans la Vue 
du projet. Vous pouvez aussi couper, copier et coller des étapes dans un 
projet en appuyant respectivement sur les touches <Ctrl-X>, <Ctrl-C> et 
<Ctrl-V>, ou en cliquant avec le bouton droit sur la Vue du projet et en 
sélectionnant Couper, Copier, Coller avant l’étape sélectionnée ou 
Coller après l’étape sélectionnée dans le menu contextuel.
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Gestion des erreurs et des mises en garde
Si une erreur se produit pendant qu’un projet s’exécute, un indicateur 
d’erreur, montré à gauche, apparaît dans la Vue du projet sur l’étape dans 
laquelle l’erreur s’est produite. Double-cliquez sur l’étape où l’erreur s’est 
produite pour afficher sa description au bas de l’onglet Configuration de 
l’étape. Cliquez sur le bouton Détails à droite de la description de l’erreur 
pour afficher la description complète.

SignalExpress enregistre toutes les erreurs et les mises en garde dans 
l’onglet Journal d’événements pendant l’exécution d’un projet. Pour 
afficher l’onglet Journal d’événements, sélectionnez Affichage»Journal 
d’événements. Reportez-vous à l’Aide SignalExpress pour obtenir des 
informations complémentaires sur les erreurs et les mises en garde en 
sélectionnant Aide»Aide SignalExpress, en cliquant sur l’onglet Index et 
en entrant erreurs.
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3
Manipulation des signaux

Vous pouvez utiliser SignalExpress pour générer et analyser des signaux 
afin d’évaluer des projets de conception sans programmation. Ce chapitre 
vous apprend à travailler avec des signaux dans SignalExpress, en vous 
indiquant notamment comment tracer des signaux sur des graphes, 
importer des signaux d’un fichier, aligner et comparer deux signaux de 
manière interactive et enregistrer des signaux dans un fichier.

Représentation de signaux dans des graphes
Effectuez les étapes suivantes pour tracer des signaux dans un exemple de 
projet et examiner visuellement les signaux à l’aide de curseurs.

1. Sélectionnez Aide»Ouvrir un exemple, pour ouvrir le répertoire 
SignalExpress\Examples. Allez jusqu’au répertoire Tutorial 
puis double-cliquez sur Signals.seproj. Ce projet configure 
l’étape Créer un signal analogique pour qu’elle permette de créer un 
signal carré et l’étape Filtre pour réaliser un filtre Butterworth 
passe-bas.

2. Faites glisser la sortie step signal de l’étape Créer un signal analogique 
vers l’onglet Affichage des données.

3. Faites glisser la sortie filtered step de l’étape Filtre vers l’onglet 
Affichage des données.

Comme les signaux step signal et filtered step sont tous deux des 
signaux temporels, ils apparaissent sur le même affichage graphe. Si 
vous essayez d’afficher des signaux de types différents en les faisant 
glisser sur le même affichage, SignalExpress crée un nouvel affichage.

4. Cliquez sur le bouton Ajouter un affichage, montré à gauche, pour 
créer un nouvel affichage.

Remarque Vous pouvez supprimer des affichages individuels en cliquant sur X dans 
l’angle supérieur droit de l’affichage.

5. Faites glisser la sortie filtered step de l’étape Filtre vers le nouvel 
affichage.
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6. Faites un clic droit sur le nouvel affichage et sélectionnez Éléments 
visibles»Curseurs dans le menu contextuel pour afficher deux 
curseurs interactifs, comme le montre la figure 3-1.

Figure 3-1.  Signals.seproj

Quand vous déplacez les curseurs, SignalExpress affiche les valeurs x 
et y des curseurs dans le tableau de curseurs au bas de l’onglet 
Affichage des données.

7. Sélectionnez Fichier»Enregistrer le projet sous et enregistrez le 
projet sous le répertoire Signals.seproj sous C:\Program 
Files\National Instruments\SignalExpress\Examples\

Tutorial.
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Importation d’un signal à partir d’un fichier
Vous pouvez importer des signaux de formats de fichier standard comme des 
fichiers ASCII délimités par des virgules ou des tabulations et des fichiers de 
données de mesures LabVIEW (.lvm). Vous pouvez aussi importer des 
signaux à partir de résultats simulés d’outils EDA (de conception électronique 
assistée par ordinateur) comme des simulateurs SPICE.

Suivez les étapes ci-après pour importer un signal à partir d’un fichier.

1. Cliquez avec le bouton droit sur la Vue du projet et sélectionnez 
Charger/Enregistrer des signaux»Signaux analogiques»Charger 
un fichier ASCII dans le menu contextuel pour ajouter l’étape 
Charger un fichier ASCII à la Vue du projet. L’onglet Configuration 
de l’étape de l’étape Charger un fichier ASCII apparaît. Cette étape 
analyse un fichier ASCII et affiche les signaux dans le fichier.

Remarque Vous pouvez ajouter des étapes à un projet à partir du menu Ajouter une étape, 
de la palette Ajouter une étape ou à partir du menu contextuel qui apparaît quand vous 
cliquez avec le bouton droit sur la Vue du projet.

2. Confirmez que la, (virgule) est sélectionnée dans le menu déroulant 
Séparateur décimal afin de lire correctement les valeurs dans le 
fichier d’exemple. 

3. Sur l’onglet Configuration de l’étape, cliquez sur le bouton Parcourir, 
montré à gauche puis naviguez vers le répertoire C:\Program 
Files\SignalExpress\Examples\Tutorial et double-cliquez 
sur le fichier Step Response.txt.

Dans la section Aperçu du fichier, la colonne 1 affiche les 
informations d’horodatage et la colonne 2 indique les valeurs de 
tension réelles du signal.

4. Passez à la page Signaux à importer de l’onglet Configuration de 
l’étape pour afficher les signaux disponibles dans le fichier.

5. Assurez-vous qu’une coche apparaît dans la case Colonne 2 pour 
importer ce signal.

L’onglet Configuration de l’étape affiche un aperçu du signal sur le 
graphe Signal importé.

6. Assurez-vous que Colonne 1 apparaît dans le menu déroulant Valeurs 
X en entrée pour définir les données de l’axe des x du signal aux 
valeurs appropriées.

7. Passez à l’onglet Affichage des données.
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8. Dans la Vue du projet, développez la sortie Step Response.txt de 
l’étape Charger un fichier ASCII.

9. Faites un clic droit sur la sortie Colonne 2 et sélectionnez Renommer 
dans le menu contextuel.

10. Entrez réponse indicielle et appuyez sur la touche <Entrée> 
pour renommer la sortie.

11. Faites glisser la nouvelle sortie réponse indicielle de l’étape Charger 
un fichier ASCII vers l’affichage inférieur sur l’onglet Affichage des 
données.

L’affichage du graphe inférieur apparaît pour n’afficher presqu’aucun 
signal.  Cela est dû au fait que l’étape Créer un signal analogique produise 
des signaux avec un horodatage actuel alors que la sortie réponse 
indicielle a un horodatage à zéro.  Cliquez avec le bouton droit sur 
l’affichage du graphe inférieur et sélectionnez Horodatage»Ignorer 
pour voir le signal filtered step et la sortie réponse indicielle.
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Le signal filtered step ressemble au front montant de la sortie réponse 
indicielle, comme le montre la figure 3-2.

Figure 3-2.  Signaux de Signals.seproj

12. Sélectionnez Fichier»Enregistrer le projet pour enregistrer le projet.

Alignement et comparaison de signaux
Bien que le signal filtered step et la sortie réponse indicielle montrent tous 
les deux un overshoot sur le front montant, il est difficile d’évaluer leur 
similarité car ces signaux proviennent de sources différentes et ont une 
amplitude et un cadencement différents. Toutefois, vous pouvez utiliser 
l’étape Alignement interactif pour aligner et comparer deux signaux, de 
sorte que vous puissiez choisir quel type d’informations vous voulez 
exporter de l’opération pour pouvoir les utiliser dans le projet.
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Suivez les étapes ci-après pour aligner deux signaux dans le projet 
Signals.seproj.

1. Développez la sortie Step Response.txt, cliquez avec le bouton droit 
sur la sortie réponse indicielle et sélectionnez Envoyer vers»
Traitement»Signaux analogiques»Alignement interactif dans le 
menu contextuel pour transmettre le signal réponse indicielle de 
l’étape Charger un fichier ASCII à l’étape Alignement interactif. 
Cochez la case Ignorer x0 de l’onglet Alignement pour ignorer les 
incompatibilités d’horodatage.

L’étape sélectionne les deux signaux les plus récents dans le projet à 
utiliser comme entrées et affiche les signaux sur les graphes de l’onglet 
Configuration de l’étape, comme le montre la figure 3-3.

Figure 3-3.  Onglet de configuration de l’étape Alignement interactif

Lorsque vous ajoutez une étape à un projet, SignalExpress sélectionne 
les signaux en entrée en fonction des types de signaux que l’étape 
accepte. Par exemple, l’étape Alignement interactif ne peut être 
utilisée que sur des signaux du domaine temporel. Par conséquent, 
l’étape sélectionne comme entrées les deux signaux du domaine 
temporel créés dans le projet. 
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Remarque Pour changer les signaux en entrée d’une étape, sélectionnez différents signaux 
dans le menu déroulant des signaux compatibles sur la page Entrée ou Entrée/Sortie de 
l’onglet Configuration de l’étape ou cliquez sur la flèche vers le bas qui apparaît à côté 
du nom de l’entrée de l’étape dans Vue du projet.

2. Cliquez sur le signal rouge dans le graphe Signaux en entrée et 
faites-le glisser vers un autre point du graphe. Le graphe Signal 
résultant de la comparaison se met à jour pour afficher la nouvelle 
différence calculée entre les signaux.

Vous pouvez faire glisser, étendre et réduire des signaux sur le graphe.

3. Essayez d’aligner les fronts montants de deux signaux en faisant 
glisser un signal dans le graphe. Cliquez sur un signal pour définir un 
point d’ancrage et maintenez la touche <Alt> enfoncée tout en faisant 
glisser le signal pour l’étendre autour de ce point d’ancrage dans le 
sens des x et des y.

Sur la page Alignement de l’onglet Configuration de l’étape, l’étape 
calcule et affiche le gain des x et des y et les valeurs d’offset dont vous 
avez besoin pour atteindre les spécifications d’alignement lorsque 
vous faites glisser les signaux.

4. Sélectionnez Auto - Créneau dans le menu déroulant Mode pour 
aligner les signaux. SignalExpress calcule l’alignement en utilisant des 
algorithmes intégrés.

Le graphe Signal résultant de la comparaison sur l’onglet 
Configuration de l’étape affiche la différence entre les deux signaux.

5. Sur la page Entrée/Sortie, cochez l’option Exporter les signaux 
alignés pour ajouter les signaux aux sorties de l’étape.

6. Passez à l’onglet Affichage des données.

7. Cliquez sur le bouton Ajouter un affichage pour ajouter un troisième 
affichage.

8. Faites glisser les sorties référence alignée et test aligné de l’étape 
Alignement interactif dans le nouveau graphe pour afficher les signaux 
alignés.

9. Sélectionnez Fichier»Enregistrer le projet pour enregistrer le projet.
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Types de signaux dans SignalExpress
Certaines étapes, comme l’étape Arithmétique, peuvent fonctionner avec 
plusieurs types de signaux. Par exemple, vous pouvez utiliser l’étape 
Arithmétique pour manipuler des signaux des domaines fréquentiel et 
temporel. L’étape Arithmétique adapte son comportement en fonction du type 
de signaux en entrée que vous sélectionnez pour cette étape. Par exemple, si 
vous ajoutez deux signaux du domaine temporel, SignalExpress ajoute 
uniquement leur amplitude. Toutefois, si vous ajoutez deux signaux de phase 
du domaine fréquentiel, SignalExpress ajoute le seuil de décalage approprié.

Reportez-vous à l’Aide SignalExpress pour obtenir des informations 
complémentaires sur des type de signaux en sélectionnant Aide»Aide 
SignalExpress, en cliquant sur l’onglet Index et en entrant "types de 
signaux".

Exportation et impression de signaux
Vous pouvez utiliser SignalExpress pour documenter des signaux ou 
continuer des analyses dans d’autres applications logicielles. Cette section 
vous apprend comment exporter des signaux, notamment en les envoyant 
dans un fichier ASCII, en envoyant les données dans Microsoft Excel, en 
imprimant des signaux et en utilisant la fonctionnalité de documentation 
intégrée pour documenter le projet SignalExpress.

Enregistrement de signaux dans un fichier
Effectuez les étapes suivantes pour enregistrer un signal du projet 
Signals.seproj dans un fichier.

1. Cliquez sur le bouton Ajouter une étape, montré à gauche, pour 
afficher la palette Ajouter une étape.

2. Sélectionnez Charger/Enregistrer des signaux»Signaux 
analogiques»Enregistrer au format ASCII/LVM pour ajouter 
l’étape Enregistrer au format ASCII/LVM à la Vue du projet. L’onglet 
Configuration de l’étape de l’étape Enregistrer au format 
ASCII/LVM apparaît.

3. Cliquez sur la page Signaux de l’onglet Configuration de l’étape et 
sélectionnez filtered step dans le menu déroulant Données en entrée.

4. Sur la page Paramètres du fichier, spécifiez où enregistrer le fichier 
texte que vous créez en cliquant sur le bouton Parcourir situé à côté 
du champ Chemin du fichier d’export et en naviguant vers le 
répertoire C:\Program Files\National Instruments\
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SignalExpress\Examples\Tutorial. Entrez signal 
filtré.txt comme nom de fichier.

5. Sélectionnez Remplacer dans le menu déroulant Si le fichier existe.

6. Sélectionnez ASCII générique (.txt) dans le menu déroulant Type du 
fichier d’export.

Vous pouvez utiliser l’étape Charger/Enregistrer les signaux pour 
enregistrer des données dans un fichier chaque fois que le projet 
s’exécute.

7. Cliquez sur la flèche vers le bas du bouton Exécuter et sélectionnez 
Exécuter une fois pour exécuter le projet et enregistrer le signal 
résultant dans le fichier ASCII spécifié.

8. Sélectionnez Fichier»Enregistrer le projet pour enregistrer le projet.

9. Sélectionnez Fichier»Fermer le projet pour fermer le projet.

10. Naviguez vers le fichier signal filtré.txt et ouvrez-le dans un 
éditeur de texte pour voir les valeurs du signal. Dans SignalExpress, 
vous pouvez utiliser l’étape Charger un fichier ASCII pour réimporter 
le signal dans un projet.

Exportation de signaux dans Microsoft Excel
Pour exporter des données de signaux dans Microsoft Excel, lancez Excel 
et faites glisser le signal en sortie d’une étape de SignalExpress dans un 
fichier tableur Excel. Vous pouvez aussi cliquer avec le bouton droit sur un 
affichage de l’onglet Affichage des données et sélectionner Exporter 
vers»Microsoft Excel pour exporter toutes les données de l’affichage.

Création de rapports dans SignalExpress
Sélectionnez Affichage»Documentation du projet pour afficher l’onglet 
Documentation du projet. Vous pouvez utiliser cet onglet pour décrire un 
projet en utilisant du texte et des images comme des graphes. Vous pouvez 
faire glisser une sortie d’étape de la Vue du projet vers l’onglet 
Documentation du projet pour afficher un graphe du signal en sortie. Si 
le projet est en cours d’exécution, le graphe sur l’onglet Documentation 
du projet se met automatiquement à jour pour représenter la valeur 
actuelle de la sortie de l’étape. 

Pour imprimer la documentation, affichez l’onglet Documentation du projet 
et sélectionnez Fichier»Imprimer»Imprimer la documentation ou cliquez 
sur le bouton Imprimer la documentation. Pour exporter la documentation au 
format HTML, affichez l’onglet Documentation du projet et sélectionnez 
Fichier»Exporter»Exporter la documentation en HTML.
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4
Enregistrement des données

Vous pouvez utiliser SignalExpress pour enregistrer et analyser vos 
mesures. Vous pouvez enregistrer n’importe quelle sortie d’étape du 
domaine temporel, de type entier non signé 32 bits, double, booléenne ou 
numérique. Vous pouvez aussi analyser et traiter les données ainsi 
enregistrées en les relisant avec les étapes d’analyse. 

Ce chapitre vous apprend à enregistrer des données en utilisant les 
fonctionnalités d’enregistrement de données intégrées à SignalExpress. 
Vous apprendrez à enregistrer un signal spécifié, à relire ce signal et à 
l’analyser en utilisant des étapes d’analyse. Vous allez également apprendre 
à utiliser l’onglet Options d’enregistrement pour enregistrer des signaux 
en fonction de conditions de démarrage et d’arrêt spécifiées. 

Enregistrement d’un signal
Vous pouvez utiliser le bouton Enregistrer pour configurer un processus 
d’enregistrement de données. 

Effectuez les étapes suivantes pour spécifier le signal à enregistrer et 
l’enregistrer.

1. Sélectionnez Aide»Ouvrir un exemple, naviguez vers le répertoire 
Tutorial et double-cliquez sur Logging.seproj.

Ce projet utilise l’étape Créer un signal analogique pour générer un 
signal sur la base d’une formule.

2. Cliquez sur le bouton Enregistrer, illustré à gauche, pour afficher la 
boîte de dialogue Sélection des signaux à enregistrer.

La boîte de dialogue Sélection des signaux à enregistrer affiche les 
signaux dans le projet disponible pour l’enregistrement. Vous pouvez 
sélectionner un ou plusieurs signaux à enregistrer. Vous pouvez aussi 
spécifier un nom et une description pour l’enregistrement.

3. Cochez la case signal pour enregistrer le signal de la formule généré 
par l’étape Créer un signal analogique.

4. Cliquez sur le bouton OK pour fermer la boîte de dialogue Sélection 
des signaux à enregistrer et commencer l’enregistrement du signal. 
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L’enregistrement se poursuit jusqu’à ce que vous cliquiez sur le bouton 
Arrêter.

5. Cliquez sur le bouton Arrêter, montré à gauche, pour arrêter le projet. 
Si c’est la première fois que vous enregistrez un signal, la boîte de 
dialogue Premier journal terminé apparaît. Cliquez sur le bouton 
OK pour fermer la boîte de dialogue.

Les données enregistrées apparaissent dans la fenêtre Données 
enregistrées au bas de la Vue du projet, comme le montre la 
figure 4-1.

Figure 4-1.  Fenêtre Données enregistrées

Par défaut, SignalExpress nomme les données enregistrées d’après la 
date et l’heure de leur enregistrement. SignalExpress enregistre des 
données au format de fichier .tdms dans le répertoire que vous 
spécifiez dans la boîte de dialogue Options. 

6. Sélectionnez Outils»Options puis sélectionnez l’option 
Enregistrement pour spécifier le répertoire dans lequel SignalExpress 
enregistre les données et pour personnaliser différentes préférences 
pour les données enregistrées.

7. Cliquez sur le bouton OK pour fermer la boîte de dialogue Options.

8. Sélectionnez Fichier»Enregistrer le projet sous et enregistrez le 
projet sous le répertoire My Logging.seproj sous C:\Program 
Files\National Instruments\SignalExpress\Examples\

Tutorial.
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Affichage d’un signal enregistré dans un journal
Effectuez les étapes suivantes pour afficher les données enregistrées dans 
un fichier journal.

1. Si l’onglet Affichage des données n’est pas visible, sélectionnez 
Affichage»Affichage des données pour le faire apparaître. 

2. La fenêtre Données enregistrées présente la liste de toutes les données 
enregistrées dans le projet actuel. Sélectionnez le journal de données 
que vous venez d’enregistrer dans la fenêtre Données enregistrées et 
faites-le glisser dans l’onglet Affichage des données. L’onglet 
Affichage des données affiche les données enregistrées et un graphe 
d’aperçu, comme le montre la figure 4-2 dans laquelle l’aide 
contextuelle est fermée. Il se peut que le signal qui apparaît sur l’onglet 
Affichage des données diffère du signal montré sur la figure 4-2 en 
fonction de la durée de votre enregistrement.

Figure 4-2.  Logging.seproj

Le graphe d’aperçu offre la possibilité de zoomer sur les données et de 
les faire défiler horizontalement dans l’onglet Affichage des données. 
Le graphe d’aperçu apparaît par défaut lorsque vous affichez des 
données enregistrées. Lorsque vous affichez des données en direct ou 
non enregistrées, cliquez avec le bouton droit sur un affichage de 

1 Données enregistrées 2 Graphe d’aperçu

1

2
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l’onglet Affichage des données et sélectionnez Éléments visibles»
Aperçu dans le menu contextuel pour afficher le graphe d’aperçu.

Cliquez sur le bouton Zoom avant à côté du graphe d’aperçu pour 
effectuer un zoom avant sur le signal enregistré. Les curseurs sur le 
graphe d’aperçu montrent le sous-ensemble de données actuellement 
affiché sur l’onglet Affichage des données. Utilisez la barre de 
défilement en dessous du graphe d’aperçu pour faire défiler les 
données. Cliquez sur le curseur et faites-le glisser sur le graphe 
d’aperçu pour agrandir ou réduire le sous-ensemble des données 
affichées.

Enregistrement de signaux avec des conditions de 
démarrage et d’arrêt prédéfinies

Vous pouvez configurer des conditions de démarrage et d’arrêt que les 
signaux doivent respecter avant que SignalExpress les enregistre ou arrête 
de les enregistrer. Effectuez les étapes suivantes pour enregistrer les 
données en fonction de conditions de démarrage et d’arrêt.

1. Si l’onglet Options d’enregistrement n’est pas visible, sélectionnez 
Affichage»Options d’enregistrement pour l’ouvrir.

2. Sélectionnez Sélection des signaux dans la liste de Catégorie de 
l’onglet Options d’enregistrement.
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3. Cochez la case du signal dans la colonne Enregistrer, comme le 
montre la figure 4-3.

Figure 4-3.  Sélection des signaux

Le bouton Enregistrer devient le bouton Enregistrer pendant 
l’exécution, montré à gauche. Assurez-vous que le bouton 
Enregistrer pendant l’exécution est enclenché. Quand le bouton 
Enregistrer pendant l’exécution est enclenché, SignalExpress 
enregistre le signal sélectionné quand vous cliquez sur le bouton 
Exécuter.

4. Sélectionnez Conditions de démarrage dans la liste Catégorie de 
l’onglet Options d’enregistrement. 

5. Cliquez sur le bouton Ajouter situé sous la Liste des conditions de 
démarrage pour personnaliser une condition de démarrage pour une 
tâche d’enregistrement.

a. Dans le menu déroulant Type de condition, assurez-vous que 
Déclenchement du signal est sélectionné pour spécifier que 
SignalExpress commence l’enregistrement quand le signal en 
entrée remplit la condition spécifiée.

b. Dans le menu déroulant Signal, assurez-vous que signal est 
sélectionné.



Chapitre 4 Enregistrement des données

Initiation à SignalExpress 4-6 ni.com

c. Dans le menu déroulant Type de déclenchement, vérifiez que 
l’option Pente montante est sélectionnée pour spécifier le début 
de l’enregistrement du signal en fonction de la valeur du front du 
signal sur la pente positive.

d. Entrez 1 dans le champ Valeur de déclenchement pour 
commencer l’enregistrement quand le signal passe 1 sur une pente 
montante.

6. Sélectionnez Conditions d’arrêt dans la liste Catégorie de l’onglet 
Options d’enregistrement.

7. Cliquez sur le bouton Ajouter situé sous la Liste des conditions 
d’arrêt pour personnaliser la condition d’arrêt d’une tâche 
d’enregistrement.

a. Dans le menu déroulant Type de condition, vérifiez que l’option 
Durée est sélectionnée pour spécifier que SignalExpress arrête 
l’enregistrement après un laps de temps défini.

b. Sur la commande Durée (s), assurez-vous que 5 apparaît pour 
spécifier la fin de l’enregistrement 5 secondes après le début du 
signal.

8. Cliquez sur le bouton Exécuter, montré à gauche. SignalExpress 
commence à enregistrer le signal quand celui-ci atteint le niveau 1 sur 
une pente montante et continue à l’enregistrer pendant 5 secondes. 

Les indicateurs suivants dans la section État de l’enregistrement de 
l’onglet Options d’enregistrement se met à jour pendant que le projet 
s’exécute.

• Enregistrement affiche activé quand le signal remplit la 
condition de démarrage et que l’enregistrement est en cours. 

• Infos sur le disque affiche l’espace disque disponible sur 
l’ordinateur pour le journal. 

• Taille estimée du journal affiche la taille du fichier journal sur le 
disque.

• Temps d’enreg. disponible affiche pendant combien de temps 
vous pouvez continuer l’enregistrement du journal avant d’être à 
cours d’espace sur le disque.

• Journal en cours démarré à affiche le temps de départ du journal 
actuel.

Les pages Conditions de démarrage, Conditions d’arrêt, Alarmes et 
Événements de l’onglet Options d’enregistrement comprennent aussi 
des indicateurs qui affichent l’état des conditions de démarrage, des 
conditions d’arrêt, des alarmes et des événements que vous configurez.
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Analyse des signaux enregistrés
Une fois que vous avez enregistré un signal, vous pouvez repasser les 
données enregistrées ou exécuter le signal enregistré via les étapes 
d’analyse, comme vous pouvez le faire avec les données en direct. 
Effectuez les étapes suivantes pour analyser un signal enregistré.

1. Repérez le menu déroulant Zone de travail au-dessus de la Vue du 
projet, comme le montre la figure 4-4. Cliquez sur la flèche vers le bas 
et sélectionnez Relecture pour passer à la zone de travail de Relecture.

Figure 4-4.  Menu déroulant Zone de travail

Utilisez des zones de travail pour effectuer plusieurs étapes 
SignalExpress à partir du même projet. Vous pouvez acquérir des 
données, traiter des signaux, enregistrer les données dans un fichier 
journal et effectuer des mesures sur les données enregistrées sans 
devoir ouvrir un nouveau projet. Lorsque vous enregistrez un projet, 
SignalExpress enregistre toutes les zones de travail qui s’y trouvent 
dans le même fichier de projet.

La zone de travail par défaut, Surveillance/Enregistrement, vous 
permet de prendre des mesures, d’analyser des données en direct et 
d’enregistrer des données. La zone de travail Relecture vous permet 
d’utiliser des données enregistrées dans la zone de travail 
Surveillance/Enregistrement comme entrée d’une étape d’analyse.

2. Cliquez sur le bouton Ajouter une étape, montré à gauche, et 
sélectionnez l’étape Filtre en sélectionnant Traitement»Signaux 
analogiques»Filtre. SignalExpress sélectionne automatiquement le 
premier signal que vous avez enregistré comme entrée de l’étape Filtre.

3. Passez à l’onglet Affichage des données, faites glisser la sortie 
filtered data de l’étape Filtre vers l’Affichage des données pour 
afficher le signal résultant.

4. Cliquez sur le bouton Exécuter. L’onglet Affichage des données 
affiche le signal filtré résultant et SignalExpress relit tout le journal.
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Relecture avancée
Vous pouvez utiliser l’onglet Options de relecture pour configurer des 
options de relecture des données avancées. L’onglet Options de relecture 
affiche un aperçu des données enregistrées et vous permet de sélectionner 
un sous-ensemble de ces données à relire ou à exécuter via des étapes 
d’analyse.

1. Sélectionnez Affichage»Options de relecture pour afficher l’onglet 
Options de relecture, comme le montre la figure 4-5. 

Figure 4-5.  Onglet Options de relecture

2. Dans la liste déroulante Signal enregistré, sélectionnez signal dans le 
deuxième journal que vous avez créé.

3. Entrez 1 dans le champ Temps de début (s) pour relire ou analyser un 
sous-ensemble du signal enregistré qui commence une seconde après 
le début du journal. 

4. Entrez 4 dans le champ Temps de fin (s) pour relire ou analyser un 
sous-ensemble du signal enregistré qui commence quatre secondes après 
le début du journal. Si la durée du journal est inférieure à 4 secondes, 
entrez la valeur appropriée dans le champ Temps de fin (s). 

5. Dans la liste déroulante Signal enregistré, cliquez avec le bouton droit 
sur le signal du deuxième journal et sélectionnez Activer dans le menu 
contextuel pour définir le signal comme journal actif.
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Remarque Vous pouvez aussi cliquer avec le bouton droit sur un journal dans la fenêtre 
Données enregistrées et sélectionner Rendre le journal actif dans le menu contextuel 
pour définir ce journal comme le journal actif.

6. Passez à l’onglet Affichage des données. L’affichage graphe sur 
l’onglet Affichage des données fait automatiquement apparaître le 
deuxième journal quand vous définissez ce signal comme le signal 
actif. 

7. Cliquez sur le bouton Exécuter, montré à gauche. SignalExpress filtre 
le sous-ensemble du signal que vous avez spécifié dans l’onglet 
Options de relecture et affiche le signal filtré résultant dans l’onglet 
Affichage des données.

8. Sélectionnez Fichier»Fermer le projet pour fermer le projet. La boîte 
de dialogue Enregistrer les changements du projet ? apparaît. 
Sélectionnez l’option Ignorer les changements du projet et 
supprimer les nouveaux journaux du disque. Vous pouvez aussi 
sélectionner les options Enregistrer le projet et les journaux et 
Ignorer les changements du projet et conserver les journaux sur 
disque.

Reportez-vous à l’Aide SignalExpress, disponible en sélectionnant Aide»
Aide SignalExpress, pour obtenir des informations complémentaires sur 
l’enregistrement de données, comme la spécification de conditions 
d’alarme, d’événements et les options de relecture.
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5
Réalisation de mesures de 
balayage

Vous pouvez utiliser SignalExpress pour automatiser les mesures afin de 
caractériser et valider des systèmes en créant des opérations de balayage. 
Un système peut être quelque chose que vous créez que vous voulez 
caractériser et valider avec SignalExpress. Vous pouvez utiliser les mesures 
de balayage pour rassembler des données de systèmes en fonction d’une 
gamme de conditions pour documenter leurs performances. Par exemple, 
vous pouvez utiliser des opérations de balayage pour faire varier la 
fréquence d’un signal d’impulsion ou le niveau d’une tension 
d’alimentation tout en prenant des mesures pour définir les caractéristiques 
des systèmes.

Ce chapitre vous apprend comment configurer des opérations de balayage 
en utilisant l’étape Balayage dans SignalExpress. Vous allez apprendre 
comment définir les caractéristiques des performances d’un filtre en 
balayant une gamme des valeurs de fréquence et en mesurant la sortie du 
filtre. Vous allez aussi apprendre à afficher les résultats du balayage et 
effectuer des balayages multidimensionnels pour effectuer des mesures 
plus complexes.

Définition de sorties et de gammes de balayage 
Vous pouvez utiliser l’étape Balayage dans SignalExpress pour définir des 
mesures automatisées dans le cadre d’opérations de balayage complexes et 
susceptibles d’être répétées.

Effectuez les étapes suivantes pour définir une gamme de fréquence à 
balayer dans un exemple de projet utilisant un filtre.

1. Sélectionnez Aide»Ouvrir un exemple, naviguez vers le répertoire 
Tutorial et double-cliquez sur Sweep.seproj.

2. Cliquez sur le bouton Exécuter, montré à gauche, pour exécuter le 
projet en continu.

Le projet génère un signal d’impulsion sinusoïdal à l’étape Créer un 
signal analogique, ce signal passe ensuite dans un filtre passe-bande 
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elliptique à l’étape Filtre, mesure le niveau Veff de la sortie du filtre à 
l’étape Amplitude et niveaux et convertit le niveau en décibels (dB) à 
l’étape Formule. L’étape Filtre agit comme une unité simulée en cours 
de test, le projet n’utilise donc pas de matériel. Toutefois, vous pouvez 
aussi balayer des signaux physiques générés à partir d’un générateur 
de fonctions, de l’analyseur de signaux dynamiques, d’un périphérique 
d’E/S multifonction (MIO) ou d’un générateur de signaux arbitraires 
National Instruments.

3. Cliquez sur le bouton Arrêter pour arrêter le projet.

4. Cliquez sur le bouton Ajouter une étape, montré à gauche, et 
sélectionnez Contrôle d’exécution»Balayage pour ajouter l’étape 
Balayage à la Vue du projet.

5. Sur l’onglet Configuration de l’étape, cliquez sur le bouton Ajouter 
pour afficher la liste des paramètres balayables à partir de chaque étape 
du projet, comme le montre la figure 5-1.

Figure 5-1.  Boîte de dialogue Sélection du paramètre de balayage

6. Sélectionnez le paramètre Fréquence (Hz) sous Créer un signal 
analogique et cliquez sur le bouton OK.

L’étape Balayage comprend l’étape Créer un signal analogique qui 
fournit le signal à balayer.

7. Sur la page Configuration du balayage de l’onglet Configuration de 
l’étape, sélectionnez Exponentiel dans le menu déroulant Type.

8. Entrez 1k dans le champ Départ : Fréquence (Hz), et entrez 40k dans 
le champ Arrêt : Fréquence (Hz).
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9. Entrez 150 dans le champ Nombre de points.

La page Configuration du balayage apparaît comme le montre la 
figure 5-2.

Figure 5-2.  Onglet Configuration de l’étape Balayage

Vous utilisez l’étape Balayage pour spécifier une gamme de valeurs sur 
laquelle effectuer des itérations dans le paramètre Fréquence (Hz) de 
l’étape Créer un signal analogique. L’étape Créer un signal analogique 
utilise la gamme de fréquence définie pour générer un signal 
sinusoïdal à chacune de ces fréquences. Vous pouvez utiliser l’étape 
Balayage pour effectuer des itérations sur toute valeur d’un paramètre 
susceptible d’être balayé de n’importe quelle étape d’un projet 
elle-même susceptible d’être balayée.

10. Passez à la page Sortie du balayage.

11. Cliquez sur le bouton Ajouter pour afficher la liste des sorties pouvant 
être balayées pour chaque étape du projet.

12. Sélectionnez la sortie response amplitude in dB sous Formule et 
cliquez sur le bouton OK pour tracer cette mesure par rapport au 
paramètre Fréquence (Hz) balayé.
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L’étape Balayage crée une boucle autour de toutes les étapes de la Vue 
du projet pour inclure toutes les étapes dans l’opération de balayage.

Exécution de mesures balayées
Effectuez les étapes suivantes pour exécuter la mesure de balayage.

1. Passez à l’onglet Affichage des données, cliquez sur la flèche vers le 
bas du bouton Exécuter et sélectionnez Exécuter une fois pour 
exécuter la mesure balayée.

La sortie blanche stimulus signal sur l’affichage graphe itère dans la 
gamme de fréquences spécifiée.

2. Faites glisser le signal response amplitude in dB vs. Fréquence du 
bas de la boucle de balayage vers l’Affichage des données pour 
afficher la sortie du balayage.

SignalExpress crée un nouvel affichage graphe. Les données d’une 
opération de balayage sont représentées dans un tableau XY qui 
requiert un affichage séparé, comme le montre la figure 5-3.

Figure 5-3.  Sweep.seproj
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3. Sélectionnez l’option Exécuter une fois pour exécuter à nouveau le 
balayage.

La réponse en fréquence de l’étape Filtre est tracée sur le nouvel 
affichage graphe pendant que le projet s’exécute. Le graphe montre la 
fonction de transfert du filtre, ou la sortie d’amplitude exprimée en 
décibels par rapport à la fréquence.

Remarque Par défaut, SignalExpress ne réinitialise pas les affichages sur l’onglet 
Affichage des données entre les itérations d’un balayage. Dans la mesure où la réponse en 
fréquence de l’étape Filtre est la même à chaque itération, le graphe qui affiche le signal ne 
semble pas se mettre à jour quand vous exécutez le projet. Vous pouvez utiliser la page 
Données de la boîte de dialogue Options pour indiquer si SignalExpress supprime le 
résultat du balayage sur les affichages entre des itérations d’un balayage. Sélectionnez 
Outils»Options pour afficher la boîte de dialogue Options.

4. Double-cliquez sur l’étape Filtre pour afficher les spécifications du 
filtre dans l’onglet Configuration de l’étape.

La réponse en fréquence du filtre dans le graphe Réponse en 
amplitude du filtre (dB) correspond au graphe de l’onglet Affichage 
des données.

5. Sélectionnez Fichier»Enregistrer le projet sous et enregistrez le 
projet sous le répertoire My Sweep.seproj sous C:\Program 
Files\National Instruments\SignalExpress\Examples\

Tutorial.

Vous pouvez utiliser l’étape Balayage pour balayer plusieurs paramètres 
simultanément en ajoutant des paramètres supplémentaires sur la page 
Configuration du balayage de l’onglet Configuration de l’étape de 
l’étape Balayage. Le balayage simultané de plusieurs paramètres est appelé 
balayage parallèle. Par exemple, si vous voulez varier l’amplitude d’un 
signal de stimulus, vous pouvez exécuter un balayage en parallèle pour 
optimiser la précision de l’acquisition en variant la gamme en entrée d’un 
numériseur ou d’un périphérique MIO tout en variant le niveau du signal. 
À mesure que le niveau du signal augmente, vous pouvez augmenter la 
gamme d’entrée du périphérique de mesure pour vous assurer que vous 
utilisez toute la résolution pour la mesure.
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Exécution de balayages multidimensionnels
Utilisez des balayages multidimensionnels ou imbriqués pour effectuer des 
itérations sur une gamme tout en faisant varier une autre gamme. Par 
exemple, si vous voulez effectuer des itérations sur des fréquences d’un 
signal d’impulsion à différentes amplitudes, exécutez un balayage 
imbriqué. Vous pouvez définir l’amplitude au niveau 1 et effectuer des 
itérations sur des fréquences, puis définir l’amplitude au niveau 2 et 
effectuer des itérations sur des fréquences, et ainsi de suite. Vous pouvez 
construire un balayage imbriqué en cliquant avec le bouton droit sur l’étape 
Balayage dans un projet en sélectionnant Ajouter un balayage imbriqué 
dans le menu contextuel pour ajouter une autre boucle de balayage. 

Effectuez les étapes suivantes pour exécuter un exemple de projet de 
balayage imbriqué.

1. Sélectionnez Aide»Ouvrir un exemple, naviguez vers le répertoire 
Tutorial et double-cliquez sur Nested Sweep.seproj.

2. Cliquez sur le bouton Exécuter pour exécuter le projet.

Chaque itération de la boucle de balayage interne balaie la fréquence 
du signal d’impulsion. La boucle de balayage externe fait varier les 
fréquences de coupure basse et haute de l’étape Filtre. Chaque itération 
apparaît en temps réel sur l’affichage graphe supérieur, puis apparaît 
sur l’affichage graphe inférieur pour montrer tous les balayages à 
chaque configuration de la fréquence de coupure, comme le montre la 
figure 5-4.
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Figure 5-4.  Nested Sweep.seproj

3. Cliquez sur le bouton Arrêter, montré à gauche, pour arrêter le projet.
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6
Extension des projets 
SignalExpress avec LabVIEW

Vous pouvez utiliser SignalExpress pour définir des mesures automatisées 
en utilisant les étapes intégrées pour acquérir, générer ou analyser des 
signaux. Vous pouvez étendre la fonctionnalité des projets SignalExpress 
en utilisant LabVIEW des façons suivantes :

• Construisez un VI dans LabVIEW et importez-le dans SignalExpress 
pour fournir une fonctionnalité d’étape personnalisée et étendre le 
nombre d’étapes disponibles dans SignalExpress.

• Convertissez un projet SignalExpress en un VI LabVIEW pour 
poursuivre le développement dans LabVIEW.

Importation de VIs LabVIEW dans SignalExpress sous 
forme d’étapes

Utilisez les étapes Exécuter un VI LabVIEW de SignalExpress pour 
appeler des VIs LabVIEW personnalisés. 

Remarque Il n’est pas nécessaire d’installer le système de développement LabVIEW pour 
utiliser une étape Exécuter un VI LabVIEW. Les étapes Exécuter un VI LabVIEW ne 
supportent pas les VIs développés dans les versions 64 bits de LabVIEW.

Vous pouvez appeler un VI LabVIEW dans SignalExpress pour effectuer 
les tâches suivantes :

• Contrôle des instruments GPIB

• Contrôle du matériel National Instruments non supporté par 
SignalExpress

• Lise ou écrive des données dans davantage de formats de fichier

• Affiche des instructions destinées à l’opérateur dans une boîte de 
dialogue locale

• Définisse un algorithme de mesure
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Effectuez les étapes suivantes pour importer un VI LabVIEW avec l’étape 
Exécuter un VI LabVIEW. 

1. Sélectionnez Aide»Ouvrir un exemple, naviguez vers le répertoire 
Tutorial et double-cliquez sur User Step.seproj.

Ce projet utilise l’étape Créer un signal analogique pour générer un 
signal.

2. Cliquez sur le bouton Ajouter une étape, montré à gauche, et 
sélectionnez Exécuter un VI LabVIEW»Exécuter un VI 
LabVIEW 2011. 

Remarque Le VI que vous exécutez dans cet exercice a été enregistré dans 
LabVIEW 2011. Vous devez utiliser la version de l’étape Exécuter un VI LabVIEW qui 
correspond à la version de LabVIEW dans laquelle vous avez enregistré le VI.

3. Sur l’onglet Configuration de l’étape, cliquez sur le bouton Parcourir 
dans la section Sélectionnez le VI et sélectionnez 
Limiter-LV2011.vi dans le répertoire C:\Program Files\
National Instruments\SignalExpress\Examples\

Tutorial. Le VI Limiter-LV2011 accepte un signal du domaine 
temporel comme entrée, écrête le signal au-dessus et en dessous des 
valeurs que vous spécifiez dans la boîte de dialogue Configuration de 
l’étape, et renvoie le signal écrêté en sortie.

Lorsque vous importez un VI LabVIEW, SignalExpress mappe les 
entrées du VI comme paramètres et les sorties du VI comme signaux 
en sortie dans SignalExpress.

Vous pouvez définir si les entrées des VIs deviennent des signaux en 
entrée ou des paramètres. Un signal en entrée apparaît dans la Vue du 
projet comme une entrée d’une étape, ce qui signifie que vous pouvez 
transmettre des signaux à un VI sous la forme d’entrées. Un paramètre 
est une valeur que vous pouvez configurer dans l’onglet 
Configuration de l’étape d’une étape. Vous pouvez aussi balayer des 
paramètres de manière dynamique en utilisant l’étape Balayage. Dans 
ce projet, le VI possède un signal en entrée Signal temporel en entrée 
et les paramètres scalaires Limite supérieure et Limite inférieure.
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Assurez-vous que l’onglet Configuration de l’étape apparaît comme 
dans la figure 6-1.

Figure 6-1.  Onglet de configuration de l’étape VI Limiter

4. Cliquez sur le bouton Exécuter, montré à gauche, pour exécuter le 
projet. 

5. Passez à l’onglet Affichage des données et faites glisser le signal 
en sortie Clipped waveform out de l’étape Exécuter un 
VI LabVIEW 2011 vers l’onglet Affichage des données.

6. Double-cliquez sur l’étape Exécuter un VI LabVIEW 2011 pour 
afficher l’onglet Configuration de l’étape.

7. Sélectionnez la page Configurer le VI pour afficher le VI. 

8. Entrez de nouvelles valeurs dans les champs Limite supérieure et 
Limite inférieure. Par exemple, entrez 100 dans le champ Limite 
supérieure.

9. Passez à l’onglet Affichage des données. Le signal Clipped 
waveform out change pour refléter les modifications effectuées.

10. Cliquez sur le bouton Arrêter, montré à gauche, pour arrêter le projet.
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11. Sélectionnez Fichier»Enregistrer sous et enregistrez le projet sous 
Mon étape utilisateur.seproj.

12. Sélectionnez Fichier»Fermer le projet pour fermer le projet.

Reportez-vous à l’Aide SignalExpress pour obtenir davantage 
d’informations sur l’utilisation de VIs LabVIEW dans SignalExpress et sur 
la construction de VIs qui fonctionnent sous SignalExpress.

Conversion de projets SignalExpress en VIs LabVIEW
SignalExpress peut convertir des projets SignalExpress en VIs LabVIEW.

Remarque Pour convertir un projet SignalExpress en VI LabVIEW, le système de 
développement complet de LabVIEW 8.2 ou une version ultérieure doit être installée.

Effectuez les étapes suivantes pour convertir un projet SignalExpress en 
VI LabVIEW.

1. Sélectionnez Aide»Ouvrir un exemple, naviguez vers le répertoire 
Tutorial\Solutions et double-cliquez sur My First 
Project.seproj.

2. Sélectionnez Outils»Générer le code»Diagramme LabVIEW.

3. Spécifiez un nom de fichier et un emplacement pour le VI LabVIEW 
et cliquez sur le bouton OK. SignalExpress génère le nouveau VI et 
l’ouvre dans la dernière version de LabVIEW ouverte sur votre 
machine.

Le VI LabVIEW résultant reflète l’exécution du projet dans 
SignalExpress. Le diagramme comprend des VIs Express LabVIEW 
câblés entre eux. Chaque VI Express correspond à une étape dans le 
projet SignalExpress. Vous pouvez double-cliquer sur un VI Express 
pour afficher une boîte de dialogue de configuration identique à 
l’onglet Configuration de l’étape dans SignalExpress. Vous pouvez 
également effectuer un clic droit sur un VI Express et sélectionner 
Ouvrir la face-avant dans le menu contextuel pour convertir le VI 
Express en un sous-VI LabVIEW. Vous pouvez afficher le diagramme 
LabVIEW pour voir comment il s’exécute et modifier la fonctionnalité 
du VI. Lorsque vous convertissez un VI Express en sous-VI, vous ne 
pouvez plus convertir le sous-VI en VI Express.

Remarque Lorsque vous convertissez un projet SignalExpress comportant un 
enregistrement dans un fichier journal, SignalExpress génère un diagramme LabVIEW 
avec un VI Express. Vous ne pouvez pas convertir le VI Express généré en un sous-VI.
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7
Et maintenant ?

Reportez-vous aux ressources suivantes pour obtenir de plus amples 
informations sur SignalExpress.

Exemples de projets SignalExpress
SignalExpress offre une variété d’exemples de projets qui démontrent 
davantage de possibilités de SignalExpress. Ces projets se trouvent sous le 
répertoire C:\Program Files\National Instruments\
SignalExpress\Examples. Passez ces exemples en revue pour en 
savoir plus sur les fonctionnalités de SignalExpress ou pour démarrer avec 
un projet qui s’approche de vos exigences.

Utilisation du matériel avec SignalExpress
SignalExpress supporte de nombreux périphériques National Instruments 
d’acquisition et de génération de signaux. Vous pouvez générer ou acquérir 
des signaux analogiques dans SignalExpress en utilisant des numériseurs 
haute vitesse, des périphériques d’acquisition de signaux dynamiques, des 
générateurs de waveform arbitraires et des générateurs de fonctions ou des 
périphériques MIO National Instruments. Vous pouvez aussi synchroniser 
plusieurs périphériques dans un système en partageant des signaux 
d’horloge et de déclenchement entre des périphériques. Reportez-vous à 
l’Aide SignalExpress en sélectionnant Aide»Aide SignalExpress pour 
obtenir des informations complémentaires sur l’utilisation de périphériques 
avec SignalExpress.

Ressources Web
Reportez-vous au site Web de National Instruments sur ni.com/
labview/signalexpress/f/ pour obtenir des ressources telles que des 
exemples de projets, de la documentation technique et des VIs LabVIEW 
écrits pour être utilisés dans SignalExpress.

http://www.ni.com/signalexpress
http://www.ni.com/signalexpress
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A
Support technique et services

Ouvrez une session avec votre profil ni.com National Instruments pour un 
accès personnalisé à vos services. Visitez les sections suivantes de ni.com 
pour vous procurer une assistance technique et des services professionnels :

• Support—Le support technique sur ni.com/support comprend les 
ressources suivantes :

– Ressources d’auto-assistance technique—Visitez 
ni.com/support pour vous procurer des drivers et des mises à 
jour de logiciels, faire des recherches dans la Base de 
connaissances, accéder aux manuels sur les produits et aux 
assistants de dépannage pas à pas, ou obtenir des milliers 
d’exemples de programmes, des tutoriels, des notes d’application, 
des drivers d’instruments et bien plus encore. Les utilisateurs 
enregistrés bénéficient également de l’accès aux Forums de 
discussion NI, sur ni.com/forums. Pour accéder au forum 
français, cliquez sur le menu déroulant “Select Community” et 
sélectionnez “Français”. Les ingénieurs d’applications de NI se 
font fort de répondre à toutes les questions qui leur sont adressées.

– Abonnement SSP (Standard Service Program)—Ce 
programme confère à ses membres un accès direct par téléphone 
et e-mail aux ingénieurs d’application de NI et leur permet 
d’obtenir un support technique individuel, ainsi qu’un accès 
privilégié aux modules d’auto-formation en ligne sur ni.com/
self-paced-training. Tous les clients reçoivent 
automatiquement un abonnement gratuit d’un an au programme 
SSP (Standard Service Program) à l’achat de la plupart des 
produits et ensembles logiciels, y compris NI Developer Suite.

Pour obtenir des informations sur d’autres options de support 
technique dans votre région, visitez ni.com/services ou 
contactez votre filiale locale en utilisant les coordonnées qui se 
trouvent sur ni.com/contact. 

• Formations et certifications—Visitez ni.com/training pour 
obtenir des informations sur les programmes de formation et de 
certification de National Instruments. Vous pouvez également vous 
inscrire à des cours de formation dispensés par des instructeurs un peu 
partout dans le monde.

http://www.ni.com
http://www.ni.com
http://www.ni.com/cgi-bin/redirect.cgi?dest=infcoprod&src=lvhelp&openagent&code=rdbp04
http://www.ni.com/cgi-bin/redirect.cgi?dest=infcoprod&src=lvhelp&openagent&code=rdbp04
http://www.ni.com/forums
http://www.ni.com/self-paced-training
http://www.ni.com/self-paced-training
http://www.ni.com/self-paced-training
http://www.ni.com/self-paced-training
http://www.ni.com/services
http://www.ni.com/contact
http://www.ni.com/cgi-bin/redirect.cgi?dest=infcoprod&src=lvhelp&openagent&code=rdbp08
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• Partenaires intégrateurs—Si vous devez concilier délais serrés, 
ressources techniques limitées et toute autre contrainte, nous vous 
invitons à faire appel aux intégrateurs du Programme National 
Instruments Alliance Partner. Pour en savoir plus, appelez votre filiale 
locale ou visitez le site ni.com/alliance.

Vous pouvez également visiter la page des filiales internationales sur 
ni.com/niglobal afin d’accéder au site Web de votre filiale. Vous y 
trouverez les informations les plus à jour pour contacter le support 
technique par téléphone ou e-mail, ainsi que le calendrier des événements.

http://www.ni.com/alliance
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Deutschsprachige Niederlassungen
National Instruments National Instruments National Instruments
Germany GmbH Ges.m.b.H. Switzerland
Ganghoferstr. 70 b Plainbachstraße 12 Sonnenbergstrasse 53
80339 München 5101 Salzburg-Bergheim CH-5408 Ennetbaden
Tel.: +49 89 7413130 Tel.: +43 662 457990-0 Tel.: +41 56 2005151, +41 21 3205151 (Lausanne)
Fax: +49 89 7146035 Fax: +43 662 457990-19 Fax: +41 56 2005155

Lokaler technischer Support
Deutschland: ni.germany@ni.com www.ni.com/germany
Österreich: ni.austria@ni.com www.ni.com/austria
Schweiz: ni.switzerland@ni.com www.ni.com/switzerland

Technischer Support und Produktinformation weltweit
ni.com

Internationale Niederlassungen
Die aktuelle Anschrift und Telefonnummer einer Niederlassung von National Instruments erhalten Sie über 
ni.com/niglobal. Auf der Website einer Niederlassung finden Sie auch Kontaktangaben für technischen 
Support und Informationen zu lokalen Veranstaltungen.

National Instruments Corporate Firmenhauptsitz
11500 North Mopac Expressway Austin, Texas 78759-3504 USA Tel: +1 512 683 0100

Weitere Informationen finden Sie im Anhang unter Technische Unterstützung und professioneller Service. Für 
Kommentare und Anregungen zu unserer Dokumentation geben Sie bitte auf unserer Website ni.com/info den 
Infocode feedback ein.

© 2004–2013 National Instruments. Alle Rechte vorbehalten.



 Wichtige Informationen

Garantie
National Instruments gewährleistet, dass die Datenträger, auf denen National Instruments Software übermittelt wird, während eines Zeitraums 
von 90 Tagen ab Lieferung, nachgewiesen durch Empfangsbestätigung oder sonstige Unterlagen, nicht aufgrund von Material- und 
Verarbeitungsfehlern Programmanweisungen nicht ausführen. Datenträger, die Programmanweisungen nicht ausführen, werden nach Wahl 
von National Instruments entweder repariert oder ersetzt, sofern National Instruments während der Garantiezeit über derartige Mängel 
informiert wird.

Damit Gegenstände zur Ausführung von Garantieleistungen angenommen werden, müssen Sie sich eine Warenrücksendenummer 
(RMA-Nummer) vom Hersteller geben lassen und diese auf der Packung deutlich sichtbar angeben. Die Kosten der Rücksendung von 
Ersatzteilen, die von der Garantie erfasst sind, an Sie übernimmt National Instruments.

National Instruments geht davon aus, dass die Informationen in diesem Dokument zutreffend sind. Das Dokument ist sorgfältig auf technische 
Richtigkeit überprüft worden. Für den Fall, dass dennoch technische oder Schreibfehler vorhanden sein sollten, behält sich National 
Instruments das Recht vor, dies in späteren Ausgaben ohne vorherige Ankündigung zu berichtigen. Bitte wenden Sie sich an National 
Instruments, falls Sie einen Fehler vermuten. National Instruments haftet in keinem Fall für Schäden, die sich aus oder im Zusammenhang mit 
diesem Dokument oder den darin enthaltenen Informationen ergeben.

SOWEIT HIER NICHT AUSDRÜCKLICH VORGESEHEN, SCHLIESST NATIONAL INSTRUMENTS JEDE GEWÄHRLEISTUNG, SEI 
SIE AUSDRÜCKLICH ODER STILLSCHWEIGEND, AUS. DIESER AUSSCHLUSS GILT INSBESONDERE FÜR EINE ETWAIGE 
KONKLUDENTE GEWÄHRLEISTUNG, DASS DIE PRODUKTE VON DURCHSCHNITTLICHER QUALITÄT UND FÜR DEN 
NORMALEN GEBRAUCH ODER FÜR EINEN BESTIMMTEN ZWECK GEEIGNET SIND. EINE SCHADENERSATZPFLICHT FÜR 
SCHULDHAFTES VERHALTEN SEITENS NATIONAL INSTRUMENTS IST AUF DEN VOM KUNDEN GEZAHLTEN KAUFPREIS 
BEGRENZT. NATIONAL INSTRUMENTS HAFTET NICHT FÜR SCHÄDEN, DIE SICH AUS DEM VERLUST VON DATEN, 
ENTGANGENEM GEWINN ODER NUTZUNGSMÖGLICHKEITEN ERGEBEN UND AUCH NICHT FÜR ZUFÄLLIGE ODER 
FOLGESCHÄDEN, SELBST WENN NATIONAL INSTRUMENTS AUF DIE MÖGLICHKEIT SOLCHER SCHÄDEN HINGEWIESEN 
WURDE. Diese Haftungsbegrenzung gilt unabhängig vom Rechtsgrund der Haftung. Ansprüche gegenüber National Instruments müssen 
innerhalb eines Jahres nach Schadenseintritt gerichtlich geltend gemacht werden. Die Firma National Instruments haftet nicht für 
Verspätungsschäden, die nicht in ihrem Verantwortungsbereich liegen. Diese Garantie erstreckt sich nicht auf Schäden, Fehler, Fehlfunktionen 
oder Servicemängel, die auf der Nichtbefolgung von Anweisungen von National Instruments für die Installation, den Betrieb oder die Wartung, 
auf Veränderungen des Produktes, Missbrauch oder Fehlgebrauch des Produktes, auf einer Unterbrechung der Energieversorgung, Feuer, 
Wasserschäden, Unfälle, Handlungen Dritter oder anderen Geschehnissen, die nicht im Verantwortungsbereich von National Instruments 
liegen, beruhen.

Urheberrechte
Gemäß den Bestimmungen des Urheberrechts darf diese Publikation ohne vorherige schriftliche Zustimmung der Firma National Instruments 
Corporation weder vollständig noch teilweise vervielfältigt oder verbreitet werden, gleich in welcher Form, ob elektronisch oder mechanisch. 
Das Verbot erfasst u. a. das Fotokopieren, das Aufzeichnen, das Speichern von Informationen in Retrieval Systemen sowie das Anfertigen von 
Übersetzungen gleich welcher Art.

National Instruments achtet das geistige Eigentum anderer und fordert seine Nutzer auf, dies ebenso zu tun. Die Software von National 
Instruments ist urheberrechtlich und durch andere Rechtsvorschriften zum Schutz geistigen Eigentums geschützt. Wenn Sie NI Software 
nutzen, um Software oder andere Materialien, die im Eigentum Dritter stehen, zu vervielfältigen, dürfen Sie NI Software nur insoweit nutzen, 
als Sie die betreffenden Materialien nach den jeweils anwendbaren Lizenzbestimmungen oder Rechtsvorschriften vervielfältigen dürfen.

Lizenzverträge von National Instruments und Rechtshinweise von Drittanbietern
Lizenzverträge (EULAs) von National Instruments und Rechtshinweise von Drittanbietern befinden sich in folgenden Verzeichnissen:

• Rechtshinweise: <National Instruments>\_Legal Information und <National Instruments>

• EULAs: <National Instruments>\Shared\MDF\Legal\license

• Informationen zum Hinzufügen von Rechtshinweisen zu Installationsprogrammen, die mithilfe von NI-Produkten erzeugt werden: 
<National Instruments>\_Legal Information.txt

Marken
Weitere Informationen zu Marken von National Instruments finden Sie in den NI Trademarks and Logo Guidelines auf ni.com/trademarks.

ARM, Keil, and µVision are trademarks or registered of ARM Ltd or its subsidiaries.

LEGO, the LEGO logo, WEDO, and MINDSTORMS are trademarks of the LEGO Group. ©2013 The LEGO Group.

TETRIX by Pitsco is a trademark of Pitsco, Inc.©2013

FIELDBUS FOUNDATION™ and FOUNDATION™ are trademarks of the Fieldbus Foundation.

EtherCAT® is a registered trademark of and licensed by Beckhoff Automation GmbH.

CANopen® is a registered Community Trademark of CAN in Automation e.V.

DeviceNet™ and EtherNet/IP™ are trademarks of ODVA.

Go!, SensorDAQ, and Vernier are registered trademarks of Vernier Software & Technology. Vernier Software & Technology and vernier.com 
are trademarks or trade dress.

Xilinx is the registered trademark of Xilinx, Inc.

Taptite and Trilobular are registered trademarks of Research Engineering & Manufacturing Inc.

FireWire® is the registered trademark of Apple Inc.

Linux® is the registered trademark of Linus Torvalds in the U.S. and other countries.



Handle Graphics®, MATLAB®, Real-Time Workshop®, Simulink®, Stateflow®, and xPC TargetBox® are registered trademarks, and TargetBox™ 
and Target Language Compiler™ are trademarks of The MathWorks, Inc.

Tektronix®, Tek, and Tektronix, Enabling Technology are registered trademarks of Tektronix, Inc.

The Bluetooth® word mark is a registered trademark owned by the Bluetooth SIG, Inc.

The ExpressCard™ word mark and logos are owned by PCMCIA and any use of such marks by National Instruments is under license.

The mark LabWindows is used under a license from Microsoft Corporation. Windows is a registered trademark of Microsoft Corporation in the 
United States and other countries.

Sonstige hierin erwähnte Produkt- und Firmenbezeichnungen sind Marken oder Handelsnamen der jeweiligen Unternehmen.

Mitglieder des National Instruments Alliance Partner Programms sind eigenständige und von National Instruments unabhängige Unternehmen; 
zwischen ihnen und National Instruments besteht keine gesellschaftsrechtliche Verbindung und auch kein Auftragsverhältnis.

Patente
Nähere Informationen über den Patentschutz von Produkten oder Technologien von National Instruments finden Sie unter Hilfe»Patente 
in Ihrer Software, in der Datei patents.txt auf Ihrem Datenträger oder in den Patentinformationen von National Instruments auf 
ni.com/patents.

Einhaltung der Ausfuhrbestimmungen
Informationen zu den von National Instruments eingehaltenen internationalen Handelsbestimmungen sowie zu Bezugsquellen für relevante 
HTS-Codes, ECCNs und andere Import-/Export-Kenndaten finden Sie auf ni.com/legal/export-compliance unter der Überschrift 
Export Compliance Information.

WARNUNG ZUR NUTZUNG VON NATIONAL INSTRUMENTS PRODUKTEN
(1) DIE SOFTWAREPRODUKTE VON NATIONAL INSTRUMENTS WURDEN NICHT MIT KOMPONENTEN UND TESTS FÜR EIN 
SICHERHEITSNIVEAU ENTWICKELT, DAS FÜR EINE VERWENDUNG BEI ODER IN ZUSAMMENHANG MIT CHIRURGISCHEN 
IMPLANTATEN ODER ALS KRITISCHE KOMPONENTEN VON LEBENSERHALTENDEN SYSTEMEN GEEIGNET IST, DEREN 
FEHLFUNKTION BEI VERNÜNFTIGER BETRACHTUNGSWEISE ZU ERHEBLICHEN VERLETZUNGEN VON MENSCHEN 
FÜHREN KANN. 

(2) BEI JEDER ANWENDUNG, EINSCHLIESSLICH DER OBEN GENANNTEN, KANN DIE ZUVERLÄSSIGKEIT DER 
FUNKTION DER SOFTWAREPRODUKTE DURCH ENTGEGENWIRKENDE FAKTOREN, EINSCHLIESSLICH Z. B. 
SPANNUNGSUNTERSCHIEDEN BEI DER STROMVERSORGUNG, FEHLFUNKTIONEN DER COMPUTER-HARDWARE, 
FEHLENDER EIGNUNG DER SOFTWARE FÜR DAS COMPUTER-BETRIEBSSYSTEM, FEHLENDER EIGNUNG VON 
ÜBERSETZUNGS- UND ENTWICKLUNGSSOFTWARE, DIE ZUR ENTWICKLUNG EINER ANWENDUNG EINGESETZT WERDEN, 
INSTALLATIONSFEHLERN, PROBLEMEN BEI DER SOFTWARE- UND HARDWAREKOMPATIBILITÄT, 
FUNKTIONSSTÖRUNGEN ODER AUSFALL DER ELEKTRONISCHEN ÜBERWACHUNGS- ODER KONTROLLGERÄTE, 
VORÜBERGEHENDEN FEHLERN DER ELEKTRONISCHEN SYSTEME (HARDWARE UND/ODER SOFTWARE), 
UNVORHERGESEHENEN EINSATZES ODER MISSBRAUCHS ODER FEHLERN DES ANWENDERS ODER DES 
ANWENDUNGSENTWICKLERS (ENTGEGENWIRKENDE FAKTOREN WIE DIESE WERDEN NACHSTEHEND 
ZUSAMMENFASSEND “SYSTEMFEHLER” GENANNT) BEEINTRÄCHTIGT WERDEN. JEDE ANWENDUNG, BEI DER EIN 
SYSTEMFEHLER EIN RISIKO FÜR SACHWERTE ODER PERSONEN DARSTELLT (EINSCHLIESSLICH DER GEFAHR 
KÖRPERLICHER SCHÄDEN UND TOD), SOLLTE AUFGRUND DER GEFAHR VON SYSTEMFEHLERN NICHT LEDIGLICH AUF 
EINE FORM VON ELEKTRONISCHEM SYSTEM GESTÜTZT WERDEN. UM SCHÄDEN UND, U. U. TÖDLICHE, VERLETZUNGEN 
ZU VERMEIDEN, SOLLTE DER NUTZER ODER ANWENDUNGSENTWICKLER ANGEMESSENE SICHERHEITSMASSNAHMEN 
ERGREIFEN, UM SYSTEMFEHLERN VORZUBEUGEN. HIERZU GEHÖREN UNTER ANDEREM SICHERUNGS- ODER 
ABSCHALTMECHANISMEN. DA JEDES ENDNUTZERSYSTEM DEN KUNDENBEDÜRFNISSEN ANGEPASST IST UND SICH VON 
DEM TESTUMFELD UNTERSCHEIDET, UND DA EIN NUTZER ODER ANWENDUNGSENTWICKLER SOFTWAREPRODUKTE 
VON NATIONAL INSTRUMENTS IN VERBINDUNG MIT ANDEREN PRODUKTEN IN EINER VON NATIONAL INSTRUMENTS 
NICHT GETESTETEN ODER VORHERGESEHENEN FORM EINSETZEN KANN, TRÄGT DER NUTZER BZW. DER 
ANWENDUNGSENTWICKLER DIE LETZTENDLICHE VERANTWORTUNG FÜR DIE ÜBERPRÜFUNG UND AUSWERTUNG DER 
EIGNUNG VON NATIONAL INSTRUMENTS PRODUKTEN, WENN PRODUKTE VON NATIONAL INSTRUMENTS IN EIN SYSTEM 
ODER EINE ANWENDUNG INTEGRIERT WERDEN. DIES ERFORDERT U. A. DIE ENTSPRECHENDE ENTWICKLUNG UND 
VERWENDUNG SOWIE EINHALTUNG EINER ENTSPRECHENDEN SICHERHEITSSTUFE BEI EINEM SOLCHEN SYSTEM ODER 
EINER SOLCHEN ANWENDUNG.
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Zu diesem Handbuch

In diesem Handbuch erhalten Sie eine Einführung in die interaktive 
Messung mit SignalExpress und die Grundfunktionen des Programms zum 
Erfassen und Analysieren von Signalen.

Die im Buch enthaltenen Übungen sollen Ihnen den Einstieg in 
SignalExpress erleichtern. Sie lernen damit die Konfiguration von Schrit-
ten, das Ausführen von Projekten, die Arbeit mit Signalen, das wiederholte 
Messen mit variablen Parametern, das Protokollieren von Daten sowie die 
Erweiterung von SignalExpress durch die grafische Programmierumge-
bung LabVIEW.

Symbole und Darstellungen
In diesem Handbuch werden die folgenden Symbole und Darstellungen 
verwendet:

» Das Symbol » kennzeichnet die Reihenfolge, in der Menüpunkte und Dia-
logfeldoptionen anzuklicken sind. So wird zum Beispiel mit der Abfolge 
Optionen»Einstellungen»Allgemein angezeigt, dass zunächst das Menü 
Optionen zu öffnen ist, daraus der Menüpunkt Einstellungen auszuwäh-
len und anschließend die Seite Allgemein anzuklicken ist.

Dieses Symbol steht für einen Tipp.

Dieses Zeichen steht für einen Hinweis auf wichtige Informationen.

fett In fettgedruckter Schrift sind Elemente dargestellt, die ausgewählt oder 
angeklickt werden müssen, wie Menüpunkte oder Optionen in Dialog-
feldern. Bei fettgedrucktem Text kann es sich auch um die Namen von Ein- 
und Ausgängen, Parametern, Anzeigen, Dialogfeldern, Bereichen in Dia-
logfeldern oder Menüs handeln.

kursiv Variablen, Hervorhebungen, Querverweise und erstmals genannte Fachaus-
drücke sind durch Kursivschrift gekennzeichnet. Ebenfalls kursiv sind 
Textstellen gedruckt, an denen Wörter oder Werte einzusetzen sind.

monospace In Monospace-Schrift (nicht proportionaler Schrift) ist Text dargestellt, der 
über die Tastatur einzugeben ist. Diese Darstellungsweise wird ebenfalls 
für Laufwerke, Pfade, Verzeichnisse, Programme, Unterprogramme, Sub-
routinen, Gerätenamen, Funktionen, Operationen, Variablen sowie 
Dateinamen und -erweiterungen verwendet.
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Literaturhinweise
Wenn Sie beim Lesen dieses Dokuments weitere Fragen haben, werden 
diese möglicherweise in der Hilfe zu SignalExpress unter Hilfe»Hilfe zu 
SignalExpress beantwortet.
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Mit den innovativen Produkten von National Instruments haben Wissen-
schaftler und Ingenieure die Möglichkeit, mit der Industrienorm entspre-
chenden Computern und Plattformen automatisierte Messsysteme zu 
erstellen. Dazu bietet National Instruments technologisch führende Pro-
grammierumgebungen wie die grafische Entwicklungsumgebung 
LabVIEW, die ANSI-C-Programmierumgebung LabWindows™/CVI™ 
oder Measurement Studio zur Programmierung in Microsoft Visual Studio 
an. Diese Programmierumgebungen arbeiten sowohl mit herkömmlichen 
Messgeräten als auch mit virtuellen Messgeräten, die mittels der Mess-
karten von National Instruments auf dem Computer emuliert werden, so 
dass Sie reale und virtuelle Messgeräte zu technisch anspruchsvollen Sys-
temen kombinieren können.

Mit SignalExpress können Sie interaktiv virtuelle Messsysteme erstellen 
und ohne Programmierung sofort mit dem Messen beginnen. Signale 
werden interaktiv erfasst, erzeugt, analysiert, verglichen, importiert und 
gespeichert. So können Sie zum Beispiel vorgegebene Werte in einem 
Schritt mit Messwerten vergleichen. Damit werden die Einfachheit und die 
Möglichkeiten virtueller Messsysteme auch solchen Nutzern zugänglich 
gemacht, die Signale ohne Programmierung von Anwendungen messen 
und analysieren möchten. Die Funktionen von SignalExpress können auch 
ausgebaut werden, indem der Benutzer ein eigenes VI (virtuelles 
Instrument) aus der LabVIEW-Entwicklungsumgebung importiert oder 
SignalExpress-Projekte in LabVIEW-Blockdiagramme umwandelt, so 
dass die Arbeit an einem Projekt in LabVIEW fortgesetzt werden kann. 
Weitere Informationen zu fortgeschrittenen Funktionen in SignalExpress 
finden Sie in Kapitel 6, Erweitern von SignalExpress-Projekten durch 
LabVIEW.

Dieses Kapitel enthält Angaben zu den Versionen von SignalExpress und 
den Lizenzoptionen für das Programm.
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Verfügbare Versionen von SignalExpress
SignalExpress ist als Full Edition und als Limited Edition (LE) erhältlich. 
In der folgenden Tabelle sehen Sie die Programmfunktionen der beiden 
Versionen im Vergleich. 

Tabelle 1-1.  Unterschiede zwischen der SignalExpress Limited Edition (LE) und der Full Edition

LE Full

Geräteunterstützung

Über 300 gängige Messgeräte Von NI-Gerätetreibern 
installierte Schritte zum 
Erfassen und Erzeugen von 
Signalen

IVI-DMM - Erfassung

IVI FGEN - Beliebiger 
Signalverlauf

IVI FGEN - Standardfunktion

IVI - Spannungsversorgung

IVI-Oszilloskop - Erfassung

Von NI-Gerätetreibern 
installierte Schritte zum 
Erfassen und Erzeugen von 
Signalen

IVI-DMM - Erfassung

IVI FGEN - Beliebiger 
Signalverlauf

IVI FGEN - Standardfunktion

IVI - Spannungsversorgung

IVI-Oszilloskop - Erfassung

Visualisierung und Dokumentation

Benutzerdefinierte grafische Darstellung Datenansicht Datenansicht

Interaktive Cursor Cursor Cursor

Verschieben von Daten per Drag and Drop in 
Microsoft Excel, Word und WordPad

Verschieben Verschieben

Drucken und Exportieren von Graphen — Registerkarte 
“Projektdokumentation”

Bedienmodus mit eingeschränkter 
Benutzerbearbeitung

— Bedienmodus

Signalerstellung

Erstellung von Analogsignalen Analoges Signal erstellen Analoges Signal erstellen

Erstellung von Digitalsignalen Digitales Signal erstellen Digitales Signal erstellen

Signalverarbeitung

Softwarefilter — Filter
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Signalverarbeitung (Fortsetzung)

Berechnungen an Skalaren und Signalverläufen — Arithmetik

Formel

Skalierung und Umrechnung

Zeitliche Mittelung

Fenster

Analoge und digitale Umrechnung — A/D-Wandlung

D/A-Wandlung

Interaktive Signalvergleiche — Interaktive Ausrichtung

Laden von Simulationsdaten von PSPICE, 
Multisim und anderen SPICE-Programmen

— Aus SPICE-Datei laden

Zeit- und Frequenzmessungen

Amplitude und Pegel — Amplitude und Pegel

Timing und Übergang — Timing und Übergang

Leistungsspektrum — Leistungsspektrum

Frequenzgang — Frequenzgang

Verzerrungsmessungen — Verzerrung

Grundfrequenz ermitteln — Grundfrequenz ermitteln

Datenprotokollierung

Speichern von Signalen in Dateien Von NI-Gerätetreibern 
installierte Schritte zum Laden 
und Speichern von Signalen

Exportieren in Text- und 
Microsoft-Excel-Dateien

Von NI-Gerätetreibern 
installierte Schritte zum Laden 
und Speichern von Signalen

Exportieren in Text- und 
Microsoft-Excel-Dateien

Als ASCII/LVM speichern

Exportieren von 
TDMS-Protokolldateien in 
Microsoft Excel

Tabelle 1-1.  Unterschiede zwischen der SignalExpress Limited Edition (LE) und der Full Edition (Fortsetzung)

LE Full
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Datenprotokollierung (Fortsetzung)

Datenprotokollierung (Erstellen von 
TDMS-Dateien)

Schaltfläche “Aufnahme”*

Wiedergabe

Schaltfläche “Aufnahme”

Wiedergabe

Schaltfläche “Aufnahme 
während Ausführung”

Registerkarte 
“Aufnahmeoptionen”

Unbegrenzte Anzahl von 
Protokollen pro Projekt

Alarm- und Ereignisprotokollierung — Alarme

Ereignisse

Datenprotokollierung mit Start- und 
Stoppbedingungen

— Startbedingungen

Stoppbedingungen

Automatische Messungen

Sweep-Messungen — Sweep

Grenzwerttest — Grenzwerttest

Software-Triggerung — Trigger

Ablaufsteuerung — Sequenz

Zugriff auf Netzwerkdaten

Datenaustausch mit Umgebungsvariablen — Umgebungsvariablen abfragen

In Umgebungsvariablen 
schreiben

Interaktion mit LabVIEW

Erzeugung von LabVIEW-Programmcode Erzeugen eines LabVIEW-VIs 
aus einem Projekt

Erzeugen eines LabVIEW-VIs 
aus einem Projekt

Tabelle 1-1.  Unterschiede zwischen der SignalExpress Limited Edition (LE) und der Full Edition (Fortsetzung)

LE Full
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Optionen zur Lizenzierung von SignalExpress
In diesem Abschnitt werden die Lizenzbestimmungen für SignalExpress 
zusammenfassend besprochen. Eine detailliertere Übersicht über die 
Lizenzbedingungen finden Sie in der Softwarelizenzvereinbarung von 
National Instruments.

Interaktion mit LabVIEW (Fortsetzung)

LabVIEW-Express-VIs Von NI-Gerätetreibern 
installierte Express-VIs zum 
Erfassen und Erzeugen von 
Signalen

Express-VIs des Typs “Signale 
erstellen”

IVI-DMM - Erfassung

IVI FGEN - Beliebiger 
Signalverlauf

IVI FGEN - 
Standardsignalverlauf

IVI - Spannungsversorgung

IVI-Oszilloskop - Erfassung

Von NI-Gerätetreibern 
installierte Express-VIs zum 
Erfassen und Erzeugen von 
Signalen

Express-VIs des Typs “Signale 
erstellen”

IVI-DMM - Erfassung

IVI FGEN - Beliebiger 
Signalverlauf

IVI FGEN - 
Standardsignalverlauf

IVI - Spannungsversorgung

IVI-Oszilloskop - Erfassung

Express-VIs zum 
Laden/Speichern von Signalen

Express-VIs zur Verarbeitung

Express-VIs zur Analyse

Ausführen von LabVIEW-VIs in SignalExpress — Schritte zum Ausführen von 
LabVIEW-VIs

* Aufnahme ist auf ein Protokoll pro Projekt begrenzt

Tabelle 1-1.  Unterschiede zwischen der SignalExpress Limited Edition (LE) und der Full Edition (Fortsetzung)

LE Full
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Evaluierungsmodus
Im Evaluierungsmodus von SignalExpress können Sie die Full Edition 
(Vollversion) von SignalExpress sowie die in Tabelle 1-1 aufgeführten 
Funktionen 7 Tage lang testen. Nach Ablauf dieses Zeitraums müssen Sie 
entweder Ihre kostenlose, unlizenzierte Limited Edition registrieren oder 
die Full Edition von SignalExpress aktivieren. Wenn Sie SignalExpress 
weder registrieren noch aktivieren, können Sie das Programm nach 
7 Tagen nicht mehr starten. 

Hinweis Wenn Sie SignalExpress auf einem Computer installieren, auf dem eine 
LabVIEW-Version ab 8.0 installiert ist, beginnt die Evaluierung der SignalExpress Full 
Edition beim ersten Start von LabVIEW oder SignalExpress.

SignalExpress Full Edition
Die Full Edition (Vollversion) von SignalExpress bietet uneingeschränkten 
Zugriff auf alle in der Tabelle 1-1 aufgeführten Funktionen. Das Programm 
kann mit dem Lizenzmanager von National Instruments, dem Installations-
programm von SignalExpress oder über die Website ni.com/activate 
aktiviert werden.

Auf ni.com/signalexpress können Sie die Vollversion von 
SignalExpress erwerben.

SignalExpress LE
Sie können sich jederzeit während oder nach der 7-tägigen Evaluierung für 
die kostenlose Limited Edition – SignalExpress LE – registrieren. Mit der 
registrierten Version von SignalExpress LE können Sie die lizenzpflichti-
gen Programmfunktionen nach Ablauf der Evaluierungsdauer mit fol-
genden Einschränkungen weiter verwenden:

• Bei jedem Einfügen eines lizenzpflichtigen Schritts wird ein Dialog-
feld mit einer Aufforderung zum Aktivieren der Software angezeigt. 

• Projekte können nicht gespeichert werden.

• Projekte werden nach 10 Minuten geschlossen.

http://www.ni.com/activate
http://www.ni.com/signalexpress
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Aktivieren von SignalExpress LE
Zur Aktivierung von SignalExpress LE von der SignalExpress-Umgebung 
aus gehen Sie wie folgt vor:

1. Starten Sie SignalExpress. 

2. Klicken Sie unter National Instruments - Lizenzdialogfeld auf die 
Schaltfläche Limited Edition registieren. 

3. Folgen Sie zur Aktivierung von SignalExpress LE den 
Eingabeaufforderungen. 

Hinweis SignalExpress LE kann auch im NI-Lizenzmanager aktiviert werden. Die dafür 
benötigte Seriennummer finden Sie in der Readme zu SignalExpress.
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2
Arbeit mit Projekten

Mit SignalExpress werden Messungen in Form einer Reihe von Schritten 
ausgeführt, die Sie interaktiv auswählen und konfigurieren. Ein Schritt ist 
eine Funktion mit individuellen Einstellungen, mit der Daten erfasst, analy-
siert, geladen oder gespeichert werden können. Die in SignalExpress ver-
fügbaren Schritte können über das Menü Schritt hinzufügen oder die 
gleichnamige Palette ausgewählt werden.  

Die meisten Schritte verarbeiten Eingangssignale und erzeugen Aus-
gangssignale. Durch die Angabe von Werten auf der Registerkarte 
Schritteinstellungen können Sie die einzelnen Schritte konfigurieren. 
Eine gespeicherte Schrittfolge ergibt ein Projekt.

In diesem Kapitel erfahren Sie, wie Sie ein Projekt laden, die Schritte im 
Projekt konfigurieren und das Projekt starten.

Öffnen von Projekten
Zum Laden eines Beispielprojekts in SignalExpress gehen Sie wie 
folgt vor:

1. Starten Sie SignalExpress. Klicken Sie im Fenster Erste Schritte auf 
Leeres Projekt für SignalExpress.

Beachten Sie, dass SignalExpress in Ansichten aufgeteilt ist, in denen 
unterschiedliche Arten von Angaben angezeigt werden. Die Haupt-
ansicht wird in der Mitte des Programmfensters angezeigt und enthält 
Registerkarten. Wenn SignalExpress in der Standardkonfiguration 
geöffnet wird, enthält die Hauptansicht die Registerkarten Daten-
ansicht, Aufnahmeoptionen und Projektdokumentation. 

Neben der Hauptansicht sehen Sie verschiedene Zusatzansichten. In 
der Standardkonfiguration wird die Ansicht Projekt links und die 
Kontexthilfe rechts angezeigt.

Hinweis Wenn das Programm unterstützte Hardware erkennt, wird im unteren Bereich des 
Programmfensters die Kanalansicht eingeblendet.
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2. Wenn SignalExpress nicht in der Standardkonfiguration geöffnet wird, 
wählen Sie Ansicht»Layout»Projekt auf Standard-Layout zurück-
setzen, um zur Standardkonfiguration zurückzukehren. Über das 
Menü Ansicht kann die Anzeige von Registerkarten und Ansichten 
jederzeit festgelegt werden.

3. Wählen Sie Hilfe»Beispiel öffnen, um zum Verzeichnis 
SignalExpress\Examples zu gelangen. Öffnen Sie das Verzeichnis 
Tutorial und klicken Sie das Beispielprojekt First 
Project.seproj doppelt an. 

4. Sehen Sie sich in Ruhe den Aufbau von SignalExpress an (siehe 
Abbildung 2-1). 

Abbildung 2-1.  First Project.seproj

1 Schaltfläche “Ausführen”
2 Schaltfläche “Aufnahme”
3 Hauptansicht mit angezeigter Datenansicht
4 Pulldown-Menü zur Auswahl des Arbeitsbereichs
5 Projektansicht

6 Schritt
7 Eingangssignal
8 Ausgangssignal
9 Fenster “Protokolldaten”
10 Kontexthilfe

8

6

7

4

31

55

5

10

9

2
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Ausführen eines Projekts und Anzeigen von Signalen
In SignalExpress gibt es verschiedene Ausführungsmodi. Projekte können 
entweder einmal oder kontinuierlich durchlaufen, eine bestimmte Anzahl 
von Iterationen absolvieren oder eine bestimmte Zeit lang ausgeführt wer-
den. Beim einmaligen Durchlauf führt SignalExpress alle in der Ansicht 
Projekt angezeigten Schritte einmal aus. Beim kontinuierlichen Durchlauf 
führt SignalExpress alle Schritte im Projekt fortlaufend aus. Klicken Sie 
auf den Pfeil der Schaltfläche Ausführen (vgl. Abbildung links) und wäh-
len Sie Ausführung konfigurieren, um den Ausführungsmodus für ein 
Projekt festzulegen.

Die Anzeige der Datenansicht wird während der Ausführung fortlaufend 
aktualisiert. Über die Registerkarte Schritteinstellungen können Sie die 
Einstellungen zu einer Messung während der Ausführung ändern. Die Aus-
gangswerte passen sich sofort an die neuen Eingangswerte an. Projekte mit 
fortlaufender Ausführung werden über die Schaltfläche Stopp (vgl. Abbil-
dung links) angehalten. Die Stopp-Schaltfläche erscheint anstelle der 
Ausführen-Schaltfläche, wenn das Projekt läuft. 

Zum Starten des Beispielprojekts in SignalExpress und zum Anzeigen von 
Signalen gehen Sie wie folgt vor:

1. Klicken Sie auf die Schaltfläche Ausführen. Wenn das Dialogfeld 
Angaben zur Ausführung angezeigt wird, klicken Sie auf Ausfüh-
ren, damit alle Schritte im Projekt kontinuierlich durchlaufen werden.

Daraufhin wird ein Signal aus einer Textdatei geladen und das Signal 
wird einer Amplituden- und Pegelmessung sowie einer Verzerrungs-
messung unterzogen. Dazu durchläuft das Signal die Schritte “Ampli-
tude und Pegel” und “Verzerrung”. Bei der Ausführung eines Projekts 
analysieren die Schritte die Eingangssignale und erzeugen als Ergeb-
nis der Analyse neue Ausgangssignale. In diesem Projekt wird mit 
dem Schritt “Aus ASCII-Datei laden” eine verzerrte Sinuskurve gela-
den, die dann mit den Schritten “Amplitude und Pegel” und 
“Verzerrung” ausgewertet wird. Beide Schritte erzeugen eine neue 
Kurve. Die Eingangsgrößen werden in der Ansicht Projekt von 
SignalExpress durch rote Pfeile und die Ausgangsgrößen durch blaue 
Pfeile gekennzeichnet.

Im Graphen in der Datenansicht wird immer noch das geladene Zeit-
bereichssignal angezeigt. Graphen können Zeitbereichs-, Frequenz-
bereichs- und XY-Signale darstellen. 



Kapitel 2 Arbeit mit Projekten

Erste Schritte mit SignalExpress 2-4 ni.com

2. Ziehen Sie das Ausgangssignal Exportiertes Spektrum des Schritts 
“Verzerrung” von der Projekt-Ansicht in die Datenansicht (vgl. 
Abbildung links). 

SignalExpress erzeugt daraufhin in der Datenansicht einen neuen 
Graphen. Das Signal Exportiertes Spektrum wird nicht im selben 
Graphen wie das Zeitbereichssignal angezeigt, da es sich bei 
Exportiertes Spektrum um ein Frequenzbereichssignal handelt. 
Signaltypen werden in SignalExpress automatisch erkannt und ent-
sprechend angezeigt.

Tipp Weitere Informationen zu Signaltypen finden Sie in der Hilfe zu SignalExpress, 
indem Sie Hilfe»Hilfe zu SignalExpress auswählen, auf die Registerkarte Suchen klicken 
und das Stichwort Signaltypen eingeben. In der Hilfe erfahren Sie mehr zu den einzel-
nen Komponenten von SignalExpress, wie Projekten, Schritten oder Signalen.

3. Ziehen Sie den Ausgang DC des Schritts “Amplitude und Pegel” in die 
Datenansicht. 

SignalExpress erzeugt daraufhin zur Darstellung der Messergebnisse 
des Ausgangs DC eine Diagrammanzeige mit einer Legende. Die 
Tabelle Legende enthält den Wert jeder Ausgangsgröße und die Farbe, 
in der die Ausgangsgröße im Graphen dargestellt wird.

4. Ziehen Sie den Ausgang RMS des Schritts “Amplitude und Pegel” in 
das Diagramm, so dass die Werte der RMS-Messung angezeigt 
werden.

SignalExpress fügt der Tabelle daraufhin eine Zeile für das zweite 
Messergebnis hinzu. Das Projekt sollte wie in Abbildung 2-2 
aussehen.
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Abbildung 2-2.  Ausgangsgrößen von First Project.seproj

Konfigurieren von Schritten
Ein Schritt ist eine konfigurierbare Funktion, mit der Daten erfasst, analy-
siert, geladen oder gespeichert werden können. Jeder Schritt verarbeitet 
Signale und gibt Signale aus. Durch die Angabe von Werten auf der Regis-
terkarte Schritteinstellungen in SignalExpress können Sie die einzelnen 
Schritte konfigurieren. Sie können auch bei laufenden Projekten Ände-
rungen an den Einstellungen vornehmen, so dass Sie Ihre Messungen 
genau anpassen können, bis die gewünschten Ergebnisse in der Datenan-
sicht dargestellt werden.
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Zur Konfiguration der Schritte “Verzerrung” sowie “Amplitude und Pegel” 
gehen Sie wie folgt vor:

1. Klicken Sie den Schritt “Verzerrung” in der Ansicht Projekt doppelt 
an. Daraufhin wird die Registerkarte Schritteinstellungen des Schritts 
“Verzerrung” wie in Abbildung 2-3 angezeigt.

Abbildung 2-3.  Registerkarte “Schritteinstellungen” des Schritts “Verzerrung”

Auf der Seite Konfiguration der Registerkarte Schritteinstellungen 
zeigt das Feld Signale exportieren (Klirrfaktor) an, dass mit dem 
Schritt “Verzerrung” das Eingangssignal ausgegeben wird. Der Graph 
Exportiertes Signal zeigt eine Vorschau des Signals an. Ausgege-
benes Leistungsspektrum weist darauf hin, dass der Schritt ein 
Leistungsspektrum des Signals erstellt, um es in ein Frequenzspektrum 
umzuwandeln. Der Bereich Messergebnisse zeigt die Grundfrequenz 
und den Klirrfaktor des Signals an. Der Schritt gibt das Signal und drei 
Messergebnisse aus: das Spektrum, den Klirrfaktor und die Grund-
frequenz des Signals.
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2. Wenn die Kontexthilfe nicht auf der rechten Bildschirmhälfte ange-
zeigt wird, klicken Sie auf Hilfe»Kontexthilfe. Daraufhin sollten alle 
in der Hilfe enthaltenen Informationen zu einem Schritt angezeigt 
werden. 

In der oberen Hälfte der Kontexthilfe werden Informationen zum 
Schritt selbst angezeigt und in der unteren Hälfte sehen Sie Angaben 
zu einem bestimmten Parameter des Schritts, wenn Sie den Cursor dar-
über positionieren. Führen Sie den Cursor z. B. über Klirrfaktor (%), 
um Informationen dazu zu erhalten.

3. Wählen Sie auf der Registerkarte Konfiguration aus dem Pull-
down-Menü Signale exportieren (Klirrfaktor) die Option 
Grundschwingung aus.

Der Graph Ausgegebenes Leistungsspektrum zeigt nun nicht mehr 
das Frequenzbereichsspektrum des gesamten Signals, sondern nur 
noch der Grundschwingung an. Das vom Schritt “Verzerrung” ausge-
gebene Signal und der Graph Exportiertes Spektrum in der 
Datenansicht werden entsprechend angepasst.

4. Wählen Sie aus dem Pulldown-Menü Signale exportieren (Klirrfak-
tor) die Option Nur Harmonische aus.

Der Graph Ausgegebenes Leistungsspektrum auf der Registerkarte 
Schritteinstellungen und der Graph der Ausgabe auf der Register-
karte Datenansicht zeigen nun das Spektrum der Harmonischen des 
Eingangssignals an.

5. Klicken Sie in der Ansicht Projekt den Schritt “Amplitude und 
Pegel” an. 

Das Dialogfeld Schritteinstellungen zeigt nun die Einstellungen zum 
Schritt “Amplituden und Pegel” an.
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6. Wählen Sie die Registerkarte Eingabe/Ausgabe, so dass eine Liste der 
möglichen Ein- und Ausgangssignale für diesen Schritt angezeigt wird 
(vgl. Abbildung 2-4).

Abbildung 2-4.  Registerkarte “Schritteinstellungen” des Schritts 
“Amplituden und Pegel”

7. Aktivieren Sie die Optionen Positiven Spitzenwert ausgeben, Nega-
tiven Spitzenwert ausgeben und Spitze-Spitze-Wert ausgeben, so 
dass diese drei Werte ermittelt werden.

In der Ansicht Projekt werden nun drei zusätzliche Ausgänge 
angezeigt.

8. Wechseln Sie zur Datenansicht.

9. Ziehen Sie die drei neuen Ausgänge von der Ansicht Projekt in die 
Diagrammanzeige für skalare Messwerte. Die neuen Ausgänge 
werden daraufhin im Graphen und in der Legende angezeigt.
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Hinweis Wenn das Projekt bereits für längere Zeit läuft, sollten Sie es eventuell anhalten 
und neu starten, so dass alle skalaren Signale im Graphen angezeigt werden. Signale im 
Graphen werden kumulativ aufgebaut. Neu hinzugefügte Signale enthalten daher entspre-
chend weniger Werte. 

10. Klicken Sie zum Anhalten des Projekts auf die Schaltfläche Stopp.

Beim Anklicken der Stopp-Schaltfläche beendet das Projekt den aktu-
ellen Durchlauf und hält dann an. Wenn Sie auf den Pfeil der 
Stopp-Schaltfläche klicken und Abbrechen wählen, wird das Projekt 
mit sofortiger Wirkung gestoppt, ohne die ausstehenden Arbeits-
schritte abzuwarten.

11. Klicken Sie auf Datei»Projekt speichern unter und speichern Sie das 
Projekt unter dem Namen My First Project.seproj im Verzeich-
nis C:\Programme\National Instruments\SignalExpress\
Examples\Tutorial.

12. Schließen Sie das Projekt über Datei»Projekt schließen.

Sortieren, Verschieben und Löschen von Schritten
Für die meisten Schritte in SignalExpress werden Eingangswerte benötigt. 
Schritte können nur mit Signalen arbeiten, die von vorigen Schritten in der 
Projekt-Ansicht ausgegeben wurden. Daher kann die Reihenfolge der 
Schritte in dieser Ansicht die Funktionsfähigkeit von Projekten 
beeinflussen. 

Für Schritte mit einer Seite Eingabe oder Eingabe/Ausgabe auf der Regis-
terkarte Schritteinstellungen werden im Menü Eingangssignal nur vom 
vorigen Schritt exportierte Signale angezeigt, die kompatibel sind. Sobald 
das Ausgabesignal eines Schritts am Eingang des nächsten anliegt, werden 
die Schritte voneinander abhängig und nacheinander mit der gleichen Rate 
ausgeführt. Der zweite Schritt kann erst beginnen, wenn durch den ersten 
Schritt ein Signal erzeugt wurde.

Sie können die Schritte in der Ansicht Projekt nach oben oder unten zie-
hen. Zum Löschen eines Schritts klicken Sie den Schritt in der Ansicht 
Projekt mit der rechten Maustaste an und wählen Sie aus dem Kontext-
menü die Option Löschen aus. Allerdings ändert sich beim Verschieben 
oder Löschen eines Schritts der Status des Signals. Beim Löschen eines 
Schritts, auf dessen Ausgangssignal ein anderer Schritt angewiesen ist, 
funktioniert das Projekt nicht mehr und in der Ansicht Projekt wird eine 
entsprechende Fehlermeldung angezeigt. Sie können Schritte innerhalb 
eines Projekts auch ausschneiden, kopieren oder einfügen, indem Sie die 
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Tastenkombinationen <Strg + X>, <Strg + C> oder <Strg + V> drücken 
oder einen Schritt in der Ansicht Projekt anklicken und die Option Aus-
schneiden, Kopieren, Vor markiertem Schritt einfügen oder Nach 
markiertem Schritt einfügen auswählen.

Umgang mit Fehlern und Warnungen
Bei einem Fehler während der Projektausführung wird durch eine Fehler-
anzeige (vgl. Abbildung links) in der Projekt-Ansicht auf den Schritt 
hingewiesen, bei dem der Fehler aufgetreten ist. Wenn Sie den fehlerhaften 
Schritt doppelt anklicken, erscheint am unteren Rand der Registerkarte 
Schritteinstellungen eine Kurzbeschreibung des Fehlers. Die vollständige 
Beschreibung wird beim Anklicken der Schaltfläche Details neben der 
Fehlermeldung angezeigt.

SignalExpress protokolliert alle Fehler und Warnungen während der Aus-
führung eines Projekts auf der Registerkarte Ereignisprotokoll. Wählen 
Sie zur Anzeige der Registerkarte Ereignisprotokoll die Option 
Ansicht»Ereignisprotokoll. Weitere Informationen zu Fehlern und War-
nungen erhalten Sie in der Hilfe zu SignalExpress, indem Sie Hilfe»Hilfe 
zu SignalExpress auswählen und auf der Registerkarte Suchen das Stich-
wort Fehler eingeben.
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Arbeit mit Signalen

In SignalExpress können Signale ohne Programmierung generiert und ana-
lysiert werden. In diesem Kapitel erfahren Sie, wie in SignalExpress mit 
Signalen gearbeitet wird. Sie lernen, wie Signale grafisch dargestellt, aus 
Dateien importiert, interaktiv ausgerichtet, verglichen und in Dateien 
gespeichert werden.

Grafisches Darstellen von Signalen
Gehen Sie zum Darstellen der Signale in einem Beispielprojekt und zum 
visuellen Untersuchen der Signale anhand von Cursorn wie folgt vor:

1. Wählen Sie Hilfe»Beispiel öffnen, um zum Verzeichnis 
SignalExpress\Examples zu gelangen. Öffnen Sie das Verzeichnis 
Tutorial und klicken Sie doppelt auf Signals.seproj. In diesem 
Projekt wird der Schritt “Analoges Signal erstellen” so konfiguriert, 
dass er ein Rechtecksignal ausgibt, und der Schritt “Filter” wird auf 
einen Butterworth-Tiefpass eingestellt.

2. Ziehen Sie den Ausgang step signal des Schritts “Analoges Signal 
erstellen” in die Datenansicht.

3. Ziehen Sie den Ausgang filtered step des Schritts “Filter” in die 
Datenansicht.

Da die Signale step signal und filtered step Zeitbereichssignale sind, 
werden sie im selben Graphen angezeigt. Wenn Sie zwei Signale 
unterschiedlichen Typs in denselben Graphen ziehen, wird automa-
tisch eine neue Anzeige hinzugefügt.

4. Klicken Sie auf die Schaltfläche Neue Anzeige (vgl. Abbildung links), 
damit eine neue Anzeige erzeugt wird.

Hinweis Anzeigen können durch Anklicken des X-Symbols in der rechten oberen Ecke 
entfernt werden.

5. Ziehen Sie den Ausgang filtered step des Schritts “Filter” in die neue 
Anzeige.
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6. Klicken Sie die neue Anzeige mit der rechten Maustaste an und wählen 
Sie aus dem Kontextmenü die Option Sichtbare Objekte»Cursor 
aus, so dass zwei interaktive Cursor eingeblendet werden (vgl. 
Abbildung 3-1).

Abbildung 3-1.  Signals.seproj

Wenn Sie die Cursor verschieben, werden in der Cursor-Tabelle im 
unteren Bereich der Datenansicht die x- und y-Werte der Cursor 
angezeigt.

7. Klicken Sie auf Datei»Projekt speichern unter und speichern Sie das 
Projekt unter dem Namen My Signals.seproj im Verzeichnis 
C:\Programme\National Instruments\SignalExpress\

Examples\Tutorial.
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Importieren von Signalen aus Dateien
Signale können aus Standarddateiformaten wie ASCII (durch Kommas 
oder Tabulatoren gegliedert) oder LabVIEW-Dateien für Messwerte 
(*.lvm-Dateien) importiert werden. Ebenso können simulierte Signale aus 
Programmen zur Entwurfsautomatisierung (wie SPICE) einbezogen 
werden.

Zum Importieren eines Signals aus einer Datei gehen Sie wie folgt vor:

1. Klicken Sie mit der rechten Maustaste in die Ansicht Projekt und 
wählen Sie Signale laden/speichern»Analoge Signale»Aus 
ASCII-Datei laden aus dem Kontextmenü aus, um den Schritt “Aus 
ASCII-Datei laden” in die Ansicht Projekt einzufügen. Daraufhin 
wird die Registerkarte Schritteinstellungen für den Schritt angezeigt. 
Der Schritt liest die Signale aus der ASCII-Datei aus und stellt sie gra-
fisch dar.

Hinweis Schritte können über das Menü Schritt hinzufügen, die Palette Schritt hinzu-
fügen oder das Kontextmenü der Ansicht Projekt erstellt werden.

2. Vergewissern Sie sich, dass im Pulldown-Menü Dezimalzeichen der 
Punkt ausgewählt ist, so dass die Werte der Beispieldatei ordnungsge-
mäß gelesen werden. 

3. Klicken Sie auf der Registerkarte Schritteinstellungen auf die Schalt-
fläche “Durchsuchen” (vgl. Abbildung links). Wechseln Sie 
anschließend zum Verzeichnis C:\Programme\National 
Instruments\SignalExpress\Examples\Tutorial und 
klicken Sie doppelt auf Step Response.txt.

In der Spalte 1 der Dateivorschau werden die Zeitwerte und in 
Spalte 2 die tatsächlichen Spannungswerte des Signals angezeigt.

4. Wechseln Sie zur Anzeige der auf der Registerkarte Schritteinstellun-
gen verfügbaren Protokolldaten auf die Seite Signale importieren.

5. Vergewissern Sie sich, dass das Signal für Spalte 2 durch ein Häkchen 
markiert ist.

Auf der Registerkarte Schritteinstellungen wird nun unter Impor-
tiertes Signal eine Vorschau des Signals angezeigt.

6. Vergewissern Sie sich, dass im Pulldown-Menü x-Eingangswerte die 
Option Spalte 1 ausgewählt ist, so dass die x-Werte des Signals ent-
sprechend angepasst werden.
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7. Wechseln Sie zur Datenansicht.

8. Erweitern Sie in der Ansicht Projekt den Ausgang Step Response.txt 
des Schritts “Aus ASCII-Datei laden”.

9. Klicken Sie mit der rechten Maustaste auf den Ausgang Spalte 2 und 
wählen Sie aus dem Kontextmenü die Option Umbenennen aus.

10. Geben Sie step response ein und drücken Sie <Enter>, so dass der 
neue Name übernommen wird.

11. Ziehen Sie den neuen Ausgang step response des Schritts “Aus 
ASCII-Datei laden” in die untere Anzeige der Datenansicht.

Die untere Graphanzeige scheint fast keine Signale anzuzeigen.  Das 
liegt daran, dass der Schritt “Analoges Signal erstellen” Signale mit 
einem aktuellen Zeitstempel erzeugt, während der Zeitstempel von 
step response Null lautet.  Klicken Sie mit der rechten Maustaste auf 
die untere Graphanzeige und wählen Sie Zeitstempel»Ignorieren aus, 
um sowohl das Signal filtered step als auch das Signal step response 
zu sehen.

Das Signal filtered step ähnelt der steigenden Flanke von step 
response (vgl. Abbildung 3-2).
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Abbildung 3-2.  Signale im Projekt “Signals.seproj”

12. Speichern Sie das Projekt über Datei»Projekt speichern.
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Ausrichten und Vergleichen von Signalen
Sowohl am Signal filtered step als auch am Signal step response ist ein 
Überschwingen an der steigenden Flanke zu verzeichnen. Dennoch lässt 
sich die Ähnlichkeit zwischen beiden nur schwer abschätzen, da die 
Signale aus unterschiedlichen Quellen stammen und in Amplitude und Zeit 
nicht identisch sind. Sie können die Signale jedoch mit dem Schritt “Inter-
aktive Ausrichtung” aneinander ausrichten und auswählen, welche 
Angaben für das Projekt eine Rolle spielen sollen.

Zum Ausrichten zweier Signale im Projekt My Signals.seproj gehen 
Sie wie folgt vor:

1. Erweitern Sie den Ausgang Step Response.txt, klicken Sie mit der 
rechten Maustaste auf den Ausgang step response und wählen Sie 
Senden an»Verarbeitung»Analoge Signale»Interaktive Ausrich-
tung aus dem Kontextmenü, um das Signal step response vom Schritt 
“Aus ASCII-Datei laden” in den Schritt “Interaktive Ausrichtung” zu 
übertragen. Aktivieren Sie die Option x0 ignorieren auf der Register-
karte Ausrichtung, so dass nicht übereinstimmende Zeitstempel 
ignoriert werden.

Daraufhin werden die zwei neuesten Signale des Projekts als Ein-
gangssignale ausgewählt und im Graphen auf der Registerkarte 
Schritteinstellungen dargestellt (vgl. Abbildung 3-3).
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Abbildung 3-3.  Einstellungen des Schritts “Interaktive Ausrichtung”

Beim Hinzufügen von Schritten zu einem Projekt wählt SignalExpress 
die Eingangssignale je nach den Signaltypen aus, mit denen der Schritt 
arbeitet. Der Schritt “Interaktive Ausrichtung” funktioniert beispiels-
weise nur mit Signalverläufen im Zeitbereich. Daher werden für den 
Schritt die zwei letzten Zeitbereichssignale ausgewählt, die im Projekt 
erstellt wurden. 

Hinweis Um die Eingangssignale eines Schritts zu ändern, wählen Sie aus dem 
Pulldown-Menü auf der Seite Eingabe oder Eingabe/Ausgabe der Registerkarte Schritt-
einstellungen ein anderes Signal aus oder klicken Sie auf den Pfeil neben den 
Schritteingängen in der Ansicht Projekt.

2. Klicken Sie im Graphen Eingangssignale das rote Signal an und 
ziehen Sie es an eine andere Stelle im Graphen. Daraufhin wird der 
Graph Signal nach Vergleich aktualisiert und der berechnete Unter-
schied zwischen beiden Signalen angezeigt.

Sie können das Signal verschieben, aufziehen und stauchen.
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3. Versuchen Sie, die steigenden Flanken der beiden Signale in eine Linie 
zu bringen, indem Sie das Signal im Graphen verschieben. Klicken Sie 
ein Signal an, um einen Ankerpunkt zu setzen, und ziehen Sie bei 
gedrückter <Alt>-Taste am Signal, um es auf der x- oder y-Achse um 
den Ankerpunkt zu dehnen.

Auf der Seite Ausrichtung der Registerkarte Schritteinstellungen 
werden automatisch die Verstärkung (der Faktor) und der Offset (Sum-
mand) für den x- und y-Wert angezeigt.

4. Wählen Sie aus dem Pulldown-Menü Modus die Option Autom. 
Schritt aus, um die Signale in eine Linie zu bringen. SignalExpress 
berechnet automatisch die Ausrichtung.

Der Graph Signal nach Vergleich auf der Registerkarte Schritt-
einstellungen zeigt den Unterschied zwischen den beiden Signalen an.

5. Aktivieren Sie auf der Seite Eingabe/Ausgabe die Option Ausgerich-
tete Signale ausgeben, um die Signale als Ausgangsgrößen des 
Schritts hinzuzufügen.

6. Wechseln Sie zur Datenansicht.

7. Fügen Sie über Neue Anzeige eine dritte Anzeige hinzu.

8. Ziehen Sie die Ausgangssignale Bezugssignal ausgerichtet und Test-
signal ausgerichtet des Schritts “Interaktive Ausrichtung” in den 
neuen Graphen, so dass die ausgerichteten Signale angezeigt werden.

9. Speichern Sie das Projekt über Datei»Projekt speichern.

Signaltypen in SignalExpress
Einige Schritte, zum Beispiel der Schritt “Arithmetik”, arbeiten mit ver-
schiedenen Signaltypen. Mit dem Schritt “Arithmetik” können z. B. 
Berechnungen an Zeit- und Frequenzbereichssignalen durchgeführt wer-
den. Je nach ausgewähltem Eingangssignal passt sich der Schritt 
entsprechend an. Wenn Sie zum Beispiel zwei Zeitbereichssignale 
addieren, werden nur die Amplituden addiert. Bei zwei Frequenzbereichs-
signalen addiert SignalExpress dagegen die entsprechende 
Phasenverschiebung.

Weitere Informationen zu Signaltypen finden Sie in der Hilfe zu 
SignalExpress, indem Sie Hilfe»Hilfe zu SignalExpress auswählen, auf 
die Registerkarte Suchen klicken und das Stichwort Signaltypen 
eingeben.
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Exportieren und Drucken von Signalen
In SignalExpress können Sie Beschreibungen zu Signalen erstellen. 
Darüber hinaus können Sie Signale exportieren, um sie in anderen Pro-
grammen weiter zu analysieren. In diesem Abschnitt lernen Sie, wie 
Signale exportiert (z. B. als ASCII-Datei), an Microsoft Excel übertragen, 
gedruckt oder mit der Dokumentationsfunktion von SignalExpress 
beschrieben werden.

Speichern von Signalen in Dateien
Zum Speichern eines Signals aus dem Projekt My Signals.seproj 
gehen Sie wie folgt vor:

1. Klicken Sie die Schaltfläche Schritt hinzufügen an (vgl. Abbildung 
links), so dass die Palette Schritt hinzufügen angezeigt wird.

2. Wählen Sie Signale laden/speichern»Analoge Signale»Als 
ASCII/LVM speichern, um den Schritt “Als ASCII/LVM speichern” 
zur Ansicht Projekt hinzuzufügen. Daraufhin werden die Schrittein-
stellungen für den Schritt angezeigt.

3. Klicken Sie auf der Registerkarte Schritteinstellungen auf die Seite 
Signale und wählen Sie aus dem Pulldown-Menü Eingangsdaten die 
Option filtered step aus.

4. Geben Sie auf der Seite Datei-Einstellungen den Speicherort für die 
Datei an, indem Sie auf die Schaltfläche Durchsuchen neben dem 
Feld Pfad zur Exportdatei klicken und das Verzeichnis 
C:\Programme\National Instruments\SignalExpress\

Examples\Tutorial auswählen. Geben Sie als Dateinamen 
Gefiltertes Signal.txt ein.

5. Wählen Sie aus dem Pulldown-Menü Bei vorhandener Datei die 
Option Überschreiben aus.

6. Wählen Sie aus dem Pulldown-Menü Typ der Exportdatei die Option 
Allgemeine ASCII-Datei (*.txt) aus.

Mit dem Schritt “Signale laden/speichern” können bei jeder Ausfüh-
rung des Projekts Daten in Dateien gespeichert werden.

7. Klicken Sie auf den Pfeil der Schaltfläche Ausführen und wählen Sie 
Einmal ausführen, um das Projekt zu starten und das Signal in der 
angegebenen ASCII-Datei zu speichern.

8. Speichern Sie das Projekt über Datei»Projekt speichern.

9. Schließen Sie das Projekt über Datei»Projekt schließen.
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10. Öffnen Sie die Datei filtered signal.txt in einem Texteditor, um 
sich die Werte des Signals anzusehen. Mit Hilfe des Schritts “Aus 
ASCII-Datei laden” können die Signale wieder in ein Projekt in 
SignalExpress importiert werden.

Erstellen von Exportdateien für Microsoft Excel
Zum Exportieren eines Signals starten Sie Microsoft Excel und ziehen Sie 
das Ausgangssignal eines Schritts von SignalExpress in die geöffnete 
Tabelle. Sie können auch mit der rechten Maustaste in die Datenansicht 
klicken und die Option Exportieren in»Microsoft Excel auswählen, um 
den Inhalt der geöffneten Anzeige zu exportieren.

Erstellen von Protokollen in SignalExpress
Über Ansicht»Projektdokumentation wird die Registerkarte Projektdo-
kumentation geöffnet. Hier können Sie ein Projekt mithilfe von Text und 
Abbildungen (z. B. Graphen) beschreiben. Wenn Sie das Ausgangssignal 
eines Schritts von der Ansicht Projekt in die Projektdokumentation zie-
hen, wird es darin grafisch dargestellt. Wird das Projekt noch ausgeführt, 
wird auch der Graph in der Projektdokumentation automatisch 
aktualisiert. 

Zum Drucken der Dokumentation wechseln Sie zur Registerkarte 
Projektdokumentation und wählen Sie entweder Datei»Drucken»
Dokumentation drucken aus oder klicken Sie auf die Schaltfläche Doku-
mentation drucken. Zum Speichern der Beschreibung als HTML-Datei 
wechseln Sie zur Registerkarte Projektdokumentation und wählen Sie 
Datei»Exportieren»Dokumentation als HTML-Datei speichern aus.



© National Instruments 4-1 Erste Schritte mit SignalExpress

4
Protokollieren von Daten

Mit SignalExpress können Sie Messergebnisse aufzeichnen und auswerten. 
Sie können Zeitbereichssignale, Werte mit doppelter Genauigkeit, vorzei-
chenlose 32-Bit-Integer, boolesche Werte und digitale Ausgangssignale 
von Schritten protokollieren. Außerdem können Sie protokollierte Werte 
analysieren und verarbeiten, indem Sie Analyseschritte darauf anwenden. 

In diesem Kapitel lernen Sie die Protokollfunktionen von SignalExpress 
kennen. Sie erfahren, wie ein Signal aufgenommen, wiedergegeben und mit 
den Analyseschritten ausgewertet wird. Außerdem wird beschrieben, wie 
mit der Registerkarte Aufnahmeoptionen Signale nach bestimmten Start- 
oder Stoppbedingungen protokolliert werden. 

Aufnehmen eines Signals
Wenn Sie auf die Schaltfläche Aufnahme klicken, können Sie die Proto-
kollierung konfigurieren. 

Zum Auswählen und Aufnehmen eines Signals gehen Sie wie folgt vor:

1. Klicken Sie auf Hilfe»Beispiel öffnen, wechseln Sie zum Verzeichnis 
Tutorial und klicken Sie doppelt auf Logging.seproj.

In diesem Projekt wird mit dem Schritt “Analoges Signal erstellen” ein 
Signal anhand einer Formel erstellt.

2. Klicken Sie auf die Schaltfläche Aufnahme (vgl. Abbildung links), 
um zum Dialogfeld Protokollsignale auswählen zu gelangen.

Das Dialogfeld Protokollsignale auswählen zeigt alle protokollier-
baren Signale im Projekt an. Sie können ein Signal oder mehrere 
Signale auswählen. Außerdem können Sie das Protokoll hier benennen 
und beschreiben.

3. Aktivieren Sie die Option signal, um das berechnete Signal des 
Schritts “Analoges Signal erstellen” aufzunehmen.

4. Klicken Sie auf die Schaltfläche OK, um das Dialogfeld zu schließen 
und mit der Aufnahme zu beginnen. Die Aufnahme läuft bis zum 
Anklicken der Schaltfläche Stopp.
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5. Klicken Sie auf die Schaltfläche Stopp (vgl. Abbildung links), um die 
Aufnahme anzuhalten. Wenn zuvor noch kein Signal aufgenommen 
wurde, wird das Dialogfeld Erstes Protokoll vollständig angezeigt. 
Klicken Sie auf OK.

Die aufgezeichneten Daten werden im Fenster Protokolldaten im 
unteren Teil der Ansicht Projekt angezeigt (vgl. Abbildung 4-1).

Abbildung 4-1.  Fenster “Protokolldaten”

Per Voreinstellung kennzeichnet SignalExpress die Werte mit dem 
Datum und der Zeit, zu der sie aufgezeichnet wurden. Alle Protokoll-
daten werden im *.tdms-Format in dem unter Optionen angegebenen 
Verzeichnis gespeichert. 

6. Zur Auswahl eines Verzeichnisses für protokollierte Werte wählen Sie 
Werkzeuge»Optionen und klicken Sie auf Protokollierung. Hier 
finden Sie auch alle anderen Einstellungen zur Protokollierung.

7. Klicken Sie auf OK, um das Dialogfeld Optionen zu schließen.

8. Klicken Sie auf Datei»Projekt speichern unter und speichern Sie das 
Projekt unter dem Namen My Logging.seproj im Verzeichnis 
C:\Programme\National Instruments\SignalExpress\

Examples\Tutorial.

Anzeigen aufgezeichneter Signale
Zum Anzeigen der aufgezeichneten Signale gehen Sie wie folgt vor:

1. Wenn die Registerkarte Datenansicht nicht angezeigt wird, klicken 
Sie auf Ansicht»Datenansicht. 

2. Unter Protokolldaten wird eine Liste aller aufgezeichneten Werte des 
Projekts angezeigt. Wählen Sie aus dem Fenster Protokolldaten das 
soeben erstellte Protokoll aus und ziehen Sie es in die Datenansicht. 
In der Datenansicht werden die Protokolldaten und eine Vorschau 



Kapitel 4 Protokollieren von Daten

© National Instruments 4-3 Erste Schritte mit SignalExpress

angezeigt (vgl. Abbildung 4-2; die Kontexthilfe ist hier geschlossen). 
Das Signal in der Datenansicht kann sich je nach Länge der Aufzeich-
nung von Abbildung 4-2 unterscheiden.

Abbildung 4-2.  Logging.seproj

In der Vorschau können Sie in die Datenansicht hineinzoomen oder 
sich durch Hin- und Herziehen der Maus verschiedene Abschnitte 
ansehen. Die Vorschau wird bei der Anzeige aufgezeichneter Werte 
immer zuerst geöffnet. Wenn Sie aktuelle bzw. nicht aufgezeichnete 
Werte betrachten, können Sie zum Öffnen der Vorschau mit der rech-
ten Maustaste auf die Datenansicht klicken und Sichtbare 
Objekte»Vorschau auswählen.

Zum Vergrößern der Ansicht der aufgezeichneten Werte klicken Sie 
auf die Schaltfläche Heranzoomen neben der Vorschau. Die Cursor in 
der Vorschau zeigen die Werte an, die gerade in der Datenansicht dar-
gestellt werden. Mit der Bildlaufleiste unter der Vorschau können Sie 
durch die Werte scrollen. Durch Anklicken und Ziehen der Cursor 
können Sie die Anzahl der dargestellten Werte variieren.

1 Protokolldaten 2 Vorschau

1

2
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Protokollieren von Signalen mit Start- und 
Stoppbedingungen

Mit Hilfe von Start- und Stoppbedingungen können Sie einen Zeitraum 
festlegen, während dessen Signale aufgezeichnet werden sollen. Gehen Sie 
dazu wie folgt vor:

1. Wählen Sie Ansicht»Aufnahmeoptionen, wenn die Registerkarte 
Aufnahmeoptionen nicht eingeblendet ist.

2. Klicken Sie unter Kategorie auf Signalauswahl.

3. Setzen Sie dann neben dem Signal in der Spalte Aufnahme ein Häk-
chen (vgl. Abbildung 4-3).

Abbildung 4-3.  Signalauswahl

Die Beschriftung der Schaltfläche Aufnahme ändert sich daraufhin in 
Aufnahme während Ausführung (vgl. Abbildung links). Die Schalt-
fläche Aufnahme während Ausführung muss angeklickt sein. Nur 
so wird das ausgewählte Signal nach dem Anklicken der Schaltfläche 
Ausführen protokolliert.

4. Klicken Sie unter Kategorie auf Startbedingungen. 



Kapitel 4 Protokollieren von Daten

© National Instruments 4-5 Erste Schritte mit SignalExpress

5. Klicken Sie auf die Schaltfläche Hinzufügen unter der Liste der 
Startbedingungen, um eine Bedingung für die Protokollierung 
festzulegen.

a. Unter Bedingungsart muss Signal-Trigger ausgewählt sein. Das 
heißt, die Aufnahme beginnt erst, wenn das Eingangssignal die 
angegebene Bedingung erfüllt.

b. Im Pulldown-Menü Signal muss signal ausgewählt sein.

c. Unter Trigger-Typ muss Pos. Steigung ausgewählt sein. Das 
bedeutet, dass mit der Aufnahme erst begonnen wird, wenn das 
Signal die angegebene Flanke bei positiver Steigung erreicht.

d. Stellen Sie Trigger-Wert auf 1 ein. Die Protokollierung beginnt 
dann beim Wert 1 einer steigenden Flanke.

6. Klicken Sie unter Kategorie auf Stoppbedingungen.

7. Klicken Sie auf die Schaltfläche Hinzufügen unter der Liste der 
Stoppbedingungen, um eine Bedingung für das Ende der Protokollie-
rung festzulegen.

a. Vergewissern Sie sich, dass im Pulldown-Menü Bedingungsart 
die Option Dauer ausgewählt ist. Damit wird die Aufnahme nach 
Ablauf einer bestimmten Zeit angehalten.

b. Vergewissern Sie sich, dass im Element Dauer (s) der Wert 5 
angezeigt wird. Das bedeutet, die Aufnahme wird 5 Sekunden 
nach dem Signalbeginn beendet.

8. Klicken Sie auf die Schaltfläche Ausführen (vgl. Abbildung links). 
SignalExpress beginnt dann beim Überschreiten von Pegel 1 an einer 
steigenden Flanke mit der Protokollierung und zeichnet das Signal 
fünf Sekunden lang auf. 

Während der Ausführung des Projekts ändern sich folgende Anzeigen 
im Bereich Protokollierungsstatus der Registerkarte 
Aufnahmeoptionen:

• Aufnahme wechselt auf ein, wenn das Signal die Startbedingung 
erfüllt hat und die Protokollierung läuft. 

• Festplattenangaben zeigt an, wie viel Festplattenspeicher für die 
Protokollierung noch frei ist. 

• Geschätzte Protokollgröße zeigt die Größe der Protokolldatei an.
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• Verfügbare Aufnahmezeit zeigt die Zeit an, die für die Protokol-
lierung noch zur Verfügung steht, bis die Festplatte voll ist.

• Aktuelles Protokoll begann zeigt den Startzeitpunkt des aktu-
ellen Protokolls an.

Die Seiten Startbedingungen, Stoppbedingungen, Alarme und 
Ereignisse der Registerkarte Aufnahmeoptionen enthalten auch 
Anzeigen für den Status von Start- und Stoppbedingungen, Alarmen 
und Ereignissen.

Analysieren aufgezeichneter Signale
Nach dem Aufzeichnen eines Signals können Sie dieses wieder abspielen 
und mit Analyseschritten auswerten. Zum Analysieren eines aufgezeichne-
ten Signals gehen Sie wie folgt vor:

1. Suchen Sie das Pulldown-Menü Arbeitsbereich über der Ansicht Pro-
jekt (vgl. Abbildung 4-4). Klicken Sie auf den Pfeil und wählen Sie 
Wiedergabe aus, um zum Wiedergabebereich zu gelangen.

Abbildung 4-4.  Pulldown-Menü zur Auswahl des Arbeitsbereichs

In Arbeitsbereichen können Sie im selben Projekt mehrere Arbeits-
schritte von SignalExpress ausführen. So können Sie z. B. Daten 
erfassen, Signale verarbeiten, Daten aufzeichnen und Messungen an 
den aufgezeichneten Daten vornehmen, ohne dazu ein neues Projekt 
öffnen zu müssen. Beim Speichern eines Projekts speichert 
SignalExpress alle Arbeitsbereiche zum Projekt in derselben Datei.

Im voreingestellten Arbeitsbereich, “Anzeigen/Aufnehmen”, können 
Sie Messungen an Signalen durchführen, die Signale auswerten und 
aufzeichnen. Im Wiedergabebereich können im Arbeitsbereich 
“Anzeigen/Aufnehmen” aufgenommene Daten als Eingangswerte für 
eine Analyse verwendet werden.

2. Klicken Sie auf die Schaltfläche Schritt hinzufügen (vgl. Abbildung 
links) und wählen Sie Verarbeitung»Analoge Signale»Filter. 
SignalExpress legt an den Eingang des Schritts “Filter” automatisch 
das erste aufgezeichnete Signal an.
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3. Wechseln Sie zur Datenansicht und ziehen Sie das Ausgangssignal 
gefilterte Daten des Schritts “Filter” in die Datenansicht, um das 
resultierende Signal anzuzeigen.

4. Klicken Sie auf die Schaltfläche Ausführen. In der Datenansicht 
wird nun das gefilterte Signal angezeigt und SignalExpress spielt die 
gesamte Aufzeichnung ab.

Erweiterte Wiedergabe
Auf der Registerkarte Wiedergabeoptionen können Sie die Datenwieder-
gabe im Detail konfigurieren. Die Registerkarte Wiedergabeoptionen 
zeigt eine Vorschau der aufgezeichneten Daten an und Sie können daraus 
einen Abschnitt auswählen, der mit den Analyseschritten ausgewertet 
werden soll.

1. Wählen Sie Ansicht»Wiedergabeoptionen, um zur Registerkarte 
Wiedergabeoptionen zu wechseln (vgl. Abbildung 4-5). 

Abbildung 4-5.  Registerkarte “Wiedergabeoptionen”

2. Wählen Sie im Feld Protokolliertes Signal das signal der letzten Auf-
nahme aus.

3. Geben Sie als Startzeit (s) den Wert 1 ein. So werden alle Daten abge-
spielt oder ausgewertet, die eine Sekunde nach Beginn der 
Aufzeichnung aufgenommen wurden. 



Kapitel 4 Protokollieren von Daten

Erste Schritte mit SignalExpress 4-8 ni.com

4. Geben Sie als Stoppzeit (s) den Wert 4 ein. Damit werden alle Daten 
bis zum Ablauf von vier Sekunden nach Aufzeichnungsbeginn abge-
spielt oder ausgewertet. Wenn das Protokoll kürzer als vier Sekunden 
ist, passen Sie die Stoppzeit (s) entsprechend an. 

5. Klicken Sie im Feld Protokolliertes Signal mit der rechten Maustaste 
auf signal (zweite Aufnahme) und wählen Sie Aktivieren aus dem 
Kontextmenü, um das Signal als aktives Protokoll festzulegen.

Hinweis Sie können auch ein Protokoll im Fenster Protokolldaten mit der rechten Maus-
taste anklicken und Protokoll aktiv schalten aus dem Kontextmenü wählen.

6. Wechseln Sie zur Datenansicht. Der Graph in der Datenansicht wird 
automatisch aktualisiert, so dass nach der Aktivierung des zweiten 
Protokolls das darin aufgezeichnete Signal angezeigt wird. 

7. Klicken Sie auf die Schaltfläche Ausführen (vgl. Abbildung links). 
SignalExpress filtert nun den Bereich des Signals, den Sie in den Wie-
dergabeoptionen angegeben haben. Das gefilterte Signal wird in der 
Datenansicht angezeigt.

8. Schließen Sie das Projekt über Datei»Projekt schließen. Daraufhin 
wird das Dialogfeld Projektänderungen speichern? angezeigt. Wäh-
len Sie Projekt verwerfen und Protokolle löschen. Sie können auch 
Projekt und Protokolle speichern oder Projekt verwerfen und Pro-
tokolle beibehalten auswählen.

In der Hilfe zu SignalExpress, die sich unter Hilfe»Hilfe zu SignalExpress 
befindet, sind weitere Optionen zur Aufzeichnung und Wiedergabe von 
Daten, z. B. anhand von Alarmbedingungen, beschrieben.
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5
Messungen mit variierenden 
Größen

Mit SignalExpress können Sie Messungen mit dem so genannten 
Sweep-Modus automatisieren, um Produktentwürfe zu testen und zu über-
prüfen, ob diese realen Bedingungen standhalten. In SignalExpress können 
Sie beliebige Produktentwürfe validieren. Anhand von Sweep-Messungen 
können Sie Daten zu Produktentwürfen über einen Bereich von Konditi-
onen hinweg gewinnen, um die Funktion der Entwürfe zu dokumentieren. 
So können Sie zum Beispiel die Frequenz eines angelegten Signals 
wobbeln oder eine Versorgungsspannung variieren, um Produktentwürfe 
auszutesten.

In diesem Kapitel lernen Sie, wie mit dem Sweep-Schritt in SignalExpress 
Messungen mit variierenden Parametern vorgenommen werden. Sie erfah-
ren u. a., wie die Reaktion eines Filters auf eine Reihe verschiedener 
Frequenzen gemessen wird. Es wird beschrieben, wie die Ergebnisse der 
Sweep-Messung angezeigt und parallele Sweeps für komplexe Messungen 
vorgenommen werden.

Festlegen des Messbereichs und der Ausgangsgrößen
In SignalExpress können Sie Messungen durch komplexe, sich wiederho-
lende Sweeps automatisieren.

Zum Festlegen eines Frequenzbereichs, mit dem ein Filter in einem Bei-
spielprojekt gewobbelt werden soll, gehen Sie wie folgt vor:

1. Klicken Sie auf Hilfe»Beispiel öffnen, wechseln Sie zum Verzeichnis 
Tutorial und klicken Sie doppelt auf Sweep.seproj.

2. Klicken Sie auf die Schaltfläche Ausführen (vgl. Abbildung links), 
um die kontinuierliche Ausführung des Projekts zu starten.

Mit dem Schritt “Analoges Signal erstellen” wird ein Sinussignal 
generiert, das den Schritt “Filter” (als elliptischer Bandpassfilter kon-
figuriert) durchläuft. Anschließend wird mit dem Schritt “Amplitude 
und Pegel” der Effektivpegel des Filters gemessen und anhand des 
Schritts “Formel” in Dezibel umgerechnet. Der Filterschritt soll den 
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Prüfling simulieren, so dass das Projekt keine Hardware benötigt. Sie 
können aber auch ein tatsächliches Signal von einem Arbiträr- oder 
Funktionsgenerator, einer Multifunktionskarte von National 
Instruments oder das Ergebnis einer Analyse dynamischer Signale 
verwenden.

3. Klicken Sie auf die Schaltfläche Stopp, um das Projekt anzuhalten.

4. Klicken Sie auf die Schaltfläche Schritt hinzufügen (vgl. Abbildung 
links) und wählen Sie Ausführungssteuerung»Sweep, um den Schritt 
“Sweep” in die Ansicht Projekt einzufügen.

5. Klicken Sie auf der Registerkarte Schritteinstellungen auf die Schalt-
fläche Hinzufügen. Daraufhin wird zu jedem Schritt im Projekt eine 
Liste variierbarer Parameter angezeigt (vgl. Abbildung 5-1).

Abbildung 5-1.  Auswahlfeld der variierbaren Messparameter

6. Wählen Sie unter Analoges Signal erstellen die Option Frequenz 
(Hz) aus und klicken Sie auf OK.

Der Schritt “Sweep” umfasst den Schritt “Analoges Signal erstellen”, 
der das Signal für die Messung mit variierenden Parametern 
bereitstellt.

7. Wählen Sie auf der Seite Sweep-Konfiguration der Registerkarte 
Schritteinstellungen aus dem Pulldown-Menü Typ die Option Expo-
nentiell aus.

8. Geben Sie 1k für Start: Frequenz (Hz) und 40k für Stopp: Frequenz 
(Hz) ein.
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9. Stellen Sie Werteanzahl auf 150 ein.

Die Seite Sweep-Konfiguration sollte Abbildung 5-2 entsprechen.

Abbildung 5-2.  Registerkarte “Schritteinstellungen” des Schritts “Sweep”

Mit dem Schritt “Sweep” können Sie für den Parameter Frequenz 
(Hz) des Schritts “Analoges Signal erstellen” einen Bereich von 
Werten festlegen, die nacheinander durchlaufen werden sollen. Der 
Schritt “Analoges Signal erstellen” erzeugt dann anhand dieses 
Bereichs bei jeder der Frequenzen eine Sinusschwingung. Der 
Sweep-Schritt ist aber nicht auf das Wobbeln von Frequenzen 
beschränkt, sondern funktioniert auch mit anderen Schritten, sofern 
deren Parameter variierbar sind.

10. Wechseln Sie zur Seite Sweep-Ausgang.
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11. Klicken Sie auf die Schaltfläche Hinzufügen, um zu jedem Schritt 
eine Liste variierbarer Parameter anzuzeigen.

12. Wählen Sie den Ausgang response amplitude in dB unter Formel aus 
und klicken Sie auf OK, um diese Messwerte dem gewobbelten Para-
meter Frequenz (Hz) visuell gegenüberzustellen.

Mit dem Sweep-Schritt wird um alle anderen Schritte in der Ansicht 
Projekt eine Schleife gelegt, in der die Schritte wiederholt werden.

Messungen mit variierenden Größen
Beginnen Sie die Messung mit variierenden Parametern wie folgt:

1. Wechseln Sie zur Datenansicht und klicken Sie auf den Pfeil 
der Schaltfläche Ausführen. Wählen Sie die Option Einmal ausfüh-
ren aus.

Der Ausgang stimulus signal des Graphen geht nun die Frequenzen 
im angegebenen Bereich nacheinander durch.

2. Ziehen Sie das Signal response amplitude in dB vs. Frequency am 
unteren Rand der Sweep-Schleife in die Datenansicht, damit das 
Ergebnis der Messung angezeigt wird.

SignalExpress erzeugt daraufhin einen neuen Graphen. Die Messung 
mit variierenden Parametern ergibt ein x-y-Array, für das ein geson-
derter Graph benötigt wird (vgl. Abbildung 5-3).
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Abbildung 5-3.  Sweep.seproj

3. Klicken Sie erneut auf Einmal ausführen.

Der Frequenzgang des Filters wird auf dem neuen Graphen dargestellt. 
Der Graph zeigt die Übertragungsfunktion des Filters an, also die 
Amplitude in dB gegenüber der Frequenz.

Hinweis Per Voreinstellung werden Anzeigen in der Datenansicht zwischen den Iterati-
onen eines Sweeps nicht gelöscht. Da der Frequenzgang des Filterschritts für jede Iteration 
gleich ist, scheint es, als würde sich das Signal während der Ausführung des Projekts nicht 
ändern. Auf der Seite Daten des Dialogfelds Optionen können Sie festlegen, ob die Anzei-
gen zwischen den Iterationen eines Sweeps gelöscht werden sollen. Wählen Sie 
Werkzeuge»Optionen, um zum Dialogfeld Optionen zu gelangen.
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4. Klicken Sie den Schritt “Filter” doppelt an, so dass auf der Register-
karte Schritteinstellungen die Filterspezifikationen angezeigt 
werden.

Der unter Amplitudengang des Filters (dB) dargestellte Frequenz-
gang stimmt mit dem Graphen in der Datenansicht überein.

5. Klicken Sie auf Datei»Projekt speichern unter und speichern Sie das 
Projekt unter dem Namen My Sweep.seproj im Verzeichnis 
C:\Progamme\National Instruments\SignalExpress\

Examples\Tutorial.

Sie können auch mehrere Parameter gleichzeitig variieren, indem Sie auf 
der Seite Sweep-Konfiguration der Registerkarte Schritteinstellungen 
des Schritts “Sweep” weitere Parameter auswählen. Ein Sweep mit mehre-
ren variierenden Parametern wird paralleler Sweep genannt. Wenn Sie zum 
Beispiel zur Messung ein Signal mit wechselnder Amplitude anlegen 
möchten, erzielen Sie die höchste Messgenauigkeit, indem Sie den Ein-
gangsbereich des A/D-Wandlers oder der MIO-Karte mit dem Signalpegel 
variieren. Durch stetiges Anpassen des Eingangsbereichs des Messgeräts 
an den Signalpegel können Sie die gesamte Auflösung des Geräts für die 
Messung ausnutzen.

Geschachtelte Messungen mit variierenden Parametern
Ebenso können zwei Sweeps ineinander verschachtelt werden. So können 
Sie zum Beispiel bei verschiedenen Amplituden durch die Frequenzen 
eines Signals wobbeln. Sie können beispielsweise die Amplitude auf den 
Pegel 1 setzen und alle Frequenzen durchlaufen, dann die Amplitude auf 2 
setzen und alle Frequenzen durchlaufen usw. Um eine geschachtelte Mes-
sung mit variierenden Parametern durchzuführen, klicken Sie einen 
Sweep-Schritt mit der rechten Maustaste an und wählen Sie Multi-Sweep 
hinzufügen, um eine weitere Sweep-Schleife einzufügen. 

Zum Öffnen eines Beispielprojekts, in dem geschachtelte Messungen mit 
variierenden Parametern demonstriert werden, gehen Sie wie folgt vor:

1. Klicken Sie auf Hilfe»Beispiel öffnen, wechseln Sie zum Verzeichnis 
Tutorial und klicken Sie doppelt auf Nested Sweep.seproj.

2. Klicken Sie zum Starten des Projekts auf die Schaltfläche Ausführen.

Jedes Mal, wenn die innere Sweep-Schleife durchläuft, wird die Fre-
quenz des anliegenden Signals gewobbelt. Mit der äußeren 
Sweep-Schleife werden die obere und die untere Grenzfrequenz des 
Schritts “Filter” geändert. Jede Iteration wird verzögerungsfrei im 
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oberen Graphen dargestellt. Im unteren Graphen erscheinen dazu die 
Messergebnisse bei jeder Änderung der Grenzfrequenz (vgl. 
Abbildung 5-4).

Abbildung 5-4.  Nested Sweep.seproj

3. Klicken Sie auf die Schaltfläche Stopp (vgl. Abbildung links), um das 
Projekt zu beenden.
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6
Erweitern von 
SignalExpress-Projekten durch 
LabVIEW

Mit den Schritten zur Erfassung, Erzeugung, Analyse oder Aufzeichnung 
von Daten können Sie mit SignalExpress automatisierte Messungen vor-
nehmen. Das Programm kann auf folgende Arten durch LabVIEW 
erweitert werden:

• Erstellen eines VIs in LabVIEW und Importieren des VIs in 
SignalExpress als neuen Schritt. Auf diese Weise kann die Anzahl der 
Schritte in SignalExpress erhöht werden.

• Umwandeln eines SignalExpress-Projekts in ein LabVIEW-VI, um die 
Schritte durch LabVIEW-VIs und -Funktionen zu ergänzen.

Importieren von LabVIEW-VIs in SignalExpress als neue 
Schritte

Aufrufen benutzerdefinierter LabVIEW-VIs in SignalExpress mit dem 
Schritt “LabVIEW-VI ausführen”. 

Hinweis Die LabVIEW-Entwicklungsumgebung wird für Schritte zum Ausführen von 
LabVIEW-VIs nicht benötigt. Die Schritte zum Ausführen von LabVIEW-VIs arbeiten 
nicht mit VIs, die in 64-Bit-Versionen von LabVIEW erstellt wurden.

Durch Aufrufen eines LabVIEW-VIs von SignalExpress aus können 
Sie z. B.:

• GPIB-Instrumente steuern

• Hardware von National Instruments nutzen, die SignalExpress nicht 
unterstützt

• Mit zusätzlichen Dateiformaten arbeiten

• Bedienungsanleitungen in Popup-Dialogfeldern einblenden

• Messalgorithmen festlegen
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Gehen Sie zum Importieren eines LabVIEW-VIs mit dem Schritt 
“LabVIEW-VI ausführen” wie folgt vor:

1. Klicken Sie auf Hilfe»Beispiel öffnen, wechseln Sie zum Verzeichnis 
Tutorial und klicken Sie doppelt auf User Step.seproj.

In diesem Projekt wird mit dem Schritt “Analoges Signal erstellen” ein 
Signal erstellt.

2. Klicken Sie auf die Schaltfläche Schritt hinzufügen und wählen Sie 
LabVIEW-VI ausführen»VI ausführen - LabVIEW 2011. 

Hinweis Das in dieser Übung genutzte VI wurde in LabVIEW 2011 gespeichert. Sie müs-
sen stets die Version des Schritts “LabVIEW-VI ausführen” verwenden, in dem Ihr VI 
gespeichert wurde.

3. Klicken Sie auf der Registerkarte Schritteinstellungen unter VI aus-
wählen auf die Schaltfläche “Durchsuchen” und wählen Sie aus dem 
Verzeichnis C:\Programme\National Instruments\
SignalExpress\Examples\Tutorial die Datei 
Limiter-LV2011.vi aus. Das VI “Limiter-LV2011” schneidet ein 
Zeitbereichssignal an den in den Schritteinstellungen festgelegten 
Werten ab.

Beim Importieren eines LabVIEW-VIs in SignalExpress werden die 
Eingänge des VIs als Schrittparameter und die Ausgänge des VIs als 
Ausgänge des Schritts interpretiert.

Bei den VI-Eingängen können Sie festlegen, ob diese Eingangssignale 
oder Parameter darstellen sollen. Ein Eingangssignal erscheint in der 
Ansicht Projekt als Eingang eines Schritts, so dass Sie dem VI von 
außen Signale zuführen können. Parameter sind alle Schritteinstel-
lungen im Dialogfeld zu einem Schritt. Mit dem Sweep-Schritt 
können Sie bestimmte Parameter dynamisch ändern. Im vorliegenden 
Projekt liegt am VI ein Zeitbereichssignal an und es hat die Parameter 
Upper limit und Lower limit (beides Skalarwerte).
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Das Dialogfeld Schritteinstellungen sollte wie in Abbildung 6-1 
aussehen.

Abbildung 6-1.  Registerkarte “Schritteinstellungen” des VIs “Limiter”

4. Klicken Sie auf die Schaltfläche Ausführen (vgl. Abbildung links), 
um das Projekt zu starten. 

5. Wechseln Sie zur Datenansicht und ziehen Sie das Signal Clipped 
waveform out des Schritts “VI ausführen - LabVIEW 2011” in die 
Datenansicht.

6. Klicken Sie doppelt auf den Schritt “VI ausführen - LabVIEW 2011”, 
um zur Registerkarte Schritteinstellungen zu gelangen.

7. Klicken Sie zur Anzeige des VIs auf die Seite VI konfigurieren. 

8. Ändern Sie die Werte für Upper limit und Lower limit. Geben Sie 
beispielsweise in Upper limit den Wert 100 ein.

9. Wechseln Sie zur Datenansicht. Das Signal Clipped waveform out 
wird nun in der Datenansicht den Änderungen entsprechend angezeigt.

10. Klicken Sie auf die Schaltfläche Stopp (vgl. Abbildung links), um das 
Projekt zu beenden.
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11. Wählen Sie Datei»Projekt speichern unter und geben Sie dem Pro-
jekt den Namen My User Step.seproj.

12. Schließen Sie das Projekt über Datei»Projekt schließen.

Informationen zum Verwenden von VIs in SignalExpress sowie zum Ent-
wickeln von VIs, die für SignalExpress geeignet sind, finden Sie in der 
Hilfe zu SignalExpress.

Umwandeln von SignalExpress-Projekten in 
LabVIEW-VIs

SignalExpress-Projekte können in LabVIEW-VIs umgewandelt werden.

Hinweis Zur Umwandlung eines Projekts von SignalExpress in ein LabVIEW-VI wird das 
LabVIEW Full Development System ab 8.2 benötigt.

Zum Umwandeln eines SignalExpress-Projekts in ein LabVIEW-VI gehen 
Sie wie folgt vor:

1. Klicken Sie auf Hilfe»Beispiel öffnen, wechseln Sie zum Verzeichnis 
Tutorial\Solutions und klicken Sie doppelt auf My First 
Project.seproj.

2. Wählen Sie Werkzeuge»Programmcode erzeugen»
LabVIEW-Blockdiagramm.

3. Geben Sie einen Namen und Speicherort für das neue VI an und 
klicken Sie auf OK. SignalExpress erzeugt das neue VI und öffnet es 
in der zuletzt auf Ihrem Rechner geöffneten Version von LabVIEW.

Das erzeugte LabVIEW-VI spiegelt den Projektablauf in 
SignalExpress wider. Das Blockdiagramm besteht aus mehreren mit-
einander verbundenen LabVIEW-Express-VIs. Jedes Express-VI 
entspricht einem Schritt im SignalExpress-Projekt. Bei einem Doppel-
klick auf ein Express-VI werden die gleichen Schritteinstellungen 
wie in SignalExpress angezeigt. Sie können die Express-VIs auch mit 
der rechten Maustaste anklicken und Frontpanel öffnen auswählen, 
um das Express-VI in ein LabVIEW-SubVI umzuwandeln. Im Block-
diagramm können Sie die Ausführung des VIs sehen und das VI 
ändern. Die Umwandlung eines Express-VIs in ein SubVI ist nicht 
umkehrbar.

Hinweis Beim Umwandeln eines SignalExpress-Projekts mit Datenprotokollierung ent-
hält das erzeugte Blockdiagramm nur ein Express-VI. Das Express-VI lässt sich nicht in 
ein SubVI umwandeln.
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7
Weitere Informationen

Weitere Informationen zu SignalExpress finden Sie in den nachfolgenden 
Informationsquellen.

Beispielprojekte zu SignalExpress
SignalExpress enthält eine Vielzahl von Beispielprojekten zur Veranschau-
lichung der Programmfunktionen. Diese Projekte befinden sich 
im Verzeichnis C:\Programme\National Instruments\
SignalExpress\Examples. Mit Hilfe der Beispiele können Sie sich mit 
den Funktionen von SignalExpress näher vertraut machen oder ein pas-
sendes Beispiel als Grundlage für ein eigenes Projekt verwenden.

Verwendung von Hardware mit SignalExpress
SignalExpress unterstützt zahlreiche Geräte von National Instruments für 
die Erfassung und Erzeugung von Signalen. SignalExpress arbeitet mit 
MIO-Karten, Karten zur Analyse dynamischer Signale, Hochgeschwindig-
keits-A/D-Wandlern sowie Arbiträr- und Funktionsgeneratoren von 
National Instruments. Sie können auch mehrere Geräte in einem System 
synchronisieren, indem Sie für alle Geräte denselben Takt oder Trigger 
verwenden. Weitere Einzelheiten zur Verwendung von Hardware mit 
SignalExpress finden Sie in der Hilfe zu SignalExpress , die sich unter 
Hilfe»Hilfe zu SignalExpress befindet.

Informationen im Web
Auf der Website ni.com/signalexpress finden Sie Beispielprojekte, 
technische Beschreibungen und LabVIEW-VIs für das Programm.

http://www.ni.com/signalexpress
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A
Technische Unterstützung und 
professioneller Service

Melden Sie sich mit Ihrem National-Instruments-Benutzerprofil auf 
ni.com an, um Zugriff auf persönliche Serviceleistungen zu erhalten. 
Informationen zu Serviceleistungen und technischem Support von National 
Instruments sind auf ni.com unter folgenden Abschnitten zu finden:

• Support—Technische Unterstützung erhalten Sie auf der Website 
ni.com/support/d in Form folgender Informationsquellen und 
Tools:

– Technische Ressourcen—Die Website ni.com/support/d 
bietet Ihnen Soforthilfe bei Fragen und Problemen. Außerdem 
finden Sie hier Treiber, Updates, eine umfassende Wissens-
datenbank (KnowledgeBase), Bedienungsanleitungen, Anlei-
tungen zur Problemlösung, Tausende Beispielprogramme, 
autodidaktische Kurse und Application Notes. Registrierte Nutzer 
können sich auch an den Diskussionsforen auf ni.com/forums 
(englisch) beteiligen. Jede im Forum eingereichte Frage wird 
garantiert beantwortet.

– Standard Service Program—Teilnehmer dieses Programms 
können sich telefonisch oder per E-Mail direkt mit unseren 
Applikationsingenieuren in Verbindung setzen und haben 
exklusiven Zugriff auf Selbstlernmodule auf ni.com/
self-paced-training. Mit dem Erwerb der meisten Software-
produkte und Produktpakete von National Instruments 
einschließlich der NI Developer Suite ist automatisch ein Einjah-
resabonnement für das Standard Service Program (SSP) 
inbegriffen. Darüber hinaus bietet National Instruments flexible 
Vertragsoptionen zum Verlängern Ihrer SSP-Leistungen. Weitere 
Informationen dazu finden Sie auf ni.com/ssp.

Welche Art der technischen Unterstützung es in Ihrer Nähe gibt, 
erfahren Sie unter ni.com/services/d oder bei einer unserer 
Niederlassungen (ni.com/contact). 

• Training und Zertifizierung—Auf ni.com/training erhalten 
Sie Informationen zu Schulungsmaterialien und Zertifizierungs-
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programmen von National Instruments. Hier können Sie sich auch 
für eine der weltweit angebotenen Softwareschulungen anmelden.

• Systemintegration—Wenn Sie aus Zeit- oder Personalmangel oder 
anderen Gründen bei der Fertigstellung eines Projekts in Verzug gera-
ten, können Ihnen die Mitglieder des NI-Alliance-Programms 
weiterhelfen. Für Informationen zu diesem Programm setzen Sie 
sich entweder telefonisch mit einer National-Instruments-Niederlas-
sung in Ihrer Nähe in Verbindung oder besuchen Sie die Website 
ni.com/alliance.

Auf die Websites der einzelnen Niederlassungen, auf denen Sie immer die 
aktuellen Kontaktinformationen, Telefonnummern des technischen Sup-
ports, E-Mail-Adressen sowie Informationen über Veranstaltungen finden, 
gelangen Sie über ni.com/niglobal.
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このマニュアルについて

SignalExpress の対話式計測、および信号の集録と解析に使用する

SignalExpress の基本的な機能について説明します。

本書には、SignalExpress で作業を開始する際に役立つ演習問題などが含

まれています。これらの演習では、プロジェクトの実行方法、ステップの

構成方法、信号の操作方法、スイープ計測の構成方法、データのログ方

法、LabVIEW のグラフィカルプログラミングを使用して SignalExpress
を拡張する方法について説明します。

表記規則

このマニュアルでは、以下の表記規則を使用しています。

→ 矢印（→）は、ネスト化されたメニュー項目やダイアログボックスのオプ

ションをたどっていくと目的の操作項目を選択できることを示します。

オプション→設定→一般と表記されている場合は、まずオプションメ

ニューをプルダウンし、次に設定項目を選択し、最後にダイアログボック

スで一般を選択します。

このアイコンは、ユーザへのアドバイスを示します。

このアイコンは、注意すべき重要な情報を示します。

太字 太字のテキストは、メニュー項目やダイアログボックスオプションなど、

ソフトウェアでユーザが選択またはクリックする必要がある項目を示しま

す。また、パラメータ名、入出力名、ビュー、ダイアログボックスまたは

その一部、メニュー名も示します。

斜体 斜体のテキストは、変数、強調、相互参照、または重要な概念の説明を示

します。また、斜体のテキストは、ユーザが入力する必要がある語句また

は値のプレースホルダも示します。

monospace このフォントのテキストは、キーボードから入力する必要があるテキスト

や文字を示します。また、ディスクドライブ、パス、ディレクトリ、プロ

グラム、サブプログラム、サブルーチンなどの名称、デバイス名、関数、

演算、変数、ファイル名および拡張子の引用にも使用されます。

関連ドキュメント

詳細は、ヘルプ→ SignalExpress ヘルプを選択して、『SignalExpress ヘ
ルプ』を参照してください。
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SignalExpress スタートアッ
プガイド

ナショナルインスツルメンツでは、科学者やエンジニア向けに業界標準の

コンピュータとプラットフォームで自動計測システムを構築するための革

新的なソリューションを提供しています。たとえば、グラフィカルプログ

ラミングが可能な LabVIEW、ANCI C プログラミング対応の

LabWindows™/CVI™、Microsoft Visual Studio プログラミング対応の

Measurement Studio などの堅固で業界最先端の自動計測システム用プ

ログラミング環境がその例です。これらのプログラミングツールをナショ

ナルインスツルメンツ製計測ハードウェアや従来型計測器へのインタ

フェースと組み合わせて使用することで、カスタム仕様の高機能な仮想計

測システムを構築することが可能です。

SignalExpress は、設計技術者が仮想計測を有効に活用するために、プロ

グラミングを行わずに対話式計測を実行するためのツールです。

SignalExpress では、信号の集録、生成、解析、比較、インポート、ログ

を対話式に行うことができます。また、設計データと測定データの比較を

1 つのステップで行えます。SignalExpress を使用すれば、信号の集録や

解析が必要な際にプログラミングアプリケーションなしで、仮想計測器の

使いやすさと性能を活用できます。また、LabVIEW 開発システムで作成

したカスタム仮想計測器（VI）を SignalExpress にインポートしたり、

SignalExpress プロジェクトを LabVIEW ブロックダイアグラムに変換し

て引き続き LabVIEW で開発を行うことができます。SignalExpress の高

度な機能の詳細については、第 6 章「LabVIEW で SignalExpress プロ

ジェクトを拡張する」を参照してください。

この章では、SignalExpress のバージョンとライセンスオプションについ

て説明します。
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SignalExpress のバージョン

SignalExpress には、正規版と Limited Edition (LE) があります。各エ

ディションで使用できる機能は、以下の表のとおりです。

表 1-1 SignalExpress Limited Edition (LE) と正規版の違い

LE 正規版

計測器のサポート

300 種以上の一般スタンドアロン計測器 NI デバイスドライバによりイン
ストールされる「信号を集録 /
生成」ステップ

IVI DMM 集録

IVI FGEN 任意波形

IVI FGEN 標準関数

IVI 電源

IVI Scope 集録

NI デバイスドライバによりイン
ストールされる「信号を集録 /
生成」ステップ

IVI DMM 集録

IVI FGEN 任意波形

IVI FGEN 標準関数

IVI 電源

IVI Scope 集録

表示とドキュメント

グラフのカスタマイズ データビュー データビュー

対話的カーソル カーソル カーソル

Microsoft Excel、Word、WordPad へのデータの
ドラッグアンドドロップ

ドラッグアンドドロップ ドラッグアンドドロップ

グラフの印刷とエクスポート — プロジェクトドキュメントタブ

制限的なユーザ編集が可能なオペレータモード — オペレータモード

信号作成

アナログ信号作成 アナログ信号を作成 アナログ信号を作成

デジタル信号作成 デジタル信号を作成 デジタル信号を作成

信号処理

ソフトウェアフィルタ — フィルタ

スカラと波形の数学的演算 — 演算

フォーミュラ

スケールと変換

時間平均

窓

アナログ / デジタル変換 — アナログからデジタルに変換

デジタルからアナログに変換

対話的な信号の比較 — 対話式アライメント

PSPICE、Multisim、SPICE パッケージからの
シミュレーションデータのロード

— SPICE からロード
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時間測定と周波数測定

振幅とレベル — 振幅とレベル

タイミングと遷移 — タイミングと遷移

パワースペクトル — パワースペクトル

周波数応答 — 周波数応答

歪み計測 — 歪み

トーン抽出 — トーン抽出

データログ

信号のファイル保存 NI デバイスドライバによりイン
ストールされる「信号をロード /
保存」ステップ

テキストおよび Microsoft Excel
ファイルへのエクスポート

NI デバイスドライバによりイン
ストールされる「信号をロード /
保存」ステップ

テキストおよび Microsoft Excel
ファイルへのエクスポート

ASCII/LVM に保存

TDMSログファイルをMicrosoft 
Excel にエクスポート

データロギング（TDMS ファイルの作成） 記録ボタン *

再生

記録ボタン

再生

実行中に記録ボタン

記録オプションタブ

プロジェクトごとのログ数に制
限なし

ログのアラームとイベント — アラーム

イベント

開始条件または停止条件付きロギング — 開始条件

停止条件

測定のオートメーション

パラメータのスイープ — スイープ

リミットテスト — リミットテスト

ソフトウェアトリガ — トリガ

シーケンス — シーケンス

リモートデータアクセス

シェア変数の読み取り / 書き込み — シェア変数を読み取り

シェア変数に書き込み

表 1-1 SignalExpress Limited Edition (LE) と正規版の違い（続き）

LE 正規版
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SignalExpress のライセンスオプション

このセクションでは、SignalExpress のライセンス規定について説明しま

す。ただし、このドキュメントは『ナショナルインスツルメンツソフト

ウェア使用許諾契約書』にとって代わるものではありません。このドキュ

メントは参照用としてのみ使用してください。

評価モード
SignalExpress の評価モードでは、表 1-1 に示されている SignalExpress
正規版の機能を 7 日間、使用することができます。この期間終了後は、

無償のライセンス不要の LE 版を登録するか、SignalExpress 正規版をア

クティブ化する必要があります。7 日の評価期間が終了しても

SignalExpress を登録またはアクティブ化しない場合は、製品を起動する

ことができなくなります。

メモ LabVIEW 8.0 以降がインストールされたマシンに SignalExpress をインストー

ルすると、LabVIEW または SignalExpress を初めて起動したときに

SignalExpress 正規版の評価期間が始まります。

LabVIEW との対話

LabVIEW コードの生成 プロジェクトから LabVIEW VI
を生成

プロジェクトから LabVIEW VI
を生成

LabVIEW Express VI NI デバイスドライバによりイン
ストールされる「信号を集録 /
生成」Signals Express VI

「信号を作成」Express VI

IVI DMM 集録

IVI FGEN 任意波形

IVI FGEN 標準波形

IVI 電源

IVI Scope 集録

NI デバイスドライバによりイン
ストールされる「信号を集録 /
生成」Signals Express VI

「信号を作成」Express VI

IVI DMM 集録

IVI FGEN 任意波形

IVI FGEN 標準波形

IVI 電源

IVI Scope 集録

「信号をロード / 保存」
Express VI

「処理」Express VI

「解析」Express VI

SignalExpress で LabVIEW VI を実行 — LabVIEW VI を実行ステップ

* 記録はプロジェクトにつき 1 つのログに限定

表 1-1 SignalExpress Limited Edition (LE) と正規版の違い（続き）

LE 正規版
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SignalExpress 正規版
SignalExpress 正規版では、表 1-1 の機能をすべて使用することができま

す。SignalExpress 正規版のアクティブ化は、NI License Manager、
SignalExpress インストーラ、ナショナルインスツルメンツのウェブサイ

ト ni.com/activateで行うことができます。

SignalExpress 正規版は、ナショナルインスツルメンツのウェブサイト

ni.com/signalexpressでご購入いただけます。

SignalExpress LE
無償の SignalExpress LE は、7 日間の評価期間中または期間終了後のい

つでも登録することができます。SignalExpress LE を登録すると、以下

の制約が付いた評価ライセンス機能を 7 日間の評価期間終了後も引き続

き使用することができます。

• ライセンスを必要とするステップを追加するたびに、ソフトウェアの

アクティブ化を促すダイアログボックスが表示されます。

• プロジェクトを保存できません。

• プロジェクトが 10 分ごとに閉じます。

SignalExpress LE をアクティブ化する
SignalExpress LE をアクティブ化するには、以下の手順に従ってくださ

い。

1. SignalExpress を起動します。

2. National Instruments ライセンスダイアログウィンドウで

Limited Edition を登録ボタンをクリックします。

3. 画面に従って SignalExpress LE をアクティブ化します。

メモ SignalExpress LE は、『SignalExpress Readme』に記載されているシリアル

番号を使用して、NI License Manager からアクティブ化することもできます。

http://www.ni.com/activate
http://www.ni.com/signalexpress
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2
プロジェクトを操作する

SignalExpress では、対話式計測環境でステップの追加や構成を行い、測

定処理を定義することができます。ステップとは、信号の集録や生成、解

析、ロード、保存を行う構成可能な関数です。ステップを追加メニューと

ステップを追加パレットには、SignalExpress で使用可能なステップが表

示されます。

ほとんどのステップは、入力信号を処理して、出力信号を生成します。各

ステップの動作は、ステップ設定タブで値を指定して設定することができ

ます。構成したステップのシーケンスは、SignalExpress プロジェクトと

して保存できます。

この章では、既存のプロジェクトをロードまたは実行する方法と、プロ

ジェクトのステップを構成する方法について説明します。

プロジェクトを開く

SignalExpress でサンプルプロジェクトをロードするには、以下の手順に

従ってください。

1. SignalExpress を起動します。スタートアップウィンドウで空の

SignalExpress プロジェクトをクリックします。

SignalExpress は、さまざまな種類の情報を表示する複数のビューに

分けられています。アプリケーションウィンドウの中央に表示される

タブ付きのビューを、プライマリビューと呼びます。SignalExpress
を初めて起動すると、プライマリビューにデフォルトでデータビュー

タブ、記録オプションタブ、プロジェクトドキュメントタブが表示さ

れます。

プライマリビューの周りには、補助ビューが表示されます。デフォル

ト構成では、左側にプロジェクトビューが表示され、右側に詳細ヘル

プが表示されます。

メモ サポートされているハードウェアデバイスが検出されると、SignalExpress ア
プリケーションウィンドウの下段にチャンネルビューが表示されます。
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2. SignalExpress がデフォルトのレイアウトで表示されていない場合

は、表示→レイアウト→プロジェクトを NI のデフォルトレイアウト

にリセットを選択することでデフォルトのレイアウトに戻すことがで

きます。タブやビューは、表示メニューから表示と非表示を切り替え

たり、デフォルトのレイアウトにリセットすることができます。

3. ヘルプ→サンプルを開を選択して SignalExpress¥Examplesディ

レクトリを開きます。Tutorialディレクトリに移動し、First 

Project.seprojをダブルクリックしてサンプルプロジェクトを開

きます。

4. 図 2-1 のようなウィンドウが表示されます。SignalExpress の各コン

ポーネントを確認してください。

図 2-1 First Project.seproj

1 実行ボタン

2 記録ボタン

3 プライマリビュー（データビュータブを選択した状態）

4 作業エリアプルダウンメニュー

5 プロジェクトビュー

6 ステップ

7 入力

8 出力

9 ログデータウィンドウ

10 詳細ヘルプ

2 31

4

8

6

7

55

9

10
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プロジェクトを実行して信号を表示する

SignalExpress には、複数の実行モードがあります。プロジェクトは、1
回だけ、指定する反復数、指定する時間、または連続的に実行することが

できます。1 回実行モードでは、プロジェクトビューのすべてのステップ

が１回実行されます。連続実行モードでは、プロジェクトのすべてのス

テップが連続的に実行されます。プロジェクトの実行モードを設定するに

は、左に示す実行ボタンの下矢印をクリックして、プルダウンメニューか

ら実行方法を構成を選択します。

プロジェクト実行中は、データビュータブの表示が継続的に更新されま

す。プロジェクト実行中に、ステップ設定タブの設定を変更して測定の構

成を変更すると、その結果が即時表示されます。連続モードで実行されて

いるプロジェクトは、ユーザが左に示す停止ボタンをクリックするまで実

行を継続します。プロジェクトの実行中は、実行ボタンが停止ボタンに変

化します。

サンプルプロジェクトを実行して信号を表示するには、以下の手順に従っ

てください。

1. 実行ボタンをクリックします。実行情報ダイアログボックスが表示さ

れた場合は、ダイアログボックスの実行ボタンをクリックしてプロ

ジェクト内のすべてのステップを連続的に実行します。

プロジェクトはテキストファイルから信号をロードし、信号に対して

2 つの操作（振幅とレベル測定および歪み測定）を実行します。これ

らの測定は、「振幅とレベル」ステップおよび「歪み」ステップで個

別に実行されます。プロジェクトを実行すると、各ステップは入力信

号を解析し、解析結果から新しい出力信号を生成します。このプロ

ジェクトでは、「ASCII からロード」ステップによって歪み正弦波が

ロードされ、「振幅とレベル」ステップと「歪み」ステップによって

この正弦波が解析され、これらの 2 つののステップから新しい出力

が返されます。SignalExpress のプロジェクトビューでは、入力は赤

い矢印で表示され、出力は青い矢印で表示されます。

データビュータブのグラフビューには、ロードされた時間領域信号が

表示されます。グラフには、時間領域、周波数領域、または XY 信号

が表示されます。

2. 左に示す「歪み」ステップのエクスポートされたスペクトル出力信号

を、プロジェクトビューからデータビュータブにドラッグして信号を

表示します。

データビュータブに新しいグラフが作成されます。エクスポートされ

たスペクトル信号は周波数領域信号であるため、時間領域信号と同じ

グラフには表示されません。SignalExpress は異なる信号タイプを自

動的に認識して、それぞれを適切な形式で表示します。
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ヒント 信号タイプの詳細については、ヘルプ→ SignalExpress ヘルプを選択して

『SignalExpress ヘルプ』を開き、キーワードタブで「信号タイプ」と入力して

適切なトピックを参照してください。このヘルプには、SignalExpress のプロ

ジェクト、ステップ、信号などの機能の詳細な説明が記載されています。

3. 「振幅とレベル」ステップの dc 出力をデータビュータブにドラッグ

します。

SignalExpress によって dc 出力のスカラ測定値を表すグラフと凡例

の表によるチャートビューが作成されます。凡例の表には、各出力の

値と隣にあるグラフに出力をプロットする際に使用される色が表示さ

れます。

4. 「振幅とレベル」ステップの rms 出力をチャートビューへドラッグし

て、スカラ RMS 測定値を表示します。

表に 2 つ目の測定結果を示す新しい行が追加されます。プロジェク

トは図 2-2 のように表示されます。

図 2-2 First Project.seproj の出力
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ステップを構成する

ステップとは、信号の集録や生成、解析、ロード、保存を行う構成可能な

関数です。ステップにより、入力信号が処理され、出力信号が生成されま

す。SignalExpress の各ステップの動作は、ステップ設定タブで値を指定

して設定することができます。プロジェクトの実行中でも、ステップの構

成を変更してその結果をデータビュータブに表示し、必要な測定結果が得

られるまで測定を調整することができます。

「歪み」ステップおよび「振幅とレベル」ステップを構成するには、以下

の手順に従ってください。

1. プロジェクトビューで「歪み」ステップをダブルクリックします。

図 2-3 のように、「歪み」ステップのステップ設定タブが表示されま

す。

図 2-3 「歪み」ステップのステップ設定タブ



第 2 章 プロジェクトを操作する

SignalExpress スタートアップガイド 2-6 ni.com

ステップ設定タブの構成ページでは、エクスポート信号 (THD) で
「歪み」ステップが入力信号をエクスポートすることを示しており、

エクスポートされた信号グラフには信号のプレビューが表示されてい

ます。エクスポートされたパワースペクトルグラフは、このステップ

が入力信号に対してパワースペクトルを実行して周波数領域に変換す

ることを示しています。また、測定結果には、信号の基本周波数と全

高調波歪み（THD）が表示されます。このステップは出力としてエク

スポート信号と 3 つの測定値（スペクトル、THD、元の時間領域の

波形入力の基本周波数）を生成します。

2. 詳細ヘルプにはステップに関する詳細な情報が表示されます。詳細ヘ

ルプが画面の右側に表示されていない場合は、左に示すヘルプ→詳細

ヘルプを選択して表示できます。

詳細ヘルプの上のセクションにはステップについての情報、下のセク

ションにはカーソルが現在置かれているパラメータ固有の詳細ヘルプ

が表示されます。たとえば、カーソルを THD (%) パラメータに移動

すると、このパラメータに関する情報が表示されます。

3. 構成ページ上で、エクスポート信号 (THD) プルダウンメニューから

基本トーンを選択します。

エクスポートされたパワースペクトルグラフが、入力信号全体の周波

数領域スペクトルの表示から、基本トーンだけの周波数スペクトルの

表示に変更されます。「歪み」ステップの出力信号とデータビュータ

ブのエクスポートされたスペクトル出力のグラフの両方が、変更に応

じて更新されます。

4. エクスポート信号 (THD) プルダウンメニューから高調波のみを選択

します。

ステップ設定タブのエクスポートされたパワースペクトルのグラフと

データビュータブの出力のグラフの両方で、入力信号の高調波信号の

スペクトルの表示だけが変更されます。

5. プロジェクトビューで「振幅とレベル」ステップをクリックします。

ステップ設定タブの内容が、「歪み」ステップの構成から「振幅とレ

ベル」ステップの構成に切り替わります。
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6. 入力 / 出力ページを選択すると、図 2-4 のように、このステップで選

択できる入出力のリストが表示されます。

図 2-4 「振幅とレベル」ステップのステップ設定タブ

7. + ピーク値をエクスポート、- ピーク値をエクスポート、ピーク -
ピーク値をエクスポートの各チェックボックスを有効にして、「振幅

とレベル」ステップからさらに 3 つの別の計測値が返されるよう設

定します。

新しい 3 つの出力がプロジェクトビューに表示されます。

8. データビュータブに切り替えます。

9. プロジェクトビューの 3 つの新しい出力をスカラ計測値のチャート

ビューへドラッグします。新しい出力がグラフと凡例の表に追加され

ます。

メモ すでに一定の時間プロジェクトが実行されている場合は、すべてのスカラ信号

をグラフに表示するためには、プロジェクトの実行を停止して再度開始する必

要がある場合があります。これは、SignalExpress がグラフに追加された信号

のデータポイントを蓄積するため、新しく追加された信号にはグラフ表示に必

要な量のデータポイントがないためです。
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10. 停止ボタンをクリックしてプロジェクトを停止します。

停止ボタンをクリックすると、現在の一連のステップ操作または反復

が完了した後でプロジェクトの実行は停止されます。停止ボタンの下

矢印をクリックし、プルダウンメニューから中断を選択すると、プロ

ジェクトが現在の反復を最後まで実行することなく完全に停止しま

す。

11. ファイル→プロジェクトを別名で保存を選択し、プロジェクトを
C:¥Program Files¥National Instruments¥SignalExpress¥

Examples¥Tutorialディレクトリに My First Project.seproj

という名前で保存します。

12. ファイル→プロジェクトを閉じるを選択し、プロジェクトを閉じま

す。

ステップを並べ替え、移動、削除する

SignalExpress プロジェクトのほとんどのステップは、入力データを必要

とします。各ステップは、プロジェクトビューでそれより前にあるステッ

プから出力される信号だけを処理できます。したがって、プロジェクト

ビューでのステップの順序はプロジェクトの動作に影響します。

ステップ設定タブに入力ページまたは入力 / 出力ページがあるステップで

は、これらのページの入力信号プルダウンメニューにそのステップより前

にあるステップの有効な出力だけが表示されます。ステップの出力が別の

ステップの入力になると、その 2 つのステップは相互依存となり、順番

に同じレートで実行されます。最初のステップによって生成された出力信

号は、2 つ目のステップの入力として受け取られ、実行が開始されます。

プロジェクト内のステップは、プロジェクトビューで上下にドラッグして

移動することができます。ステップを削除するには、プロジェクトビュー

でステップを右クリックし、詳細メニューから削除を選択します。ステッ

プを移動または削除すると、プロジェクトの信号のステータスが変更され

ます。たとえば、出力信号を生成するステップを削除すると、そのステッ

プの出力信号が他のステップの入力として使用されている場合、プロジェ

クトにエラーが発生し、プロジェクトビューにエラーインジケータが表示

されます。プロジェクト内のステップの切り取り / コピー / 貼り付けをす

るには、それぞれ <Ctrl-X>、<Ctrl-C>、<Ctrl-V> キーを押すか、プロジェ

クトビューのステップを右クリックして詳細メニューから切り取り、コ

ピー、選択したステップの前に貼り付け、または選択したステップの後に

貼り付けを選択します。
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エラーと警告を処理する

プロジェクトの実行中にエラーが発生した場合は、プロジェクトビューの

エラーが発生したステップに左に示すエラーインジケータが表示されま

す。エラーが発生したステップをダブルクリックすると、ステップ設定タ

ブの下方にエラーの説明が表示されます。エラーの説明の右側にある詳細

ボタンをクリックすると、エラーの詳細な説明が表示されます。

プロジェクトの実行中に発生するすべてのエラーおよび警告は、イベント

ログタブに記録されます。イベントログタブを表示するには、表示→イベ

ントログを選択します。エラーと警告の詳細については、ヘルプ→

SignalExpress ヘルプを選択して『SignalExpress ヘルプ』を開き、

キーワードタブで「エラー」と入力して適切なトピックを参照してくださ

い。
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3
信号を操作する

SignalExpress では、プログラミングを行わずに信号の生成と解析を行う

ことができます。この章では、SignalExpress で信号をグラフにプロット

する方法、信号をファイルからインポートする方法、2 つの信号を対話式

に揃えて比較する方法、信号をファイルに保存する方法などについて説明

します。

信号をグラフで表示する

サンプルプロジェクトの信号をプロットし、カーソルを使用して視覚的に

検証するには、以下の手順に従ってください。

1. ヘルプ→サンプルを開くを選択して SignalExpress¥Examples

ディレクトリを開きます。Tutorialディレクトリに移動して、

Signals.seprojをダブルクリックします。このプロジェクトでは、

「アナログ信号を作成」ステップで方形波を生成し、「フィルタ」ス

テップでローパスバタワースフィルタを実行します。

2. 「アナログ信号を作成」ステップの step signal 出力をデータビュー

タブにドラッグします。

3. 「フィルタ」ステップの filtered step 出力をデータビュータブにド

ラッグします。

step signal 信号と filtered step 信号は、どちらも時間領域信号で

あるため、同じグラフビューに表示されます。異なるタイプの信号を

同じグラフにドラッグしてプロットしようとすると、新しいビューが

自動的に作成されます。

4. 左に示すビューを追加ボタンをクリックし、新しいビューを追加しま

す。

メモ 各ビューは、右上端の X をクリックして削除することができます。

5. 「フィルタ」ステップの filtered step 出力を新しいビューにドラッグ

します。
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6. 新しいビューを右クリックし、詳細メニューから表示項目→カーソル

を選択して図 3-1 のような 2 つの対話式カーソルを表示します。

図 3-1 Signals.seproj

カーソルをドラッグすると、データビュータブの下方に表示されてい

るカーソル表の x 値と y 値が更新されます。

7. ファイル→プロジェクトを別名で保存を選択し、プロジェクトを
C:¥Program Files¥National Instruments¥SignalExpress¥

Examples¥Tutorialディレクトリに My Signals.seprojという

名前で保存します。
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信号をファイルからインポートする

信号は、カンマ区切りもしくはタブ区切りの ASCII ファイルなどの標準

的なファイル形式、また LabVIEW 計測データファイル（.lvm）からイ

ンポートできます。また、SPICE シミュレータなどの電子設計オート

メーションツールのシミュレーション結果から信号をインポートすること

もできます。

信号をファイルからインポートするには、以下の手順に従ってください。

1. プロジェクトビューを右クリックし、詳細メニューから信号をロード /
保存→アナログ信号→ ASCII からロードを選択してプロジェクト

ビューに「ASCII からロード」ステップを追加します。「ASCII から

ロード」ステップのステップ設定タブが開きます。このステップによ

り、ASCII 形式のファイルが読み込まれ、データが表示されます。

メモ プロジェクトへのステップの追加は、ステップを追加メニュー、ステップを追加

パレット、またはプロジェクトビューを右クリックして表示される詳細メニュー

から行うことができます。

2. サンプルファイルの値を正しく読み込むために、小数区切りプルダウ

ンメニューで . ( ドット ) が選択されていることを確認します。

3. ステップ設定タブで、左に示す参照ボタンをクリックし、
C:¥Program Files¥National Instruments¥SignalExpress¥

Examples¥Tutorialディレクトリにある Step Response.txtを

ダブルクリックします。

ファイルプレビューセクションの列 1 はタイムスタンプデータ、

列 2 は信号の実際の電圧値を示します。

4. ステップ設定タブの信号のインポートページを開き、ファイルに保存

されている信号を表示します。

5. インポートする信号の列 2 チェックボックスがオンになっているこ

とを確認します。

ステップ設定ダイアログボックスのインポートされた信号グラフに信

号のプレビューが表示されます。

6. X 入力値プルダウンメニューで列 1 が選択されていることを確認し

ます。これにより、波形の x 軸データが適切な値に設定されます。

7. データビュータブに切り替えます。

8. プロジェクトビューで、「ASCII からロード」ステップの Step 
Response.txt 出力を展開します。

9. 列 2 を右クリックして、詳細メニューから名前を変更を選択します。

10. step responseと入力し、<Enter> キーを押して出力名を変更しま

す。
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11. 「ASCII からロード」ステップの新しい step response 出力をデータ

ビュータブの下のビューにドラッグします。

下のグラフビューが表示されますが、ほとんど信号はありません。こ

れは、「アナログ信号を作成」ステップが現在のタイムスタンプで信

号を生成するのに対して、step response 出力のタイムスタンプはゼ

ロだからです。filtered step 信号と step response 出力の両方を表

示するには、下のグラフビューを右クリックして、タイムスタンプ→

無視を選択します。

図 3-2 のように、filtered step 信号は、step response 出力の立ち

上がりエッジと類似しています。

図 3-2 Signals.seproj の信号

12. ファイル→プロジェクトを保存を選択してプロジェクトを保存しま

す。
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信号を揃えて比較する

filtered step 信号も step response 出力も立ち上がりエッジでオーバー

シュートが見られますが、それぞれ信号ソースが異なるため振幅やタイミ

ングに相違があり、類似点を判定しにくい状態です。このような場合、

「対話式アライメント」ステップを使用して 2 つの信号を揃えて比較し、

その結果からプロジェクトで必要な情報を選択してエクスポートすること

ができます。

My Signals.seprojプロジェクトの 2 つの信号を揃えるには、以下の手

順に従ってください。

1. Step Response.txt 出力を展開し、step response を右クリックし、

詳細メニューから送信先→処理→アナログ信号→対話式アライメント

を選択して「ASCII からロード」ステップの step response 信号を

「対話式アライメント」ステップに渡します。タイムスタンプの不一

致を無視するには、アライメントタブの x0 を無視チェックボックス

をオンにします。

「対話式アライメント」ステップは、図 3-3 のようにプロジェクトの

最新の 2 つの信号を入力として選択し、ステップ設定タブのグラフ

にそれらの信号を表示します。

図 3-3 「対話式アライメント」ステップのステップ設定タブ
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ステップをプロジェクトに追加すると、そのステップで受け入れ可能

な信号タイプに基づいて入力信号が自動的に選択されます。たとえ

ば、「対話式アライメント」ステップは時間領域の波形信号のみを処

理できます。したがって、プロジェクトで作成された 2 つの最新の

時間領域信号が入力として選択されます。

メモ ステップの入力信号を変更するには、ステップ設定タブの入力ページまたは

入力 / 出力ページのプルダウンメニュー、またはプロジェクトビューでステッ

プの入力名の横に表示されている下矢印をクリックして、別の信号を選択しま

す。

2. 入力信号グラフで赤い信号をクリックし、そのグラフ内の他のポイン

トへドラッグします。比較結果信号グラフが更新され、新しく計算さ

れた信号の差異が表示されます。

グラフ上の信号は、ドラッグ、拡張、縮小できます。

3. グラフ内で信号をドラッグして、2 つの信号の立ち上がりエッジを揃

えます。信号をクリックしてアンカーポイントを設定し、<Alt> キー

を押したまま信号を x 軸と y 軸に沿ってアンカーポイントの周囲で

ドラッグします。

信号をドラッグすると、ステップ設定タブのアライメントページで、

アライメント設定を満たすｘ 軸とｙ 軸のゲインとオフセットの値が

計算され、結果が表示されます。

4. モードプルダウンメニューから自動 - ステップを選択し、信号を揃え

ます。アライメントは SignalExpress の標準アルゴリズムに基づい

て計算されます。

ステップ設定タブの比較結果信号グラフには、2 つの信号の相違が表

示されます。

5. 入力 / 出力ページの揃えた信号をエクスポートチェックボックスをオ

ンにして、信号をステップの出力に追加します。

6. データビュータブに切り替えます。

7. ビューを追加ボタンをクリックして 3 つ目のビューを追加します。

8. 「対話式アライメント」ステップの整列した基準出力と整列したテスト

出力を新しいグラフにドラッグし、揃えられた信号を表示します。

9. ファイル→プロジェクトを保存を選択してプロジェクトを保存しま

す。
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SignalExpress の信号タイプ

ステップの中には、「演算」ステップなど、複数の信号タイプを処理でき

るものがあります。たとえば、「演算」ステップでは、時間領域または周

波数領域の波形を処理することができます。この「演算」ステップは、選

択した入力信号のタイプに応じて異なる動作をします。たとえば、2 つの

時間領域信号を加算すると、その振幅のみが加算されます。これに対し、

2 つの周波数領域位相信号を加算すると、適切な位相シフトが加算されま

す。

信号タイプの詳細については、ヘルプ→ SignalExpress ヘルプを選択し

て『SignalExpress ヘルプ』を開き、キーワードタブで「信号タイプ」と

入力して適切なトピックを参照してください。

信号をエクスポートおよび印刷する

SignalExpress では、信号のドキュメントを作成したり、別のソフトウェ

アアプリケーションでさらに詳細な解析を行うことができます。このセク

ションでは、信号のエクスポート、信号の ASCII ファイルへの保存、

データの Microsoft Excel への送信、信号の印刷、標準のドキュメント機

能を使用した SignalExpress プロジェクトのドキュメント作成の方法に

ついて説明します。

信号をファイルに保存する
My Signals.seprojの信号をファイルへ保存するには、以下の手順に

従ってください。

1. ステップを追加ボタンをクリックしてステップを追加パレットを開き

ます。

2. 信号をロード / 保存→アナログ信号→ ASCII/LVM に保存を選択して

プロジェクトビューに「ASCII/LVM に保存」ステップを追加します。

「ASCII/LVM に保存」ステップのステップ設定タブが開きます。

3. ステップ設定タブの信号ページをクリックし、入力データプルダウン

メニューから filtered step を選択します。

4. ファイル設定ページで、エクスポートファイルのパスフィールドの横

にある参照ボタンをクリックし、C:¥Program Files¥National 

Instruments¥SignalExpress¥Examples¥Tutorialを参照して、

作成するテキストファイルの場所を指定します。filtered 

signal.txtというファイル名を入力します。

5. ファイルが既存の場合プルダウンメニューから上書きを選択します。

6. エクスポートファイルのタイププルダウンメニューから汎用

ASCII(.txt) を選択します。
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プロジェクトが実行されるたびに、「信号をロード / 保存」ステップ

を使用し、データをファイルへ保存します。

7. 実行ボタンの下矢印をクリックして 1 回実行を選択します。プロ

ジェクトが実行され、その結果得られた信号が指定した ASCII ファ

イルに保存されます。

8. ファイル→プロジェクトを保存を選択してプロジェクトを保存しま

す。

9. ファイル→プロジェクトを閉じるを選択し、プロジェクトを閉じま

す。

10. 任意のテキストエディタで filtered signal.txtを開き、信号の

値を確認します。このファイルの信号は、「ASCII からロード」ス

テップを使用して SignalExpress に再度インポートすることができ

ます。

Microsoft Excel へ信号をエクスポートする
Microsoft Excel へ信号データをエクスポートするには、Excel を起動し、

SignalExpress のステップの出力信号を Excel のスプレッドシートにドラッ

グします。または、データビュータブを右クリックしてエクスポート→

Microsoft Excel を選択してビューのすべてのデータをエクスポートするこ

ともできます。

SignalExpress でレポートを作成する
プロジェクトドキュメントタブを表示するには、表示→プロジェクトド

キュメントを選択します。このタブでは、テキストまたはグラフなどの画

像を使用してプロジェクトのドキュメントを作成できます。プロジェクト

ビューのステップの出力をプロジェクトドキュメントタブにドラッグする

と、出力信号のグラフが表示されます。プロジェクト実行中の場合は、

プロジェクトドキュメントタブのグラフがステップの出力の最新値を反映

するように自動的に更新されます。

ドキュメントを印刷するには、プロジェクトドキュメントタブを開き、

ファイル→印刷→ドキュメントを印刷を選択するか、ドキュメントを印刷

ボタンをクリックします。ドキュメントを HTML へエクスポートするに

は、プロジェクトドキュメントタブを開き、ファイル→エクスポート→

ドキュメントを HTML にエクスポートを選択します。
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4
データをログする

SignalExpress では、測定値を記録して解析することができます。あらゆ

る時間領域値、倍精度値、32 ビット符号なし整数、ブール値、デジタル

値のステップ出力を記録できます。解析ステップでログデータを再生し

て、解析、処理することもできます。

この章では、SignalExpress で統合データログ機能を使用したデータの記

録方法について説明します。たとえば、指定した信号の記録方法、信号の

再生方法、解析のステップを使用した信号の解析方法について説明しま

す。また、記録オプションタブで指定した開始条件または停止条件に基づ

いて信号をログする方法についても説明します。

信号を記録する

記録ボタンでデータログ処理を構成できます。

記録する信号を指定して記録するには、以下の手順に従ってください。

1. ヘルプ→サンプルを開くを選択し、Tutorialディレクトリにある

Logging.seprojをダブルクリックします。

このプロジェクトでは、「アナログ信号を作成」ステップを使用して

式に基づいて信号を生成します。

2. 左に示す記録ボタンをクリックし、ログに記録する信号を選択ダイア

ログボックスを開きます。

ログに記録する信号を選択ダイアログボックスは、プロジェクトで記

録可能な信号を表示します。1 つまたは複数の信号を記録するように

選択することができます。ログの名前と説明を指定することもできま

す。

3. 「アナログ信号を作成」ステップで生成されるフォーミュラ信号を記

録するために signal チェックボックスをオンにします。

4. OK ボタンをクリックしてログに記録する信号を選択ダイアログボッ

クスを閉じて信号の記録を開始します。停止ボタンをクリックするま

で、ログ操作が継続されます。

5. 左に示す停止ボタンをクリックして信号のログを停止します。初めて

信号をログした場合は、最初のログ作成を完了ダイアログボックスが

表示されます。OK ボタンをクリックし、ダイアログボックスを閉じ

ます。
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ログデータは、図 4-1 で示すようにプロジェクトビューの下方のログ

データウィンドウに表示されます。

図 4-1 ログデータウィンドウ

デフォルトでは、データを記録した日付と時間に応じて自動的にログ

データに名前が付けられます。ログデータはオプションダイアログ

ボックスで指定したディレクトリに .tdmsファイル形式で保存され

ます。

6. ログデータを保存するディレクトリを変更したり、ログデータの設定

をカスタマイズするには、ツール→オプションを選択し、ログオプ

ションを選択します。

7. OK ボタンをクリックしてオプションダイアログボックスを閉じま

す。

8. ファイル→プロジェクトを別名で保存を選択し、プロジェクトを
C:¥Program Files¥National Instruments¥SignalExpress¥

Examples¥Tutorialディレクトリに My Logging.seprojという

名前で保存します。

ログされた信号を表示する

ログデータを表示するには、以下の手順に従ってください。

1. データビュータブが非表示の場合は、表示→データビューを選択して

表示します。

2. ログデータウィンドウには、現在のプロジェクトのすべてのログデー

タが表示されます。ログデータウィンドウで記録したデータログを選

択してデータビュータブへドラッグします。図 4-2 のようにデータ

ビュータブにログデータとグラフプレビューが表示されます（図は詳

細ヘルプを閉じた状態）。信号を記録した時間の長さによっては、

データビュータブに表示される信号は図 4-2の信号と異なる場合があ

ります。
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図 4-2 Logging.seproj

グラフプレビューを使用して、データビュータブのデータにズームし

たり表示場所を変更することができます。グラフプレビューは、ログ

データを表示したときにデフォルトで表示されます。ライブデータま

たはログされていないデータのグラフプレビューを表示するには、

データビュータブのビューを右クリックして詳細メニューから表示項

目→プレビューを選択します。

ログ信号にズームするには、グラフプレビューの横にあるズームイン

ボタンをクリックします。グラフプレビューのカーソルは、データ

ビュータブに現在表示されているデータのサブセットを示します。グ

ラフプレビューの下にあるスクロールバーを使用してデータをスク

ロールします。グラフプレビューでカーソルをクリックしてドラッグ

すると、表示されているデータのサブセットを増減させることができ

ます。

1 データをログする 2 グラフプレビュー

1

2
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事前定義した開始 / 停止条件で信号をログする

信号があらかじめ指定した条件に一致したときに、信号の記録が開始また

は停止されるように設定することができます。開始および停止条件に基づ

いてデータをログするには、以下の手順に従ってください。

1. 記録オプションタブが表示されていない場合は、表示→記録オプショ

ンを選択して表示します。

2. 記録オプションタブのカテゴリリストで信号選択を選択します。

3. 図 4-3 のように、信号の記録列にチェックマークを付けます。

図 4-3 信号選択

記録ボタンは、左に示す実行中に記録ボタンに変わります。実行中に

記録ボタンが押下された状態であることを確認します。実行中に記録

ボタンが押下されているときは、実行ボタンをクリックしたときに選

択されている信号が記録されます。

4. 記録オプションタブのカテゴリリストで開始条件を選択します。
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5. ログタスクの開始条件を変更するには、開始条件リストページで追加

ボタンをクリックします。

a. 条件タイププルダウンメニューで信号トリガが選択されているこ

とを確認します。この設定では、入力信号が指定された条件を満

たすと記録が開始されます。

b. 信号プルダウンメニューで signal が選択されていることを確認

します。

c. トリガタイププルダウンメニューで立ち上がりスロープが選択さ

れていることを確認します。この設定では、正のスロープでの信

号のエッジの値に基づいて信号の記録が開始されます。

d. トリガ値に 1と入力して、立ち上がりスロープで信号がレベル 1
を超えたときに記録が開始されるよう指定します。

6. 記録オプションタブのカテゴリリストで停止条件を選択します。

7. ログタスクの停止条件を変更するには、停止条件リストページで追加

ボタンをクリックします。

a. 条件タイププルダウンメニューで持続時間が選択されていること

を確認します。この設定では、指定された時間が経過すると記録

が停止されます。

b. 信号が開始してから 5 秒後に記録を停止するように指定するた

めに、持続時間 (s) 制御器に 5が表示されていることを確認しま

す。

8. 左に示す実行ボタンをクリックします。立ち上がりスロープで信号が

レベル 1 を超えると、信号の記録が開始され、5 秒間継続します。

プロジェクトの実行中は、記録オプションタブの現在のログの状態セ

クションの以下の表示が更新されます。

• 信号が開始条件を満たしてからログが実行されている間、記録中

インジケータが ON になります。

• ディスク情報は、ログに使用できるコンピュータの有効なハード

ディスクスペースを表示します。

• 現在の推定ログサイズは、ディスク上のログファイルのサイズを

示します。

• 残り記録時間は、使用可能なディスクスペースに対してログを継

続できる時間を示します。

• 現在のログ開始時間は現在のログが開始された時間を示します。

記録オプションタブの開始条件、停止条件、アラーム、イベントペー

ジには、設定された開始 / 停止条件、アラーム、イベントの状態を示

すインジケータが表示されます。
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ログされた信号を解析する

ログ信号は、再生したり、ライブデータと同様に解析ステップで処理した

りすることができます。ログされた信号を解析するには、以下の手順に

従って下さい。

1. プロジェクトビューの上部にある作業エリアプルダウンメニュー

（図 4-4）で下矢印をクリックして再生を選択し、再生作業エリアに

切り替えます。

図 4-4 作業エリアプルダウンメニュー

作業エリアは、同じプロジェクトで複数の SignalExpress 操作を実

行する場合に使用します。新規プロジェクトを開かずに、データ集

録、信号処理、データの記録、ログデータでの測定実行が可能です。

プロジェクトを保存すると、プロジェクトのすべての作業エリアがプ

ロジェクトファイルに保存されます。

デフォルトの監視 / 記録作業エリアでは、測定の実行、ライブデータ

の解析、データのログを行うことができます。再生作業エリアでは、

監視 / 記録作業エリアでログしたデータを入力として解析ステップを

実行することができます。

2. 左に示すステップを追加ボタンをクリックし、処理→アナログ信号→

フィルタから「フィルタ」ステップを選択します。最初のログ信号が

自動的に「フィルタ」ステップの入力として選択されます。

3. データビュータブに切り替え、「フィルタ」ステップのフィルタ後の

データ出力をデータビュータブにドラッグします。

4. 実行ボタンをクリックします。データビュータブに結果として得られ

たフィルタ済みの信号が表示され、ログ全体が再生されます。
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上級再生

再生オプションタブでは、ログデータの詳細な再生オプションを構成でき

ます。再生オプションタブでは、ログデータのプレビューを表示し、再生

するデータのサブセットを選択したり、解析ステップでデータを処理する

ことができます。

1. 表示→再生オプションを選択して図 4-5のような再生オプションタブ

を表示します。

図 4-5 再生オプションタブ

2. ログされた信号リストボックスで、作成した 2 番目のログから

signal を選択します。

3. 開始時間 (s) に 1と入力して、ログ開始から 1 秒後からのログ信号サ

ブセットを再生または解析するよう指定します。

4. 停止時間 (s) フィールドに 4と入力して、ログ開始後から 4 秒後まで

の信号サブセットを再生または解析するよう指定します。ログの長さ

が 4 秒未満の場合は、停止時間 (s) フィールドに適切な値を入力しま

す。

5. ログされた信号リストボックスで 2 番目のログの signal を右クリッ

クし、詳細メニューからアクティブ化を選択してこの信号をアクティ

ブログに設定します。

メモ または、ログデータウィンドウでログを右クリックし、詳細メニューからアク

ティブログに設定を選択してアクティブログに設定することもできます。
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6. データビュータブに切り替えます。2 番目のログの信号をアクティブ

にすると、データビュータブのグラフビューが、その信号を表示する

ように自動的に更新されます。

7. 左に示す実行ボタンをクリックします。SignalExpress は、再生オプ

ションタブで指定した信号のサブセットをフィルタ処理し、データ

ビュータブに結果として得られたフィルタ処理済み信号を表示しま

す。

8. ファイル→プロジェクトを閉じるを選択し、プロジェクトを閉じま

す。プロジェクトへの変更を保存 ? ダイアログボックスが表示され

ます。プロジェクトでの変更を破棄し、ディスク上の新規ログを削除

オプションを選択します。また、プロジェクトおよびログを保存、お

よびプロジェクトでの変更を破棄し、ディスク上のログを保持オプ

ションを選択することもできます。

アラーム条件、イベント、再生オプションの指定などのログデータの詳細

については、ヘルプ→ SignalExpress ヘルプを選択して

『SignalExpress ヘルプ』を参照してください。



© National Instruments 5-1 SignalExpress スタートアップガイド

5
スイープ計測を行う

SignalExpress では、スイープ操作により測定を自動化し、特性評価や設

計検証を行うことができます。この操作では、SignalExpress で作成する

どのような設計でも特性化または検証することができます。スイープ計測

値を使用して設計の特定の条件範囲におけるデータを収集し、その設計の

性能をドキュメント化することができます。たとえば、測定中にスイープ

操作によって刺激信号の周波数や電源の電圧レベルを変化させることで、

設計を特性評価することができます。

この章では、SignalExpress で「スイープ」ステップを使用してスイープ

操作を設定する方法について説明します。特定の範囲で周波数値をスイー

プしてフィルタ出力の測定を行うことで、フィルタの性能を評価する方

法、スイープ結果の表示方法、より複雑な測定のための多次元スイープの

実行方法についても説明します。

スイープの範囲と出力を定義する

「スイープ」ステップでは、複雑で反復的なスイープ操作の自動化を定義

することができます。

以下の手順に従って、サンプルプロジェクトでフィルタでのスイープ操作

を行うための周波数範囲を定義します。

1. ヘルプ→サンプルを開くを選択し、Tutorialディレクトリにある

Sweep.seprojをダブルクリックします。

2. 左に示す実行ボタンをクリックし、プロジェクトを連続的に実行しま

す。

このプロジェクトでは、「アナログ信号を作成」ステップにより正弦

波の刺激信号が生成されます。この信号は、「フィルタ」ステップに

より楕円バンドパスフィルタを介して渡され、「振幅とレベル」ス

テップによりフィルタ出力の RMS が測定され、「フォーミュラ」ス

テップによりデシベル（dB）に変換されます。「フィルタ」ステップ

はシミュレートされた検査対象として動作するため、ハードウェアは

使用しません。ただし、ナショナルインスツルメンツの任意波形発生

器、関数発生器、ダイナミック信号アナライザ、またはマルチファン

クション I/O（MIO）デバイスから生成される物理チャンネルをス

イープすることもできます。

3. 停止ボタンをクリックしてプロジェクトを停止します。
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4. 左に示すステップを追加ボタンをクリックし、実行制御→スイープを

選択してプロジェクトビューに「スイープ」ステップを追加します。

5. ステップ設定タブで追加ボタンをクリックし、図 5-1 に示すようなプ

ロジェクトの各ステップのスイープパラメータのリストを表示しま

す。

図 5-1 スイープパラメータ選択ダイアログボックス

6. アナログ信号を作成の下の周波数 (Hz) パラメータを選択し、OK ボ

タンをクリックします。

スイープする信号を出力する「アナログ信号を作成」ステップが「ス

イープ」ステップによって囲まれます。

7. ステップ設定タブのスイープ構成ページのタイププルダウンメニュー

で指数を選択します。

8. 開始 : 周波数 (Hz) フィールドに 1kと入力し、終了 : 周波数 (Hz)
フィールドに 40kと入力します。
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9. ポイント数フィールドに 150と入力します。

スイープ構成ページは図 5-2 のようになります。

図 5-2 「スイープ」ステップのステップ設定タブ

「スイープ」ステップは、「アナログ信号を作成」ステップの周波数パ

ラメータの反復する各値の範囲を指定するために使用します。「アナ

ログ信号を作成」ステップは、定義された周波数範囲をもとに、各周

波数で正弦波を生成します。「スイープ」ステップでは、プロジェク

トのすべてのスイープ可能なステップのスイープパラメータの各値に

対して反復するように指定することができます。

10. スイープ出力ページに切り替えます。

11. 追加ボタンをクリックしてプロジェクトの各ステップのスイープ出力

リストを表示します。

12. フォーミュラの response amplitude in dB 出力を選択して OK ボ

タンをクリックすると、この出力値がスイープされた周波数パラメー

タに対してプロットされます。

プロジェクトビューのすべてのステップが「スイープ」ステップの

ループに囲まれ、スイープ操作の対象となります。



第 5 章 スイープ計測を行う

SignalExpress スタートアップガイド 5-4 ni.com

スイープ測定を実行する

スイープ測定を実行するには、以下の手順に従ってください。

1. データビュータブに切り替え、実行ボタンの下矢印をクリックして

1 回実行を選択してスイープ測定を実行します。

グラフ上で、白い stimulus signal 出力が指定された周波数範囲で反

復します。

2. スイープループの下の response amplitude in dB vs. 周波数信号を

データビュータブにドラッグし、スイープの出力を表示します。

新しいグラフビューが作成されます。スイープ操作のデータは XY 配

列で、図 5-3 のように別のビューに表示されます。

図 5-3 Sweep.seproj
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3. 1 回実行オプションを再度選択してスイープを実行します。

プロジェクトの実行中、新しいグラフビューに「フィルタ」ステップ

の周波数応答がプロットされます。周波数に対するデシベルで表され

る振幅の出力、またはフィルタの転送関数がグラフに表示されます。

メモ デフォルトでは、データビュータブの表示はスイープの反復ごとに消去されま

せん。「フィルタ」ステップの周波数応答はどの反復でも同じであるため、プロ

ジェクトの実行中に信号を表示するグラフが更新されていないように見えます。

オプションダイアログボックスのデータページで、スイープの反復ごとに

ビューを消去するかどうか選択することができます。ツール→オプションを選

択してオプションダイアログボックスを表示します。

4. 「フィルタ」ステップをダブルクリックし、ステップ設定タブでフィ

ルタ仕様を表示します。

フィルタ振幅応答（dB）グラフの周波数応答は、データビューのグ

ラフと一致します。

5. ファイル→プロジェクトを別名で保存を選択し、プロジェクトを
C:¥Progam Files¥National Instruments¥SignalExpress¥

Examples¥Tutorialディレクトリに My Sweep.seprojという名前

で保存します。

「スイープ」ステップを使用し、複数のパラメータを同時にスイープする

には、スイープのステップ設定タブのスイープ構成ページで別のパラメー

タを追加します。複数のパラメータを同時にスイープすることを、平行ス

イープと呼びます。たとえば、刺激信号の振幅を変更するには、平行ス

イープを実行してデジタイザや MIO デバイスの信号レベルの変更に応じ

て入力範囲を調整することで、集録の精度を最大限に高めることができま

す。信号レベルが上昇したら、測定デバイスの入力範囲を広げれば、その

測定に計測器が持つ分解能を最大限に活かすことができます。

多次元スイープを実行する

多次元（ネスト）スイープを使用して、2 つのパラメータを順番にスイー

プすることができます。刺激信号の周波数を様々な振幅でスイープするに

は、ネストスイープを実行します。たとえば、振幅をレベル 1 から順番

に設定して、それぞれのレベルで各周波数をスイープすることができま

す。ネストスイープを作成するには、プロジェクトで「スイープ」ステッ

プを右クリックし、詳細メニューからネストスイープを追加を選択して別

のスイープループを追加します。
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ネストスイープのサンプルプロジェクトを実行するには、以下の手順に

従ってください。

1. ヘルプ→サンプルを開くを選択し、Tutorialディレクトリにある

Nested Sweep.seprojをダブルクリックします。

2. 実行ボタンをクリックして、プロジェクトを実行します。

内側のスイープループの各反復は、刺激信号の周波数をスイープしま

す。外側のスイープループは、「フィルタ」ステップのカットオフ周

波数の上限と下限を変化させます。図 5-4 で示すように、各反復がま

ず上のグラフにリアルタイムで表示され、その後下のグラフに各カッ

トオフ周波数設定でのスイープがすべて表示されます。

図 5-4 Nested Sweep.seproj

3. 左に示す停止ボタンをクリックし、プロジェクトを停止します。
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LabVIEW で SignalExpress
プロジェクトを拡張する

SignalExpress では、標準の信号の集録、生成、解析、ログステップを使

用して自動計測を定義することができます。LabVIEW を使用することに

より、SignalExpress プロジェクトの機能を以下のように拡張することが

できます。

• LabVIEW で VI を作成し、その VI を SignalExpress にインポートす

ることで、ステップ機能をカスタマイズしたり、SignalExpress で使

用できるステップの数を拡張することができます。

• また SignalExpress プロジェクトを LabVIEW VI に変換し、引き続

き LabVIEW で開発することができます。

LabVIEW の VI を SignalExpress にステップとして
インポートする

SignalExpress でカスタム LabVIEW VI を呼び出すには、「LabVIEW VI
を実行」ステップを使用します。

メモ 「LabVIEW VI を実行」ステップを使用するために LabVIEW 開発システムをイ

ンストールする必要はありません。「LabVIEW VI を実行」ステップは、64 ビッ

ト版の LabVIEW で開発された VI はサポートしていません。

SignalExpress で LabVIEW VI を呼び出すことで、以下のことを行うこ

とができます。

• GPIB 計測器を制御する

• SignalExpress でサポートされていないナショナルインスツルメンツ

のハードウェアを制御する

• 多様なファイル形式のデータを読み書きする

• 操作説明をポップアップダイアログボックスに表示する

• 測定アルゴリズムを定義する
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「LabVIEW VI を実行」ステップで LabVIEW VI をインポートするには、

以下の手順に従ってください。

1. ヘルプ→サンプルを開くを選択し、Tutorialディレクトリにある

User Step.seprojをダブルクリックします。

このプロジェクトでは、「アナログ信号を作成」ステップで信号を生

成します。

2. ステップを追加ボタンをクリックして、LabVIEW VI を実行→

LabVIEW 2011 VI を実行を選択します。

メモ この演習で実行する VI は LabVIEW 2011 形式で保存されています。 「LabVIEW 
VI を実行」ステップは、VI が保存された LabVIEW バージョンに一致するもの

を使用する必要があります。

3. ステップ設定タブで、VI を選択セクションの参照ボタンをクリック

し、C:¥Program Files¥National Instruments¥
SignalExpress¥Examples¥Tutorialディレクトリの

Limiter-LV2011.viを選択します。「Limiter-LV2011」VI は時間領

域波形を入力として受け入れ、ステップ設定タブで指定した信号範囲

の上限を超えた値と下限を下回った値をクリップし、クリップした波

形を出力信号として返します。

SignalExpress に LabVIEW の VI をインポートすると、VI の入力は

パラメータとして、出力は出力信号としてマップされます。

VI の入力を入力信号またはパラメータのどちらに変換するかを定義

できます。入力信号はプロジェクトビューでステップの入力として表

示されるため、信号を VI に入力として渡すことができます。パラ

メータは、ステップのステップ設定タブで構成できる値です。パラ

メータは「スイープ」ステップを使用して動的にスイープすることも

できます。このプロジェクトでは、VI に入力信号の Time 
waveform in、およびスカラパラメータの Upper limit と Lower 
limit があります。
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ステップ設定タブは図 6-1 のように表示されます。

図 6-1 Limiter VI のステップ設定タブ

4. 左に示す実行ボタンをクリックし、プロジェクトを実行します。

5. データビュータブに切り替え、「LabVIEW 2011 VI を実行」ステップの

Clipped waveform out 出力をデータビュータブにドラッグします。

6. 「LabVIEW 2011 VI を実行」ステップをダブルクリックしてステップ

設定タブを表示します。

7. VI を構成タブを選択して VI を表示します。

8. Upper limit および Lower limit フィールドに新しい値を入力します。

たとえば、Upper limit フィールドに 100と入力します。

9. データビュータブに切り替えます。Clipped waveform out 信号に

変更内容が反映されます。

10. 左に示す停止ボタンをクリックし、プロジェクトを停止します。

11. ファイル→プロジェクトを別名で保存を選択し、My User 

Step.seprojという名前でプロジェクトを保存します。

12. ファイル→プロジェクトを閉じるを選択し、プロジェクトを閉じま

す。
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SignalExpress での LabVIEW の VI の使用方法や、SignalExpress で正

しく動作する VI の作成方法については、『SignalExpress ヘルプ』を参照

してください。

SignalExpress プロジェクトを LabVIEW VI に変換
する

SignalExpress で SignalExpress プロジェクトを LabVIEW VI に変換す

ることができます。

メモ SignalExpress プロジェクトを LabVIEW の VI に変換するには、LabVIEW 8.2
開発システム以降がインストールされている必要があります。

SignalExpress プロジェクトを LabVIEW VI に変換するには、以下の手

順に従ってください。

1. ヘルプ→サンプルを開くを選択し、Tutorial¥Solutionsディレク

トリにある My First Project.seprojをダブルクリックします。

2. ツール→コード生成→ LabVIEW ダイアグラムを選択します。

3. 新しい LabVIEW の VI のファイル名と場所を指定し、OK ボタンを

クリックします。SignalExpress によって新しい VI が生成され、そ

の VI がそのコンピュータで前回開いたバージョンの LabVIEW で開

かれます。

生成された LabVIEW VI には、SignalExpress でのプロジェクトの実

行が反映されます。LabVIEW のブロックダイアグラムは、互いに配

線された複数の LabVIEW Express VI で構成されます。各 Express VI
は、SignalExpress プロジェクトの各ステップに対応します。

Express VI をダブルクリックすると、SignalExpress のステップ設定

タブと同じ構成ダイアログボックスが表示されます。また、Express 
VI を右クリックし、詳細メニューからフロントパネルを開くを選択

すると、Express VI を LabVIEW のサブ VI に変換することができま

す。LabVIEW でブロックダイアグラムを表示して、その実行状況を

確認したり、VI の機能を変更したりすることができます。Express VI
をサブ VI に変換した場合、そのサブ VI を Express VI に戻すことは

できません。

メモ ログ機能が構成された SignalExpress プロジェクトを変換すると、1 つの

Express VI を持つ LabVIEW のブロックダイアグラムが生成されます。生成さ

れた Express VI をサブ VI に変換することはできません。
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7
詳細情報

SignalExpress の詳細については、以下のリソースを参照してください。

SignalExpress のサンプルプロジェクト

SignalExpress では、SignalExpress の多彩な機能を駆使した、さまざま

なサンプルプロジェクトが用意されています。これらのプロジェクトは、
C:¥Program Files¥National Instruments¥SignalExpress¥

Examplesディレクトリにあります。これらのサンプルを参照して、ニー

ズに合ったプロジェクトを作成するために、より詳細な SignalExpress
の機能を習得することができます。

SignalExpress でハードウェアを使用する

SignalExpress では、さまざまなナショナルインスツルメンツ製の信号集

録 / 生成ハードウェアがサポートされています。SignalExpress では、ナ

ショナルインスツルメンツの MIO デバイス、ダイナミック信号集録デバ

イス、高速デジタイザ、任意波形発生器、関数発生器デバイスを使用し

て、アナログ信号の生成または集録、およびロギングを行うことができま

す。また、デバイス間でクロックを共有や信号をトリガすることで、シス

テムで複数デバイスを同期することもできます。SignalExpress でのハー

ドウェアの詳細な使用方法については、ヘルプ→ SignalExpress ヘルプ

を選択すると開く『SignalExpress ヘルプ』を参照してください。

ウェブリソース

サンプルプロジェクト、技術関連ドキュメント、SignalExpress で使用で

きる LabVIEW VI などのリソースについては、ナショナルインスツルメ

ンツのウェブサイト ni.com/jp/signalexpressを参照してください。

http://www.ni.com/signalexpress
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技術サポートおよびプロフェッ
ショナルサービス

ナショナルインスツルメンツ ni.com/jpのユーザプロファイルにログイ

ンすると、お客様向けサービス用にカスタマイズされたアクセスページが

表示されます。技術サポートおよびその他のサービスについては、ナショ

ナルインスツルメンツのウェブサイト ni.com/jpの下記のセクションを

参照してください。

• サポート — 技術サポート ni.com/jp/supportには以下のリソー

スがあります。

– セルフヘルプリソース — 質問に対する回答やソリューションが
必要な場合は、ナショナルインスツルメンツのウェブサイト
ni.com/jp/supportでソフトウェアドライバとアップデート、
検索可能な技術サポートデータベース、製品マニュアル、トラブ
ルシューティングウィザード、種類豊富なサンプルプログラム、
チュートリアル、アプリケーションノート、計測器ドライバなど
をご利用いただけます。ユーザ登録されたお客様は、NI ディス
カッションフォーラム ni.com/jp/dforumにアクセスするこ
ともできます。 

– 標準サポート・保守プログラム（SSP）—NI のアプリケーション
エンジニアによる電話または E メールでの個別サポートです。
ソフトウェア製品（一部を除く）または NI Developer Suite を
含むバンドルソフトウェアをご購入のお客様には、「標準サポー
ト・保守プログラム (SSP)」の 1 年間のメンバーシップを自動的
にご提供いたします。また、SSP の特典を必要な限り中断なく利
用できる柔軟な延長契約オプションもご利用いただけます。詳細
については、ni.com/sspをご覧ください。

その他の技術サポートオプションについては、ni.com/jp/
servicesをご覧いただくか、ni.com/jp/contactからお問い
合わせください。

• トレーニングと認定 — トレーニングおよび認定プログラムについて

は、ni.com/training/jaを参照してください。また、世界各地

で登録可能なオンサイトトレーニングを提供しております。

http://www.ni.com
http://www.ni.com
http://www.ni.com/cgi-bin/redirect.cgi?dest=infcoprod&src=lvhelp&openagent&code=rdbp04
http://www.ni.com/cgi-bin/redirect.cgi?dest=infcoprod&src=lvhelp&openagent&code=rdbp04
http://www.ni.com/forums
http://www.ni.com/elearning
http://www.ni.com/ssp
http://www.ni.com/services
http://www.ni.com/services
http://www.ni.com/contact
http://www.ni.com/cgi-bin/redirect.cgi?dest=infcoprod&src=lvhelp&openagent&code=rdbp08
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• システムインテグレーション — 時間の制約がある場合や社内の技術

リソースが不足している場合、またはプロジェクトで簡単に解消しな

い問題がある場合などは、ナショナルインスツルメンツのアライアン

スパートナーによるサービスをご利用いただけます。詳しくは、NI
営業所にお電話いただくか、ni.com/jp/allianceをご覧くださ

い。

弊社ウェブサイトの Worldwide Offices セクション ni.com/niglobal

（英語））からは、お問い合わせ先、サポート電話番号、電子メールアドレ

ス、現行のイベント等に関する最新情報を提供する各国支社のウェブサイ

トにアクセスできます。 

http://www.ni.com/alliance
http://www.ni.com/niglobal
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